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Fundamentals | About these instructions

About these instructions

These instructions provide all the information and safety precautions needed for
the safe operation of the product.

Information on the product

Product designation Part number Firmware version Index

QUADRA-CHEK 30x4 1089174-xx 826880.1.0.x

The ID label is provided on the rear panel of the unit.
Example:

1—-QUADRA-CHEK xxxx xx

3— ID 1234567-xx xx E
SN 12 345 678 x

www.heidenhain.d

D

UL61010-1

2

1 Product designation
2 Index
3 Part number

Validity of the documentation

Before using the documentation and the product, you need to verify that the

documentation matches the product.

» Compare the part number and the index indicated in the documentation with
the corresponding data given on the ID label of the product

» Compare the firmware version given in the documentation with the firmware
version of the product

Further information: "Device information", page 313

> If the part numbers and indexes as well as the firmware versions match, the
documentation is valid

@ If the part numbers and indexes as well as the firmware versions do not
match so that the documentation is not valid, you will find the current
documentation for the product at www.heidenhain.de.
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Fundamentals | Notes on reading the documentation

1.3 Notes on reading the documentation

The table below lists the components of the documentation in the order of priority
for reading.

A WARNING

Fatal accidents, personal injury or property damage caused by non-
compliance with the documentation!

Failure to comply with the documentation may result in fatal accidents, personal
injury or property damage.

» Read the documentation carefully from beginning to end
> Keep the documentation for future reference

Documentation Description

Addendum An addendum supplements or supersedes
the corresponding contents of the Operating
Instructions and, if applicable, of the Installation
Instructions. If this document is included in
delivery, read it first before you proceed. All
other contents of the documentation retain
their validity.

Installation Instructions The Installation Instructions contain all the
information and safety precautions needed
for the proper mounting and installation of
the product. They are an excerpt from the
Operating Instructions and are included in every
delivery. This document has the second highest
priority for reading.

Operating Instructions The Operating Instructions contain all the
information and safety precautions needed for
the proper operation of the product according
to its intended use. This document has
the third highest priority for reading. This
documentation is included on the supplied
storage medium and can be downloaded from
the download area at www.heidenhain.de.
The Operating Instructions must be printed
prior to commissioning the product.

Documentation of connected These documents are not included in delivery.
measuring devices and other They are shipped with the respective measuring
peripherals devices and peripherals.

Would you like any changes, or have you found any errors?

We are continuously striving to improve our documentation for you. Please help us
by sending your requests to the following e-mail address:

userdoc@heidenhain.de
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Fundamentals | Storage and distribution of the documentation

Storage and distribution of the documentation

These instructions must be kept in the immediate vicinity of the workplace and
must be available to all personnel at all times. The operating company must inform
the personnel where these instructions are kept. If the instructions have become
illegible, the operating company must obtain a new copy from the manufacturer.

If the product is handed over or sold to a third party, the following documents must
be given to the new owner:

B Addendum, if supplied
B [nstallation Instructions
B QOperating Instructions

Target group for the instructions
The Operating Instructions must be read and observed by every person who
performs any of the following tasks:

= Mounting

E [nstallation

B Commissioning

® Setup, programming and operation

E Service, cleaning and maintenance

= Troubleshooting

= Removal

® Disposal

Notes in this documentation

Safety precautions
Comply with all safety precautions indicated in these Operating Instructions and in
your machine tool builder's documentation!

Precautionary statements warn of hazards in handling the product and provide
information on their prevention. They are classified according to the severity of the
danger, and are divided into the following groups:

ADANGER

Danger indicates hazards for persons. If you do not follow the avoidance
instructions, the hazard will result in death or severe injury.

A WARNING

Warning indicates hazards for persons. If you do not follow the avoidance
instructions, the hazard could result in death or serious injury.

A CAUTION

Caution indicates hazards for persons. If you do not follow the avoidance
instructions, the hazard could result in minor or moderate injury.
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Notice indicates danger to material or data. If you do not follow the avoidance
instructions, the hazard could result in things other than personal injury, like
property damage.

Informational notes

Observe the informational notes provided in these instructions to ensure reliable
and efficient operation of the product.

In these instructions, you will find the following informational notes:

0 The information symbol indicates a tip.
A tip provides important additional or supplementary information.

@ The gear symbol indicates that the function described depends on the
machine, e.g.

= Your machine must feature a certain software or hardware option

B The behavior of the functions depends on the configurable machine
settings

@ The book symbol represents a cross reference to external

documentation, e.g. the documentation of your machine tool builder or
other supplier.

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016
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Fundamentals | Symbols and fonts used for marking text

Symbols and fonts used for marking text

In these instructions the following symbols and fonts are used for marking text:

Format Meaning
> identifies an action and the result of this action
> Example:
» Tap Finish in the feature
> The measured contour is shown in green
L] identifies an item of a list
LI Example:
Bold identifies menus, tabs and buttons as well as geometry

features, functions and parameters.
Example:

» Select Manual measuring

» Select Circle
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Safety | General safety precautions

General safety precautions

General accepted safety precautions, in particular the applicable precautions
relating to the handling of live electrical equipment, must be followed when
operating the system. Failure to observe these safety precautions may result in
personal injury or damage to the product.

It is understood that safety rules within individual companies vary. If a conflict

exists between the material contained in these instructions and the rules of a
company using this system, the more stringent rules take precedence.

Intended use

The products of the QUADRA-CHEK 3000 series are advanced digital evaluation
electronics for the measurement of 2-D and 3-D features in metrological
applications. The products are used primarily on measuring machines, profile
projectors and video measuring machines. With the QUADRA-CHEK 3000 NC1
software option, measuring tasks can be automated completely.

The products of the QUADRA-CHEK 3000 series

B must only be used in commercial applications and in an industrial environment

® must be mounted on a suitable stand or holder to ensure the correct and
intended operation of the product

B are intended for indoor use in an environment that is free from humidity, dirt, oil
and lubricants (see Specifications)

@ The products of the QUADRA-CHEK 3000 series support the use of
a wide variety of peripheral devices from different manufacturers.
HEIDENHAIN cannot make any statements on the intended use of
these devices. The information on their intended use, which is provided
in the associated documentations, must be observed.

Improper use

When the products are used with the QUADRA-CHEK 3000 NC1 software option
for automated measuring tasks, it must be ensured that no hazard to persons

can result. If any such hazard exists, appropriate measures must be taken by the
operating company.

In particular, the following applications are not permitted:
B Use and storage outside the specifications

® Qutdoor use

m Use in potentially explosive atmospheres

|

Use of the products of the QUADRA-CHEK 3000 series as part of a safety
function
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2.5

Personnel qualification

The personnel for mounting, installation, operation, service, maintenance and
removal must be appropriately qualified for this work and must have obtained
sufficient information from the documentation supplied with the product and with
the connected peripherals.

The personnel required for the individual activities to be performed on the product
are indicated in the respective sections of these instructions.

The personnel groups that are responsible for mounting, installation, operation,
maintenance and removal have different qualifications and tasks, which are
specified as follows.

Operator

The operator uses and operates the product within the framework specified for the
intended use. The user is informed by the operating company about the special
tasks and about the potential risks involved with improper handling.

Qualified personnel

The qualified personnel are trained by the operating company to perform advanced
operation and parameterization. The qualified personnel have the required technical
training, knowledge and experience and know the applicable regulations, and are
thus capable of performing the assigned work regarding the application concerned
and of proactively identifying and avoiding potential risks.

Electrical specialist

The electrical specialist has the required technical training, knowledge and
experience and knows the applicable standards and regulations, and is thus
capable of performing work on electrical systems and of proactively identifying and
avoiding potential risks. Electrical specialists have been specially trained for the
environment they work in.

Electrical specialists must comply with the provisions of the applicable legal
regulations on accident prevention.

Obligations of the operating company

The operating company owns or leases the product and the peripherals. It is
responsible that the intended use is complied with at all times.

The operating company must:

= Assign the different tasks to be performed on the product to appropriate,
qualified and authorized personnel

® \Verifiably train the personnel in the authorizations and tasks

= Provide all materials and means necessary in order for the personnel to
complete the assigned tasks

= Ensure that the product is operated only when in perfect technical condition
B Ensure that the product is protected from unauthorized use
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Safety | General safety precautions

General safety precautions

NOTICE

Damage to the operating system!

Disconnecting the power source while the product is on can damage the
operating system of the product.

> Use the Switch-off menu on the touchscreen to shut down the product.
» Do not disconnect the power source while the product is on.

» Do not turn the power switch off until the product has shut down.

Loss of or damage to configuration data!

» Back up the configuration data for restoration purposes.

Further information: "Backing up and restoring the configuration®, page 346

o The safety of any system incorporating the use of this product is the
responsibility of the assembler or installer of the system.

@ The product supports the use of a wide variety of peripheral devices
from different manufacturers. HEIDENHAIN cannot make any
statements on the specific safety precautions to be taken for
these devices. The safety precautions provided in the respective
documentations must be observed. If no such information has been
supplied, it must be obtained from the manufacturers concerned.

The specific safety precautions required for the individual activities to be
performed on the product are indicated in the respective sections of these
instructions.

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Safety | General safety precautions

2.6.1

2.6.2

Symbols in the Operating Instructions

The following safety symbols are used in this document:

Symbol Meaning
f identifies information that warns of personal injury

identifies electrostatic sensitive devices (ESD)

ESD wristband for personal grounding

Symbols on the product

The following symbols are used to identify the product:

Symbol on the Meaning
product

Observe the safety precautions regarding electricity

and power connection before you connect the product.

Functional ground connection as per IEC/EN 60204-1.
Observe the information on installation.

Product seal. Breaking or removing the product seal
will result in forfeiture of warranty and guarantee.
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Electrical safety instructions

A WARNING

Hazard of contact with live parts when opening the product.
This may result in electric shock, burns or death.

» Never open the housing
» Only the manufacturer is permitted to access the inside of the product

NOTICE

Damage to internal parts of the product!
Opening the product will result in forfeiture of warranty and guarantee.

» Never open the housing
» Only the product manufacturer is permitted to access the inside of the

product

A WARNING

>

Hazard of dangerous amount of electricity passing through the human
body upon direct or indirect contact with live electrical parts.

This may result in electric shock, burns or death.

Work on the electrical system and live electrical components is to be
performed only by trained specialists

For power connection and all interface connections, use only cables and
connectors that comply with applicable standards

Have the manufacturer exchange defective electrical components
immediately

Regularly inspect all connected cables and all connections on the product.
Defects, such as loose connections or scorched cables, must be removed
immediately
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Transport and storage | Overview

Overview

This chapter contains all the information necessary for the transportation and
storage of the product and provides an overview of all the items supplied and the
available accessories of the product.

Unpacking

» Open the top lid of the box

Remove the packaging materials
Unpack the contents

Check the delivery for completeness
Check the delivery for damage

v vyYwvyy

Items supplied and accessories

Items supplied
The following items are included in the shipment:

® Device

E |nstallation Instructions

® Storage medium with Operating Instructions
| |

Addendum (optional)
Further information: "Notes on reading the documentation’, page 13

= 2-D demo part

Accessories
The following accessories are optionally available and can be ordered from

HEIDENHAIN:

Accessories Part number
Duo-Pos stand 1089230-02
For rigid mounting, inclination angle 20° or 45°

Multi-Pos stand 1089230-03
For steplessly variable tilting within an angle of 90°

Multi-Pos holder 1089230-04

For fastening on an arm, continuously tiltable within
an angle of 90°

USB connecting cable 354770-xx
Connector Type A to Type B

Calibration standard 681047-01

2-D demo part 681047-02
Adapter connector 1089210-01

HEIDENHAIN TTL to RSF TTL and RENISHAW TTL
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o The software options listed below are not enabled in the standard
firmware of the product. Whether the below hardware accessories can
be used depends on the software option. The accessories indicated for
the software options can only be used in conjunction with the enabled
software option.

Accessories Part number

QUADRA-CHEK 3000 VED software option 1089229-02

® Display, evaluation and archiving of live images
from digital cameras

®  Manual or automatic acquisition of measuring
points via video edge detection

B Programmable control of lighting

QUADRA-CHEK 3000 AF software option 1089229-03

QUADRA-CHEK 3000 Z software option 1089229-04
QUADRA-CHEK 3000 OED software option 1089229-08

Fiber-optic cable 681049-xx

With right-angle end

Fiber-optic connection 681049-xx

Two SMA connectors

Holder 681050-xx

With a hole for accepting the right-angle end of
fiberoptic cables

QUADRA-CHEK 3000 TP software option 1089229-09
3-D demo part 681048-01
3-D demo part for multi-sensor scanning 681048-02
Adapter cable for touch-probe connection, 1095709-xx

DIN 5-pin female, for connection of Renishaw
touch probes

TS 248 touch probe Cable outlet:
Axial: 683110-xx
Radial: 683112-xx

KT 130 edge finder 283273-xx
QUADRA-CHEK 3000 AEI1 software option 1089229-01
B Enabling of an additional encoder input
QUADRA-CHEK 3000 NC1 software option 1089229-07

1 Only in conjunction with QUADRA-CHEK 3000 VED software option
20 Only in conjunction with QUADRA-CHEK 3000 OED software option
3 Only in conjunction with QUADRA-CHEK 3000 TP software option
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The product supports only cameras from camera manufacturer IDS
Imaging Development Systems GmbH.

The product supports only cameras with a maximum resolution of 2.0
megapixels.

For connection, HEIDENHAIN recommends the use of USB connecting
cables from the manufacturer IDS Imaging Development Systems
GmbH.

HEIDENHAIN recommends the following cameras from IDS Imaging
Development Systems GmbH:

Part no.: Model designation: Resolution:

AB00795 UI-1240LE-C-HQ 1.31 megapixels
AB00796 Ul-1240LE-M-GL 1.31 megapixels
ABO00799 UI-1250LE-C-HQ 1.92 megapixels
AB00800 UI-1250LE-M-GL 1.92 megapixels
ABO00797 UI-1240SE-C-HQ 1.31 megapixels
AB00798 UI-1240SE-M-GL 1.31 megapixels
AB00801 UI-1250SE-C-HQ 1.92 megapixels
AB00802 Ul-1250SE-M-GL 1.92 megapixels

In case of damage in transit

v

Have the shipping agent confirm the damage

Keep the packaging materials for inspection

>
> Notify
>

the sender of the damage

Contact the distributor or machine manufacturer for replacement parts

In case of damage in transit:
» Keep the packaging materials for inspection
» Contact HEIDENHAIN or the machine manufacturer

This applies also if damage occurred to requested replacement parts
during transit.
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3.5 Repackaging and storage

Repackage and store the product carefully in accordance with the conditions
stated below.

Repackaging

Repackaging should correspond to the original packaging as closely as possible.

> Attach all mounting parts and dust protection caps to the product or repackage
them in the same way they were originally shipped from the factory.

» Repackage the product such that it is protected from impact and vibration
during transit

> Repackage the product such that it is protected from the ingress of dust or
humidity

> Place all accessories that were included in the shipment in the original
packaging
Further information: "ltems supplied and accessories", page 24

» Include the Addendum (if it was included in the items supplied), the Installation
Instructions and the Operating Instructions
Further information: "Storage and distribution of the documentation’, page 14

o If you return the product for repair to a service agency:

» Ship the product without accessories, without measuring devices
and without peripherals

Storage of the product
» Package the product as described above

» Observe the specified ambient conditions
> Inspect the product for damage after any transport or longer storage times
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Overview

This chapter contains all the information necessary for mounting the product.

Mounting | Overview

o The following steps are only to be performed by qualified personnel.
Further information: "Personnel qualification", page 19

Assembly of the device

General mounting information
The receptacle for the mounting variants is provided on the rear panel. The
connection is compatible with VESA standard 100 mm x 100 mm.

4

100

-

100

The material for attachment of the mounting variants on the device is included in
delivery.

You will also need the following:

m Torx T20 screwdriver

® Torx T25 screwdriver

B Hex key, width A/F 2.5 (Duo-Pos stand)
Material for mounting on supporting surface

0 The product must be mounted on a stand or holder to ensure the
correct and intended operation of the product.
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421 Mounting on Duo-Pos stand

You can attach the Duo-Pos stand to the product at a 20° or 45° angle.

Use the two supplied M4 x 8 ISO 7380 hexagon socket screws to attach the stand
to the lower threaded holes on the rear panel. The permissible tightening torque is
2.5 Nm.

Using the mounting slots (width = 4.5 mm), you can screw the stand to a
supporting surface.

The cables are routed together through the two supports of the stand from behind
and then through the lateral openings to the connections.

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016

31



32

Dimensions of the Duo-Pos stand

258+1

Mounting | Assembly of the device

208+1

ISO 7380-M4x8
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422 Mounting on Multi-Pos stand

Use the four supplied M4 x 8 ISO 14581 (black) countersunk screws for
attachment to the threaded holes on the rear panel. The permissible tightening
torque is 2.5 Nm.

Using two Mb screws, you can screw the stand to a supporting surface from the
bottom.

You can tilt the stand to any angle within the 90° tilt range. The recommended
tightening torque for the T25 screw is 5.0 Nm. The maximum permissible
tightening torque for the T25 screw is 15.0 Nm.

The cables are routed together through the opening in the stand from behind and
then laterally below the joint to the connections.
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Dimensions of the Multi-Pos stand
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423 Mounting on Multi-Pos holder

Use the four supplied M4 x 8 ISO 14581 (black) countersunk screws for
attachment to the threaded holes on the rear panel. The permissible tightening
torque is 2.5 Nm.

You can tilt the holder to any angle within the 90° tilt range. The recommended
tightening torque for the T25 screw is 5.0 Nm. The maximum permissible
tightening torque for the T25 screw is 15.0 Nm.

The cables are routed together through the opening in the holder from behind and
then laterally to the connections.

152+2 113+2
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Installation | Overview

Overview

This chapter contains all the information necessary for installing the product.

o The following steps must be performed only by qualified personnel.
Further information: "Personnel qualification", page 19

General information

NOTICE

Interference from sources of high electromagnetic emission!

Peripheral devices, such as frequency inverters or servo drives, may cause
interference.

To increase the noise immunity to electromagnetic influences:

» Use the optional functional ground connection as per IEC/EN 60204-1

» Use only USB peripherals with continuous shielding, e.g. by metalized film
and metal braiding or a metal housing. The degree of coverage provided by
the braiding must be 85 % or higher. The shield must be connected around
the entire circumference of the connectors (360° connection).

NOTICE

Engaging and disengaging connecting elements!

Risk of damage to internal components.

» Do not engage or disengage any connecting elements while the unit is under
power

NOTICE
Electrostatic discharge (ESD)!

This product contains electrostatic sensitive components that can be destroyed
by electrostatic discharge (ESD).

> |t is essential to observe the safety precautions for handling ESD-sensitive
components

» Never touch connector pins without ensuring proper grounding

» Wear a grounded ESD wristband when handling product connections
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5.3 Product overview

The connections on the rear panel of the device are protected by dust protection
caps from contamination and damage.

NOTICE

Contamination or damage may result if the dust protection caps are
missing!

This may impair the proper functioning of the contacts or destroy them.

» Remove dust protection caps only when connecting measuring devices or
peripherals

> |If you remove a measuring device or peripheral, re-attach the dust protection
cap to the connection

o The type of connections for encoders may vary depending on the
product version.
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Installation | Product overview
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Rear panel

Connections that are independent of software options:

4

~

1"

D-sub connections for encoders, 2 inputs enabled by default, another
2 inputs can be enabled optionally

X1 to X4: Device variant with 15-pin D-sub connections for encoders with
1 Vg interface

X21 to X24: Device variant with 9-pin D-sub connections for encoders with a
TTL interface

USB ports, Hi-Speed USB 2.0 (Type A)

X32: Connection for digital camera, printer or USB mass storage device
X33 to X34: Connection for printer or USB mass storage device
Speaker

Functional ground connection as per IEC/EN 60204-1

RJ45 Ethernet connections

X116: Connection for communication and data exchange with subsequent
systems or PC

X100: Power switch and power connection
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Connections that depend on software options:

1

10

Connections for optical edge detector for point measurement

X107: Reference input for optical waveguide from the light source

X108: Input for optical waveguide from the projection screen

X102: 37-pin D-sub connection for digital TTL interface (8 inputs, 16 outputs)

X112: 15-pin D-sub connection for touch probes (e.g. HEIDENHAIN touch
probe)

RJ45 Ethernet connections

X117: Connection for digital camera

X103: 37-pin D-sub connection for digital or analog interface (TTL 4 inputs,
6 outputs; analog 3 inputs, 10 outputs)

X104: 9-pin D-sub connection for universal relay interface (2x relay
changeover contacts)

Left side panel

12

X31 (below protective cover):
Hi-Speed USB 2.0 port (Type A) for printer or USB mass storage device
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5.4 Connecting encoders

o The type of connections for encoders may vary depending on the
product version.

» Remove and save the dust protection caps

» Route the cables depending on the mounting variant.
Further information: "Assembly of the device", page 30

» Connect the encoder cables tightly to the respective connections.
Further information: "Product overview", page 39

> If the cable connectors include mounting screws, do not overtighten them

NOTICE

Incorrect pin assignment!
This may cause product malfunctions or damage to the product.

» Only assign pins or wires that are used

Pin layout of X1-X4

1 Vep

87 6543 21
00 O0O0OOOOo
1514131211108

O O O O OO

1 2 3 4 5 6 7 8
A+ oV B+ Up / / R- /
9 10 1 12 13 14 15
A- Sensor 0 | B- Sensor / R+ /

\ Up

Pin layout of X21-X24

TTL
5 4 3 2 1
O O O 0 O
9 8 7 6
O O O O
1 2 3 4 5 6 7 8 9
/ Uat Uyt Uao U, oV U, U,o Uao
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5.5

Wiring of switching inputs and outputs

A WARNING

Hazard when using switching inputs for safety functions!

If switching inputs for mechanical limit switches are used for safety functions,
severe injury or death can result.

» Do not use the switching inputs for mechanical limit switches for safety
functions

NOTICE

Damage to the product due to incorrect wiring!

Incorrect wiring of switching inputs or switching outputs can cause damage to
the product or peripheral devices.

» Comply with the specifications of the product
Further information: "Specifications", page 365

o The encoder fulfills the requirements of standard IEC 61010-1 only if
the power to the peripheral devices is supplied from a secondary circuit
with current limitation as per IEC 61010-13rd Ed., Section 9.4 or with
power limitation as per IEC 60950-12nd Ed. Section 2.5 or from a Class 2
secondary circuit as specified in UL1310.

In place of IEC 61010-13rd Ed., Section 9.4, the corresponding sections
of standards DIN EN 61010-1, EN 61010-1, UL 61010-1 and CAN/CSA-
C22.2 No. 61010-1 and, in place of IEC 60950-12nd Ed.  Section 2.5, the
corresponding sections of standards DIN EN 60950-1, EN 60950-1, UL
60950-1, CAN/CSA-C22.2 No. 60950-1 can be applied.

o Depending on the peripherals to be connected, the connection work
may need to be performed by an electrical specialist.

Example: Safety Extra Low Voltage (SELV) exceeded.
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Pin layout of X102, X103

Installation | Wiring of switching inputs and outputs

1 2 3 4 5 6 7 8
GND Din 1 Din 3 Din 4 Din 6 GND Dout0 | Dout2
9 10 1" 12 13 14 15 16
Dout 4 GND Dout6 | Dout8 | Dout10 | GND | Dout12 | Dout 14
17 18 19 20 21 22 23 24
/ / GND Din 0 Din 2 DC5V | Dinb Din 7
25 26 27 28 29 30 31 32
GND Dout1 | Dout3 | Doutb GND Dout7 | Dout9 | Dout 11
33 34 35 36 37
GND | Dout 13 | Dout 15 / /
X103
%915‘12?15’13”313218% 8568306853 éj
TETYLRYIRBYLTYLRYY
1 2 3 4 5 6 7 8
GND (D)| Din1 Din 3 / Ain1 | GND (A)| Dout0 | Dout2
9 10 " 12 13 14 15 16
Dout4 | GND (D)| AoutO | Aout2 | Aout4 | GND (A)| Aout 6+ | Aout 7+
17 18 19 20 21 22 23 24
8+ Aout 9+ | GND (A)| DinO Din2 |[DC5V (D] AiInO Ain 2
25 26 27 28 29 30 31 32
GND (A)| Dout1 | Dout3 | Doutb | GND (D)| Aout1 | Aout3 | Aoutb
33 34 35 36 37
GND (A) | Aout 6- | Aout 7- | Aout 8- | Aout 9—
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Pin layout of X104

5 4 3 2 1
O 0 o o o
98 7 6
O O O O
1 2 3 4 5 6 7 8 9
R-0 R-0 / R-1 R-1 R-0 / / R-1
NO NC NO NC Cco Cco

CO - Change Over
NO - Normally Open
NC — Normally Closed
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Connecting a digital camera

Connecting a USB digital camera
» Remove and save the dust protection caps

» Route the cables depending on the mounting variant
Further information: "Assembly of the device", page 30

» Connect the camera to the USB Type A port X32. Make sure the USB cable
connector is fully inserted
Further information: "Product overview", page 39

Pin layout of X32

4 32 1
1 2 3 4
5VDC Data (-) Data (+) GND

Connecting an Ethernet digital camera
» Remove and save the dust protection caps

» Route the cables depending on the mounting variant
Further information: "Assembly of the device", page 30

> Connect the camera to the Ethernet port X117 using a standard CAT.5 cable.
The cable connector must firmly engage in the port
Further information: "Product overview", page 39

Pin layout of X117

12345678

1 2 3 4 5 6 7 8
D1+ D1- D2+ D3+ D3- D2- D4+ D4-
(TX+) (TX=) (RX+) (RX-)
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Installation | Connecting an optical edge detector

5.7 Connecting an optical edge detector

» Remove and save the dust protection cap

» Route the optical waveguides depending on the mounting variant
Further information: "Assembly of the device", page 30

@ » Adhere to the manufacturer's specifications regarding the
maximum bend radius of the optical waveguides

» Connect the optical waveguide of the light source (reference) to connection
X107

» Connect the optical waveguide from the projection screen to connection X108
Further information: "Product overview", page 39

Pin layout of X107 and X108
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Connecting printers

Connecting a USB printer
» Remove and save the dust protection caps
» Route the cables depending on the mounting variant
Further information: "Assembly of the device", page 30
» Connect the USB printer to one of the USB Type A ports X31-X34. Make sure

the USB cable connector is fully inserted
Further information: "Product overview", page 39

Pin layout of X31-X34

4 321
1 2 3 4
5VDC Data (-) Data (+) GND

Connecting an Ethernet printer

» Remove and save the dust protection caps

» Route the cables depending on the mounting variant
Further information: "Assembly of the device", page 30

» Connect the Ethernet printer to the Ethernet port X116 using a standard CAT.5
cable. The cable connector must firmly engage in the port
Further information: "Product overview", page 39

Pin layout of X116

12345678

1 2 3 4 5 6 7 8
D1+ D1- D2+ D3+ D3- D2- D4+ D4-
(TX+) (TX=) (RX+) (RX-)
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Installation | Connecting a network peripheral

5.9 Connecting a network peripheral

Connecting a network peripheral

» Remove and save the dust protection caps

» Route the cables depending on the mounting variant
Further information: "Assembly of the device", page 30

» Connect the network peripheral to the Ethernet port X116 using a standard
CAT.5 cable. The cable connector must firmly engage in the port
Further information: "Product overview", page 39

Pin layout of X116

12345678

1 2 3 4 5 6 7 8
D1+ D1- D2+ D3+ D3- D2- D4+ D4-
(TX+) (TX=) (RX+) (RX-)
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Installation | Connecting the line voltage

5.10 Connecting the line voltage

A WARNING

Risk of electric shock!

Improper grounding of electrical devices may result in serious personal injury or
death by electric shock.
» Always use 3-wire power cables

» Make sure the ground wire is correctly connected to the ground of the
building's electrical installations

A WARNING

Fire hazard from the use of power cables that do not meet the national
requirements of the respective country in which the product is mounted.

Improper grounding of electrical devices may result in serious personal injury or
death by electric shock.

» Use only a power cable that meets at least the national requirements of the
respective country in which the product is mounted.

» Use a power cable that meets the requirements to connect the power
connection to a 3-wire grounded power outlet
Further information: "Product overview", page 39
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Basic operation | Overview

6.1 Overview

The product is operated using the touch-sensitive screen (touchscreen) only.

This chapter describes the following functions and operating elements of the
product:

Touchscreen and gestures

User interface

General operating elements and functions
Adjusting the lighting

Working in the workspace

Using the Inspector

Using measuring tools
Switch-on/Switch-off

User login and logout

Messages and audio feedback

6.2 Touchscreen and gestures

6.2.1 Touchscreen

The product is operated solely via the operating elements of the touchscreen.
The operating elements can be activated, switched or moved by using different
gestures. Data is entered using the touchscreen keyboard.

Malfunctions of the touchscreen caused by humidity or contact with
water!

» Protect the touchscreen from humidity or contact with water
Further information: "Product data", page 366

6.2.2 Gestures

Tap
Tapping means touching the screen briefly with your finger tip.

The actions initiated by tapping the touchscreen include:
m Select menus, features or parameters

Enter characters with the screen keyboard

Close dialogs

Relocate a measuring tool in the workspace

Display and hide the main menu in the Measure
menu

® Display and hide the Inspector in the Measure menu
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Long press
Long press means touching the screen and holding your finger(s) on it for a few
seconds.
A long press on a measuring tool in the Measure menu
in the workspace initiates the following action:
® Open the zoom function in the workspace when
measuring with the Crosshair measuring tool
Drag

Dragging is a combination of long-press and then swipe, moving a finger over the
touchscreen when at least the starting point of motion is defined.

The actions initiated by dragging an operating element
include:

= Open the Details dialog in the Inspector
® Position the measuring tools
m Scroll lists and texts

Two-finger drag
Dragging with two fingers means moving two fingers in parallel over the
touchscreen when at least the starting point of motion is defined.

Two-finger dragging in the Measure menu in the

workspace initiates the following action:

= Move the image section within the field of view of a
camera in the workspace
Further information: "Moving an image section”,
page 76
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6.3 User interface

6.3.1 User interface after switch-on

Factory default user interface

The illustration shows the user interface the way it looks when you switch on the
product for the first time.

This user interface will also be displayed after resetting the product to the factory
defaults.

HEIDENHAIN

QUADRA-CHEK 3014 NC

Not logged in
-
<

In the User login menu, you can log in and out of the product as a user. The
product provides various authorization levels that grant the user full or restricted
access to management and operation functionality.

Further information: "User permissions’, page 335
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User login

» In the drop-down list, select the user you want to log in
» Tap the Password input field

» Enter the user's password
Further information: "Factory default settings”, page 312

o If a password other than the default password
has been assigned to the user, ask a Setup or
OEM user for the assigned password.

If the password is no longer known, contact a
HEIDENHAIN service agency.

» Confirm the entry with RET

» Tap Log in
> The user is logged in and the Measure menu is displayed.

o If "Reference mark search after unit start" is active, all functions of the
product will be disabled until the reference mark search is successfully
completed.

Further information: "Activating the reference mark search’,
page 112

Performing the reference mark search after startup
> After logging in, follow the instructions of the wizard

> On successful completion of the reference mark search, the display color of the
axis position changes from red to white

Setting the language
The default language for the user interface is English. The language can be set
individually for each user.

> Tap Settings in the main menu.

Q

Tap User
The logged-in user is indicated by a check mark
Select the logged-in user

VvV v vV

The language selected for the user is indicated by a national
flag in a drop-down list

> Select the flag for the desired language in the Language
drop-down list

> The user interface immediately switches to the selected
language
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User interface without software options activated

Move the X axis until one or more reference marks are crossed.

If automatic user login is active, the Measure menu with the workspace and the
Inspector is displayed after the product is started.

Further information: "Measure menu", page 64
If automatic user login is not active, the product displays the User login menu.
Further information: "User login menu", page 72

o If "Reference mark search after unit start" is active, all functions of the
product will be disabled until the reference mark search is successfully
completed.

Further information: "Activating the reference mark search”,
page 112

Performing the reference mark search after startup
> After logging in, follow the instructions of the wizard

> On successful completion of the reference mark search, the display color of the
axis position changes from red to white
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Setting the language

> Tap Settings in the main menu.

Q

Tap User
The logged-in user is indicated by a check mark
Select the logged-in user

The language selected for the user is indicated by a national
flag in a drop-down list

VvV vV VY

> Select the flag for the desired language in the Language
drop-down list

> The user interface immediately switches to the selected
language

User interface with QUADRA-CHEK 3000 VED software option

Move the Z axis until one or more reference marks are crossed.

If automatic user login is active, the Measure menu with the activated software

option, the workspace and the Inspector is displayed after the product is started.

Further information: "Measure menu", page 64
If automatic user login is not active, the product displays the User login menu.
Further information: "User login menu", page 72
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o If the QUADRA-CHEK 3000 VED software option was activated
without connecting a camera, the virtual camera is used. The Operating
Instructions show only the virtual camera.

For information on activating the software option, please refer to the
Commissioning chapter.

Further information: "Enabling software options", page 108

0 If "Reference mark search after unit start" is active, all functions of the
product will be disabled until the reference mark search is successfully
completed.

Further information: "Activating the reference mark search”,
page 112

Performing the reference mark search after startup
> After logging in, follow the instructions of the wizard

> On successful completion of the reference mark search, the display color of the
axis position changes from red to white

Setting the language

> Tap Settings in the main menu.

rOW Tap User
The logged-in user is indicated by a check mark

Select the logged-in user

The language selected for the user is indicated by a national
flag in a drop-down list

» Select the flag for the desired language in the Language
drop-down list

VvV v VvV

> The user interface immediately switches to the selected
language

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Basic operation | User interface

6.3.2 General operating elements and functions
The following operating elements are available for setting and operating the
product via the touchscreen:

Screen keyboard

Input fields

Toggle switch

Sliding switch

Slider

Drop-down list

Screen buttons

Screen keyboard

With the screen keyboard, you can enter text into the input fields of the user
interface. The displayed screen keyboard is either numeric or alphanumeric,
depending on the input field.

HEIDENHAIN

QUADRA-CHEK 3014 NC

Not logged in
gg

Example of using the screen keyboard

To enter values, tap an input field

The input field is highlighted

The screen keyboard is displayed

Enter text or numbers

In some input fields, a green check mark indicates that the entry is correct

VVVY V VY

If the entry is incomplete or incorrect, a red exclamation mark is displayed. The
entry cannot be concluded

v

To apply the values, confirm the entry with RET
> The values are displayed
> The screen keyboard disappears
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Input fields with plus and minus buttons
To adjust a numerical value, use the "+" (plus) and "-" (minus) buttons to the left and
right of the numerical value.

» Tap + or - until the desired value is displayed

» Long-press + or - to scroll through the values more
quickly
> The selected value is displayed

= 500

Toggle switch
Use the toggle switch to switch between functions.

> Tap the desired function
> The active function is shown in green

mm inch

> The inactive function is shown in light gray

Sliding switch
With the sliding switch, you activate or deactivate a function.

» Drag the sliding switch to the desired position or tap the
ON sliding switch
> The function is activated or deactivated

Slider
With the slider, you can continuously adjust a value.

2 » Drag the slider to the desired position
w > The selected value is displayed graphically or in percent

Drop-down list
Buttons that open drop-down lists are indicated by a triangle pointing down.

» Tap the button
1Vpp N .
> The list opens
1 Vpp > The active entry is highlighted in green
» Tap the desired entry
>

11 pA
e The selected entry is applied
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Undo
With this button, you can undo the last action.

Processes that have already been concluded cannot be undone.

» Tap Undo
z> > The last action is undone

Add
The button is displayed in different ways:

® Dark on light background
®  Light on dark background

» To add a feature, tap Add

+ > The new feature is added
Close
. » Tap Close to close a dialog
Confirm

. » Tap Confirm to conclude an activity
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Main menu of the user interface

User interface with QUADRA-CHEK 3000 VED software option

1

© Enter

1 Message display area, displays the time and the number of unclosed messages
2 Main menu with operating elements for controlling and configuring the product

Operating elements of the main menu
The main menu is displayed independently of activated software options.

Operating Function
element

Message
Opens an overview of all messages and shows the number

of messages that have not been closed
Further information: "Messages", page 100

Measure

Manual measurement, construction or definition of features
by using measuring programs and predefined geometries

Further information: "Measure menu", page 64

Measurement report

Creation and management of measurement reports by
using templates

Further information: "Measurement report menu’,
page 68

File management
@ Management of the files that are available in the product
These include:
* Measuring programs
¢ Templates for measurement reports
*  Measurement reports
¢ Documentation

Further information: "File management menu",
page 70
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Operating Function
element
User login
(01 Login and logout of users
Further information: "User login menu", page 72
Settings
@ Settings of the product, such as setting up users,

configuring sensors or updating the firmware
Further information: "Settings menu", page 73

Switch off

(D Activation of energy-saving mode or shutdown of the
operating system
Further information: "Switch off menu", page 74
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Measure menu

Activation

> Tap Measure in the main menu
> The user interface for manual measuring, constructing and

defining is displayed

Measure menu without software option

i

1 The function palette provides functions for manual measuring, constructing and
defining. The selected function is displayed as an active operating element.

2 The geometry palette provides all geometries for manual measuring,
constructing and defining. Some geometries are combined into geometry
groups. The selected geometry is displayed as an active feature. The
geometries available on the geometry palette depend on the selected function.

3 The workspace displays, for example, the current position of the measuring
plate or the features preview (graphical representation of the features).

4 The Inspector provides the quick access menu, the position preview or features
preview, and the feature list or program step list. The feature list contains the
features that have been measured, constructed or defined.
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Measure menu with QUADRA-CHEK 3000 VED software option
1 2 3

© Enter

1 The function palette provides functions for manual measuring, constructing and
defining. The selected function is displayed as an active operating element.

2 The sensor palette provides the optional sensors, e.g. VED. It is only visible if
the software option is active.

3 The workspace displays, for example, the live image or the input area for
constructing and defining features.

4 The Inspector provides the quick access menu, the position preview, the
features preview, and the feature list or program step list. The feature list
contains the features that have been measured, constructed or defined.

5 The workspace displays tool-dependent and sensor-dependent settings and
control elements.

6 The geometry palette provides all geometries for manual measuring,
constructing and defining. Some geometries are combined into geometry
groups. The selected geometry is displayed as an active feature. The
geometries available on the geometry palette depend on the selected function.

7 The tool palette provides the measuring tools required for conducting the
selected measurement. The tool palette is only visible if the live image from the
VED sensor is displayed in the workspace.

8 The lighting palette is only displayed if the optical sensor is active.
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Operating elements of the function palette

Manual Constructing  Defining
measuring

©

Define

Operating elements of the sensor palette

The operating elements of the sensor palette are only available if software options
are active. If one software option is active, the software option is displayed. If
multiple software options are active, you can choose between the options.

Video edge
detection
(VED)

=K

Operating elements of the geometry palette

Measure Magic

Snapshot

The Snapshot operating element is only available if the
QUADRA-CHEK 3000 VED software option is active.

Height point

The Height point operating element is only
available if the Z axis is active.

Line

Circle Arc Ellipse
m
Slot Rectangle
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Distance

Alignment Reference
plane

The Reference plane
operating element is only
available if the Z axis is active.

&

Alignment

Lighting palette

The lighting palette is only available if an optical sensor is
EoS active.

Operating elements of the tool palette

The operating elements of the tool palette are only available if a software option
is active. They are displayed only in the manual measuring function, e.g. if the live
image is in the workspace.

Crosshair Single edge Circle Buffer Contour
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Measurement report menu

Activation

> Tap Measurement report in the main menu

> The user interface for displaying and creating the
measurement reports appears

Short description

AllTol
Standard

A\ EuroTol

I
g

Standard

MyCustomTemplatel

IN
e

MyCustomTemplate2

Create

Created

rq 04/18/2016 10:19:01

Last changed
04/15/2016 08:23:14

Last opened
04/18/2016 10:1:01

List of default templates

Preview of the selected template

Display of information on the selected template
List of custom templates

A WON=

In the Measurement report menu, you can select existing report templates and
create custom templates. A list of the created templates is shown in the column
on the left. A preview of the selected template is displayed in the column on the
right.

Further information: "Measurement report’, page 283
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Displaying operating elements

Operating
element

Short description

Copy template

Opens a dialog for copying the selected template. After
editing the properties, you can save a copy of the template
under a new name and edit the copy.

Edit template
Activates the edit mode for a custom template.
Default templates cannot be edited.

Rename template
Opens a dialog for renaming the template.
Default templates cannot be renamed.

Delete selection
Opens a dialog for deleting the custom template.
Default templates cannot be deleted.
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File management menu

Activation

> Tap File management in the main menu

> The user interface for managing the stored files is displayed

Short description

1
2

Internal
Internal .
A\ MASSSTORAGE

»

Documents

Images

Programs

Reports

System

User

List of available storage locations
List of folders in the selected storage location

The File management menu shows an overview of the files stored in the
product's memory. If USB mass storage devices or network drives are connected,
they are displayed in the list of storage locations.

The connected USB mass storage devices and network drives are displayed with
their names or drive designations.

The files in the Internal storage location are saved in folders:

Documents: Documents with instructions and service addresses

Images: Images of measured objects as reference material

Programs: Stored measuring programs

Reports: Stored measurement reports and measurement report templates
System: Audio files and system logs

User: User data

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Basic operation | User interface

Displaying and opening files
> Tap a folder to open it
» Tap a file to display its properties

Further information: "Displaying and opening files", page 307

Displaying operating elements

> To display the operating elements, drag the icon of the folder or file to the right

> The operating elements are displayed

Short description

Create a new folder

Adds a new folder to the selected folder

Move folder
Opens a dialog for moving the folder

Copy folder
Opens a dialog for copying the folder

Rename folder
Opens a dialog for renaming the folder

Move file
Opens a dialog for moving the file

Copy file
Opens a dialog for copying the file

Rename file
Opens a dialog for renaming the file

CEEEBEEEBEE :

Delete selection

Opens a dialog for deleting the file or folder

Safely removing a USB mass storage device

@ > Tap File management in the main menu
> Navigate to the list of storage locations

>
>

»

Tap Safely remove
Disconnect the USB mass storage device
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6.3.7 User login menu

Activation

» Tap User login in the main menu

> The user interface for user login and logout is displayed

Short description

HEIDENHAIN

QUADRA-CHEK 3014 NC

Logged in as

ro] Operator

1 Display of the logged-in user
2 User login

The User login menu shows the logged-in user in the column on the left. The login
of a new user is displayed in the column on the right.

To log in another user, the logged-in user must log out.
Further information: "User login and logout", page 98
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6.3.8  Settings menu

Activation

> Tap Settings in the main menu

> The user interface for the product settings is displayed

Short description

General {é} Device information 4

A Sensors @ Screen and touch screen »
Features Display »

o

8 Interfaces 33 Sounds >
User rO\' Printers »

Axes N Date and time »

Service % Units 4

Run-In Test Copyrights »

‘{,E} Service info »
(I) Documentation »

1 List of setting options
2 List of setting parameters

The Settings menu shows all options for configuring the product. With the setting
parameters, you can adapt the product to on-site requirements.

Further information: "Settings’, page 311
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Switch off menu
Activation

» Tap Switch off in the main menu

> The operating elements for shutting down the operating
system and for activating the energy-saving mode are
displayed

Short description
The Switch off menu provides the following two options:

Operating Function
element

Shut down

Shuts down the operating system of the product.

Energy saving mode
The screen is switched off.

Further information: "Switch-on/Switch-off", page 96

Working in the workspace
The workspace is only available in the Measure menu.

Activation

» Tap Measure in the main menu
> The user interface for manual measuring, constructing and

defining is displayed

Adjusting the display of the workspace

In the Measure menu, you can increase the workspace by hiding the main menu or
the Inspector.

Hiding or displaying the main menu

. > Tap the tab
> The main menu is hidden

> The arrow changes direction
» To display the main menu, tap the tab

Hiding or displaying the Inspector
The Inspector can only be hidden when using the Manual measuring function.

» Tap the tab
. > The Inspector is hidden
> The arrow changes direction
» To display the Inspector, tap the tab
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6.4.2

Operating elements in the workspace

Operating elements of the manual measuring function
The operating elements in the workspace are only available if an optical sensor is
active.

Settings Edge detection modes

Operating elements of the construction function
The workspace provides operating elements for adjusting the features view.

Zoom to all Zoom to Magnify Reduce
selection graphic graphic

El

Operating elements of the definition function
Depending on the selected geometry, the input fields required for definition are
displayed in the workspace.

Enter the coordi of the crcle center
and the diameter or radius.

10.0000

Example: Input fields in the workspace for Circle geometry
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6.4.3 Moving an image section

o The live image can only be moved if the QUADRA-CHEK 3000 VED
software option is active and the Manual measuring function is
selected.

The live image can be moved within the field of view because the field of view of
the camera image is larger than the image section in the workspace.

1 2

HEIDENMHAIN

L 4
-
HHHH' o

1 Field of view of the camera
2 Image section (live image)

> In the workspace, drag the image section with two fingers to the desired
position

> The image section is moved within the camera's field of view
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6.5 Using the Inspector

The Inspector is only available in the Measure menu.

Activation

» Tap Measure in the main menu

> The user interface for measuring, constructing and defining is
displayed

6.5.1 Operating elements of the Inspector

The Inspector comprises the following areas and operating elements:

Quick access menu
Position preview (only available in the manual measuring function)

Features preview (only available in the manual measuring function and the
definition function)

Live image preview (only available in the manual measuring function and if the
QUADRA-CHEK 3000 VED software option is active)

Feature list or program step list

Miscellaneous functions

Undo (only available in the manual measuring function)
Enter (only available in the manual measuring function)

Operating Short description
element

manual

Quick access menu
mm

The quick access menu displays the current settings for
manual measuring, constructing and defining:

= Unit for linear values (millimeters or inches)
m Selected magnification

B Type of measuring point acquisition (automatic or
manual)

Timeout for automatic measuring point acquisition

» To adjust the settings of the quick access menu, tap the
quick access menu

0.000000 Position preview

Aaeseel  [he position preview is only available in the manual
0.000000 measuring function.

The current axis positions are displayed.

If no reference mark search has been performed, the axis
positions are displayed in red.

Further information: "Conducting the reference mark
search’, page 203

» To display the position preview in the workspace, tap
the position preview

> The position preview is displayed in the workspace

> The current content of the workspace switches to the
Inspector
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Operating Short description
element

Features preview

The features preview is only available in the measuring
function.

The features preview displays a reduced view of the

measured, constructed and defined features. The current

image section of the live image is highlighted.

» To display the features preview in the workspace, tap
Features preview

> The features preview is displayed in the workspace

> The current content of the workspace switches to the
Inspector

Live image preview

The live image preview is only available in the manual
measuring function.

-
HEIZEHAIN L .
il

\

The live image preview displays a reduced view of the live
image. The live image preview is shown if the position
preview or the features preview is displayed in the
workspace.

» To display the live image preview in the workspace, tap
Live image preview
> The live image preview is displayed in the workspace

> The current content of the workspace switches to the
Inspector

Feature list

The feature list contains a list of all features that have been
measured, constructed or defined. The feature list provides
the following information:

= 1: Measured feature with symbol, name and
consecutive number

2: Function that was used for creating the feature

3: Concludes the measuring point acquisition

4: Number of measuring points that have been acquired
5: Newly acquired feature with symbol

Each feature contains details on the measurement results
as well as selectable tolerances.

» To adjust the tolerances and display the measured
values, drag a feature into the workspace

» To delete a feature, drag the feature to the right out of
the Inspector
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Operating
element

Initialization
Auto enter
Magnification

Units

Start VED probe

Calculate Slot 1

Start VED probe

Short description

Program step list

The program step list shows all actions that occur during
the measurement. It is displayed instead of the feature list
in the Inspector.

The program steps can be combined and saved as
measuring programs.

Further information: "Programming’, page 271

Miscellaneous functions

The miscellaneous functions comprise the following
functions:

®  Switching the display between feature list and program
step list

® Creating and saving a program
® Calling the program control in the workspace

m Deleting selected features or all features from the
feature list

© Enter
[ ]
© Enter

Enter

If automatic measuring point acquisition is deactivated, the
measuring points are acquired manually.

If automatic measuring point acquisition is active, a red dot
is shown in the operating element.

If automatic measuring point acquisition is active, the
measuring points are acquired after the set timeout
expires.
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6.5.2  Adjusting settings in the quick access menu

With the quick access menu, you can adjust the following settings:

= Unit for linear values (Millimeters or Inch)

®  Unit for angular values (Radian, Decimal degrees or Deg-Min-Sec)
Type of coordinate system (Cartesian or Polar)
Magnification

Type of measuring point acquisition (Auto enter)
B Timeout for automatic measuring point acquisition (Auto enter timeout in ms)

Setting the units of measure
Before you start measuring, you need to set the desired units of measure in the
Inspector's quick access menu.

Tap the Quick access menu in the Inspector

Select the desired Unit for linear values

Select the desired Unit for angular values

Tap Close to close the quick access menu

The selected units are displayed in the Quick access menu

mm x1 ‘

manual

Selecting the coordinate system
Depending on the measuring task, you can set the type of coordinate system in
the Inspector's quick access menu.

vV v . v v Y

Tap the Quick access menu in the Inspector
Select the desired Type of coordinate system
Tap Close to close the quick access menu

The positions are displayed in the Position preview
according to the selected coordinate system

mm x1 ‘

manual

vV v v Vv
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Setting the magnification

If an optical sensor is active, you can take the optical magnification of the
measured object (e.g. due to camera optics) into account. To do this, select the
magnification that corresponds to the camera optics in the quick access menu.
The number of available magnification levels depends on the configuration of the
measuring machine.

o The magnification of the camera optics must match the magnification
that is set in the product. To ensure that the live image is focused in the
workspace, adjust the working distance between the measured object
and the camera, if required.

mn » Tap the Quick access menu in the Inspector

rrez] |] extns > Select the desired magnification so that it corresponds to the
camera optics

> |f required, adjust the respective magnification and the focus
of the camera optics

» Tap Close to close the quick access menu

> The selected magnification is displayed in the Quick access
menu

o If the selected magnification has not yet been set, the pixel size of the
sensor must be determined in the Settings menu.

Further information: "Determining the pixel sizes", page 129

Setting automatic measuring point acquisition

You can acquire measuring points automatically or manually one at a time. The
automatic acquisition (auto enter) function automatically enters the measuring
points as soon as the measuring tool has remained at a standstill above the
measuring point for a short period of time. You can activate or deactivate this
function, and set the standstill time ("timeout").

o > Tap the Quick access menu in the Inspector
manid | 3oms > Activate or deactivate Auto enter
A > \When Auto enter is active, a red dot is shown in the Enter
Enter
button

» Set the Auto enter timeout in ms

> As soon as the measuring tool has remained at a standstill
above a measuring point for longer than the selected period
of time, the measuring tool automatically enters one or more
measuring points

. » Tap Close to close the quick access menu

> The selected timeout period is displayed in the Quick access
menu
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6.5.3  Adjusting miscellaneous functions of the Inspector

Switching between feature list and program step list
The feature list shows the acquired features whereas the program step list shows
the program steps of the measuring program.

Further information: "Programming", page 271

. » Tap Miscellaneous functions in the Inspector
> Select the Feature list or Program step list display

> Activating the program step list also activates the display of
the program control in the workspace

. > Tap Close to close the miscellaneous functions

Creating or saving a measuring program
With the miscellaneous functions of the Inspector, you can create a new
measuring program or save acquired features as a measuring program.

Further information: "Programming’, page 271

Tap Miscellaneous functions in the Inspector
To create a new measuring program, tap New
Tap OK in the dialog

A new measuring program is created and the miscellaneous
functions are closed

» To save acquired features as a measuring program, tap Save
as

» Tap the input field in the dialog and enter a name for the
measuring program

Confirm the entry with RET

Tap OK

The measuring program is saved

The miscellaneous functions are closed

vV v v Y

VvV Vv Vv Y
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Deleting features

With the miscellaneous functions of the Inspector, you can delete multiple
features simultaneously.

>

H
4

’

Select the features in the feature list
Tap Miscellaneous functions in the Inspector

To delete the selected features from the feature list, tap
Delete selection

To delete all features from the feature list, tap Delete all

o The reference features, such as zero point,
alignment and reference plane, cannot be
deleted as long as other features are referenced
to them.

Tap Close to close the miscellaneous functions

6.6 Using measuring tools

o The operating elements of the tool palette are only available if an optical
sensor is active. They are only displayed in the manual measuring
function if the live image is in the workspace.

Activation

v

VvV v.v Vv Y

Tap Measure in the main menu

> The user interface for measuring, constructing and defining is

displayed

Select Manual measuring

If required, tap Live image preview in the Inspector
The live image is shown in the workspace

Tap Tool palette

The measuring tools of the tool palette are displayed
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Measuring tools

Basic operation | Using measuring tools

Depending on the optical sensor, various measuring tools are available for
acquiring the measuring points. The measuring tools can be operated by gestures

in the workspace.

Further information: "Using VED measuring tools", page 87

VED measuring tools

Icon

Measuring tool

Crosshair

Functions and characteristics

®  Manual acquisition of single measuring points

= No automatic acquisition of light-to-dark transitions

B Zoom function available for pixel-precise
positioning

®  Alignment and position adjustable

Single edge

= Active measuring tool

= Automatic acquisition of single measuring points
B Acquisition of light-to-dark transitions

®  Size of search range adjustable

= Alignment and position adjustable

Circle

= Active measuring tool

Acquisition of multiple measuring points e.g. at
circles and circular arcs

Acquisition of light-to-dark transitions
Size of search range adjustable

Scan direction adjustable

Search range angle adjustable
Position adjustable

Buffer

= Active measuring tool

®  Automatic acquisition of multiple measuring points
at edges

B Acquisition of light-to-dark transitions
®  Size of search range adjustable
= Alignment and position adjustable

Contour

= Active measuring tool

B Automatic acquisition of multiple measuring points
at contours

B Acquisition of light-to-dark transitions

= |ndependent positioning of the start and end points
of the search range

B Size of search range adjustable
® Scan direction adjustable
®  Alignment and position adjustable
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6.6.2  Setting the VED measuring tool

You can set all functions separately for each measuring tool. The product will save
your entries when you exit the dialog.
Select the desired measuring tool in the Tool palette
Tap Settings at the bottom of the workspace
The Settings dialog for the selected measuring tool opens

The available parameters depend on the selected measuring
tool

VvV Vv VvYy

v

Set the parameters

» Tap Close to close the Settings dialog
> The selected parameters are saved for the measuring tool

Operating Parameter Function
element

oN |

| Expanded tool mode Expansion of Crosshair, Single Edge and Buffer

Crosshair: The lines of the crosshairs are extended
to the edge of the workspace. The extensions can
be used for alignment and for fine positioning with
motion reduction.

Single edge: The search range is extended with the
crosshairs. The expanded tool mode can be used
for alignment and for fine positioning with motion
reduction.

Buffer: The search range is extended with the
crosshairs. The expanded tool mode can be used for
alignment.

e B Edge detection modes Modes of automatic measuring point acquisition

The active mode determines the acquisition direction
for the light-to-dark transition at an edge (dark — light;
light — dark; dark or light — light or dark).

i Color Color of the measuring tool

‘ - Line type Line type of the measuring tool
‘ s . ‘ Motion reduction in Function of the Crosshair measuring tool
zoom Motion reduction of the zoom function at a ratio of
1:10 or 1:5. Selecting 1:1 deactivates the motion
reduction.

The motion reduction applies to the movement of the
zoom function in the live image.

The motion reduction in zoom is independent of the
motion reduction of the expanded tool mode.

‘ = . ‘ Maxirrlum number Function of the Circle and Buffer measuring tools
of points to be Maximum number of measuring points acquired with
measured one entry (Enter).

‘ = \ﬂ N ‘ Distance of points to Function of the Contour measuring tool
be measured Distance between the measuring points that are

acquired with one entry (Enter).
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Operating Parameter Function
element
-n Number of points to Function of the Contour measuring tool
be measured Number of points to be measured is only taken into

account if the Distance of points to be measured
parameter is set to "0".

Number of measuring points acquired with one entry
(Enter).

Tool size and position  Resets the measuring tool to the default size, default
alignment and default position
The default position is at the center of the camera's
field of view.
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6.6.3 Using VED measuring tools

Display Meaning

Search range

The Single edge, Circle and Buffer measuring tools have
an edge that indicates the search range of the tool.

The edge of the Contour measuring tool indicates the end
point of measuring point acquisition.

The scan direction of the search range is indicated by an
arrow.

Handles

The handles are located on the edge or the axes of the
measuring tools.

D Active handles are shown with an outline around the

handle.

The direction of motion of the active handle is indicated by
arrows next to the handle.

Crosshair

Display Activity

Relocating the crosshairs

HEIDENHAIN . -, . .
» Tap the desired position in the live
image

| | | | | | | | ! > The crosshairs jump to the selected

. position

Shifting the crosshairs

» Touch a place in the live image and
drag the crosshairs to the desired
position

HEIDENHAIN
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Display

Basic operation | Using measuring tools

Activity

Zooming

To precisely position the measuring

tool, you can use the zoom function to

magnify the immediate vicinity of the

crosshairs.

» Long-press the crosshairs or their
vicinity

» Drag the magnifying glass with the
crosshairs to the desired position

> The crosshairs move with motion
reduction

» To exit the zoom function, tap X on
the edge of the magnifying glass

You can change the motion reduction
of the zoom function in the settings of
the measuring tool.

HEIDENHAIN

Moving the crosshairs in an axis

» Touch an axis of the crosshairs and
drag the crosshairs along the axis
to the desired position

> The crosshairs move with motion
reduction

HEIDENHAIN

11111
o« \ =

Aligning the crosshairs

» Touch a handle of the crosshairs
and drag the crosshairs to the
desired orientation
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Single edge

Display Activity

Relocating the single edge

HEIDENHAIN

» Tap the desired position in the live
image

> The single edge jumps to the
selected position

Shifting the single edge

» Touch a place in the live image and
drag the single edge to the desired
position

HEIDENHAIN

Moving the single edge in an axis

» Touch an axis of the single edge
and drag the single edge along the
axis to the desired position

> The single edge moves with
motion reduction

HEIDENHAIN

Aligning the single edge
» Touch a handle of the single edge

and drag the single edge to the
desired orientation

HEIDENHAIN

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016 89



90

Circle
Display

HEIDENHAIN

Basic operation | Using measuring tools

Activity

Relocating the circle

» Tap the desired position in the live
image

> The circle jumps to the selected
position

HEIDENHAIN

Shifting the circle

» Touch a place in the live image
and drag the circle to the desired
position

HEIDENHAIN

Resizing the search range

» Touch the outer edge of the search
range and drag it to the desired size

> The size of the inner edge changes
proportionally

» Touch the inner edge of the search
range and drag it to the desired size

HEIDENHAIN

Reversing the scan direction of the
search range

» Touch the inner edge of the search
range and drag it over the outer
edge

> The arrows indicate the changed
scan direction

HEIDENHAIN

Adjusting the search range angle

To limit the search range, you can
adjust the search range angle. This
makes it possible, for example, to
acquire measuring points on circular
arcs.

» Touch the handle of the circle and
drag the handle along the outer
edge

> The search range is inside the
circular arc delimited by the
handles
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Buffer

Display

HEIDENHAIN ! ] ‘

Activity

Relocating the buffer

» Tap the desired position in the live
image

> The buffer jumps to the selected
position

Shifting the buffer

» Touch a place in the live image
and drag the buffer to the desired
position

Aligning the buffer

» Touch a handle of the buffer and
drag the buffer to the desired
orientation

- -

Resizing the search range

» Touch the edge of the search range

and drag it to the desired size

> The search range is changed along

the axis at an equal distance from
the center
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Contour
Display Activity

Relocating the contour
HEIDENHAIN

| | | | | | | | ! > The contour jumps to the selected

. position

» Tap the desired position in the live
image

Shifting the contour

HEIDENHAIN

» Touch a place in the live image and
drag the contour to the desired
position

Aligning the contour

» Touch a handle of the contour and
drag the contour to the desired
orientation

HEIDENHAIN

Resizing the contour
» Touch a handle of the contour and
drag the contour to the desired size

> The contour is changed along the
axis at an equal distance from the
center
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Display

HEIDENHAIN

Activity

Separating start point and end
point

To measure a contour, you can
separate the start point and the end
point of measuring point acquisition.
The measuring points are acquired
between the contour and the edge of
the circle, depending on the search
direction.

» Touch the search range (circle) and
drag it to the desired position

> The position of the contour remains
unchanged

HEIDENHAIN I o ‘

S

Adjusting the search direction

The indicator at the contour shows the
search direction along the measured
object for the acquisition of measuring
points. The measuring points are
acquired between the contour as the
start point and the circle as the end
point.

» Touch the indicator at the contour

and drag the indicator to the other
side of the contour

> The search direction of the
measuring point acquisition is
changed
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Basic operation | Adjusting the lighting

Adjusting the lighting

0 The lighting palette is only available if an optical sensor is active. The
selection and the range of functions depend on the device settings and
the connected light unit.

You can connect two different light sources and one laser pointer to the product
and adjust them separately.

= Transmitted light: Light source below the measured object (backlight)
m Reflected light: Light source with four segments that can be switched indi-

vidually

® |aser pointer: Point light above the measured object that can be used as a

positioning aid

Displaying the lighting palette

>
>

Laser pointer

TH WN=

Tap Measure in the main menu

The user interface for measuring, constructing and defining is
displayed

Select Manual measuring

If required, tap Live image preview in the Inspector

The live image is shown in the workspace

Tap Lighting palette
The operating elements of the lighting palette are displayed

2 3

Preset 2 Preset 3 Preset 4

Slider for transmitted light
Preset operating elements
Segment switch for reflected light

Slider for the reflected-light segments

o Set the lighting according to the properties of the measured object.
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Operating
element

Short description

Transmitted light slider for setting the light intensity for
the transmitted light.

w

Preset toggle switch for selecting and saving the desired
preset settings. The active preset is displayed in green.

Laser pointer operating element for switching a connected
laser pointer on and off. When the laser pointer is on, the
operating element is displayed in green.

Reflected light slider for setting the light intensity for the
reflected-light segments.

Segment switch for selecting the active reflected-light
segments. To activate all segments, select All. Active
segments are displayed in green.

Further information: "Setting the lighting", page 124
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6.8 Switch-on/Switch-off

6.8.1 Switch-on

o Before using the product, you need to perform the commissioning
and setup steps. Depending on the purpose of use, you may have to
configure additional setup parameters.

Further information: "Commissioning", page 103

» Turn the power switch on
The power switch is on the rear side of the unit

> The unit powers up. This can take a moment

> |f automatic user login is active, the user interface is displayed in the Measure
menu
Further information: "Measure menu", page 64

> |f automatic user login is not active, the User login menu is displayed
Further information: "User login and logout", page 98

6.8.2  Activating and deactivating the energy-saving mode

If you will not be using the unit for a while, you should activate the energy-saving
mode. This switches the unit to an inactive state without interrupting the power
supply. The screen is switched off in this state.

Activating energy-saving mode

» Tap Switch off in the main menu

» Tap Energy-saving mode
> The screen switches off

Deactivating energy-saving mode
Tap anywhere on the touchscreen

An arrow appears at the bottom of the screen
Drag the Arrow up

The screen is switched on and shows the user interface last
displayed

VvV vV VY
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6.8.3 Switch-off

NOTICE

Damage to the operating system!

Disconnecting the power source while the product is on can damage the
operating system of the product.

» Use the Switch-off menu on the touchscreen to shut down the product.
» Do not disconnect the power source while the product is on.

» Do not turn the power switch off until the product has shut down.

> Tap Switch off in the main menu

» Tap Shut down
>

The operating system shuts down

» Wait until the following message appears on the screen: To
restart the device, switch it off and then back on.

» Turn the power switch off
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6.9 User login and logout

In the User login menu, you can log in and out of the product as a user. The
product provides various authorization levels that grant the user full or restricted
access to management and operation functionality.

Further information: "User permissions’, page 335

Activation

> Tap User login in the main menu

HEIDENHAIN

QUADRA-CHEK 3014 NC

fo\ Operator

e
EZS

1 Display of the logged-in user
2 User login

Only one user can be logged in to the product at a time. The logged-in user is
displayed.
Before a new user can log in, the logged-in user has to log out.

User logout
- > Tap Log out
= .
> The user is logged out

> The functions of the main menu are inactive, except for
Switch off

> The product can only be operated again after a user has
logged in
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User login

» In the drop-down list, select the user you want to log in
» Tap the Password input field

» Enter the user's password
Further information: "Factory default settings”, page 312

o If a password other than the default password
has been assigned to the user, ask a Setup or
OEM user for the assigned password.
If the password is no longer known, contact a
HEIDENHAIN service agency.

» Confirm the entry with RET

» Tap Log in
> The user is logged in and the Measure menu is displayed.
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6.10 Messages and audio feedback

6.10.1 Messages
2

% The pixel size has not yet been specified for the
20:39 - 5
selected magnification level!

HEIDENHAIN

. \ -
‘

1 Message display area, displays the time and the number of unclosed messages
2 Message list

The messages that appear at the top of the workspace are generated as a result
of e.g. operator errors, uncompleted processes, or successfully completed
measuring programs.

The messages are displayed on occurrence of the message cause or when you tap
the Messages display area at the top left of the screen.

Viewing messages
> The message list opens
Resizing the display area

> To resize the message display area, drag the handle up or
down

» To close the display area, drag the handle up out of the
screen

> The number of unclosed messages is indicated in Messages

Closing messages

» Tap Close to close a message

| X
| ‘ > The message disappears
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6.10.2 Wizard

HEIDENHAIN

1 Wizard (example)

The wizard supports the user when performing teach-in processes or handling
procedures, and when executing measuring programs.

You can move the wizard in the workspace.

The operating elements provided by the wizard depend on the work step or

process.
» To undo the last work step or repeat the process, tap Undo
» To confirm the displayed work step, tap Confirm
> The wizard proceeds to the next step or concludes the
process
» Tap Close to close the wizard

6.10.3 Audio feedback

The product can also provide audio feedback to indicate user actions, completed
processes or malfunctions.

The available sounds are grouped into categories. The sounds differ within a
category.

You can define the audio feedback settings in the Settings menu.
Further information: "Sounds’, page 314
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71 Overview

0 Make sure that you have read and understood the "Basic Operation"
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

o The following steps must be performed only by qualified personnel.
Further information: "Personnel qualification", page 19

During commissioning, the machine manufacturer's commissioning engineer
(OEM) configures the product for use in the specific measuring machine.

The settings can be reset to the factory defaults.
Further information: "Resetting to the factory defaults", page 350

Backing up the configuration

To back up the settings, you can back up the configuration data after
commissioning or setup. These configuration data can be reused for equivalent
products.

Before the backed-up configuration data can be restored to a product, the software
options that were active during the backup must be activated on the respective
product.

Further information: "Backing up and restoring the configuration®, page 346
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7.2 Logging in for commissioning

In the User login menu, you can log in and out of the product as a user. The

product provides various authorization levels that grant the user full or restricted

access to management and operation functionality.

Login

To commission the product, the OEM user must log in.

vV v VvyYvyy

>
>

Tap User login in the main menu

If required, log out the user who is currently logged in
Select the OEM user

Tap the Password input field

Enter the password 'oem’

o If a password other than the default password
has been assigned to the user, ask a Setup or
OEM user for the assigned password.

If the password is no longer known, contact a
HEIDENHAIN service agency.

Tap Log in

The user is logged in and the Measure menu is displayed.

Performing the reference mark search after startup
> After logging in, follow the instructions of the wizard

> On successful completion of the reference mark search, the display color of the

axis position changes from red to white
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Setting the language
The default language for the user interface is English. The language can be set
individually for each user.

> Tap Settings in the main menu.

Q

Tap User
The logged-in user is indicated by a check mark
Select the logged-in user

The language selected for the user is indicated by a national

flag in a drop-down list

» Select the flag for the desired language in the Language
drop-down list

> The user interface immediately switches to the selected

language

VvV v.Vv VY

Changing the password
The password must be changed to prevent unauthorized configuration.

The password is confidential and must not be disclosed to any other person.

» Tap Settings in the main menu

O

Select User

The logged-in user is indicated by a check mark
Select the logged-in user

Tap Password

Enter the current password

Confirm the entry with RET

Enter the new password and repeat it

Confirm the entries with RET

Tap OK

Close the message with OK

The new password is available the next time the user logs in

V VvV vV vV vV VvV VvVVvVVY
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7.3 Commissioning steps

The steps for commissioning the product should be performed in the sequence in
which they are described in the following sections.

Sec. 7.3.1: Sec. 73.2: Sec. 7.3.3:
> 4

Basic settings Configuring the axes Configuring VED sensors

Setting the date and time Activating the reference mark Setting the camera

Setting the units of measure search Setting the magnification

Entering and configuring users and Setting axis parameters Setting the lighting

passwords Configuring axis error compensa- Setting the camera orientation

Enabling software options tion Adjusting the contrast settings
Determining the pixel sizes

NOTICE

Loss of or damage to configuration data!

» Back up the configuration data for restoration purposes and keep the backup
safe.
Further information: "Backing up and restoring the configuration’,
page 346

7.3.1 Basic settings

Sec. 7.3.1: Sec. 7.3.2: Sec. 7.3.3:

Basic settings Configuring the axes Configuring VED sensors

Setting the date and time

> Tap Settings in the main menu

@ » Tap General
» Tap Date and time

» To set the date and time in the middle line, drag the columns
up or down

> Tap Set to confirm

> Select the desired format in the Date format list:
5 MM-DD-YYYY: Display as month, day, year
" DD-MM-YYYY: Display as day, month, year
5 YYYY-MM-DD: Display as year, month, day
Further information: "Date and time", page 316
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Setting the units of measure

The product provides various parameters for setting the units of measure, decimal
places and rounding methods.

> Tap Settings in the main menu

@ » Tap General
» Tap Units
» To set a unit of measure, tap the corresponding drop-down
list and select the unit
» To reduce or increase the number of decimal places
displayed, tap - or +
Further information: "Units", page 316

Enabling software options
Additional software options are enabled in the product via a license key.

Overview of software options
The overview page shows you which software options are enabled in the product.

> Tap Settings in the main menu

» Tap Service
% » Open in the sequence
m Software options
® Overview

> A list of enabled software options is displayed

Requesting a license key
You can request a license key by

= Reading out device information for the license key request
® Creating a license key request
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Reading out device information for the license key request

> Tap Settings in the main menu

@ Tap General
Tap Device information

An overview of the device information appears

The product name, part number, serial number and firmware
version are displayed

» Contact a HEIDENHAIN service agency and request a license
key for the product

> The license key and the license file are generated and sent to
you by e-mail

> You can read the license key from the provided license file
into the product or enter it manually

vV Vv Vvy
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Creating a license key request

> Tap Settings in the main menu

% » Tap Service
> Tap Software options

» To request a software option that is available for a fee, tap
Request options

» To request a free trial version, tap Request trial options

> To select a QUADRA-CHEK 3000 AEI1 software option,
use - and + to specify the number of additional encoder
inputs

> To select the QUADRA-CHEK 3000 VED software option, tap
the check mark

o » To deselect an entry, tap the check mark for
the respective software option

» Tap Creating a request

v

In the dialog, select the storage location in which you want to
save the license key request

Enter a suitable file name
Confirm the entry with RET
Tap OK

The license key request is created and saved in the selected
folder

v v vy

> If the license key request is stored in the product, move the
file to a connected USB mass storage device or the network
drive
Further information: "Moving a file", page 306

> Contact a HEIDENHAIN service agency and request a license
key for the product

> The license key and the license file are generated and sent to
you by e-mail

> You can read the license key from the provided license file
into the product or enter it manually
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Activating a license key

You can activate a license key by
B Reading the license key from the provided license file into the product

B Entering the license key manually into the product

Reading the license file

>

2 .

VvV v.v VvY v

v

Tap Settings in the main menu

Tap Service

Open in the sequence
= Software options
= Activate options
Tap Read license file

Select the license file in the file system, on the USB mass
storage device or on the network drive

Confirm your selection with OK
Tap OK

The license key is activated
Tap OK

You may need to restart the product, depending on the
software option

Confirm the restart with OK
The activated software option is available

Entering the license key

>

2 :

VvV vV v Vv Y

v

Tap Settings in the main menu

Tap Service

Open in the sequence

= Software options

B Activate options

Enter the license key into the License key input field
Confirm entry with RET

Tap OK

The license key is activated

Tap OK

You may need to restart the product, depending on the
software option

Confirm the restart with OK

> The activated software option is available
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73.2 Configuring the axes

Sec. 73.1: Sec. 7.3.2: Sec. 73.3:

Basic settings Configuring the axes Configuring VED sensors

Activating the reference mark search

The reference mark search must be performed to ensure that the relationship
between the axis positions and the measuring plate is reproducible.

Requirement: The encoders installed in the measuring machine have reference
marks that have been configured in the axis parameters.

If the reference mark search has been activated, a wizard appears on startup of the
product and asks the user to move the axes of the encoder.

o The reference mark search performed on startup of the product can
only be canceled if an OEM or Setup user is logged in. Users of the
Operator type cannot cancel the reference mark search.

> Tap Settings in the main menu

S > Tap Axes
» Open in the sequence
" General settings
m Reference marks
» Set the sliding switch to ON

> The reference marks of the encoder must be traversed every
time the product is started

> The functions of the product will only be available after the
reference mark search has been completed

> On successful completion of the reference mark search, the
display color of the axis position changes from red to white

Further information: "Axes", page 337

Starting the reference mark search

> Tap Settings in the main menu

» Open in the sequence
= Axes
B General settings
® Reference marks
> Tap Start
> Existing reference marks are cleared

> The display color of the axis position changes from white to
red

» Follow the instructions of the wizard

> On successful completion of the reference mark search, the
display color of the axis position changes from red to white
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Setting axis parameters

Linear encoders
The following overview provides examples of HEIDENHAIN linear encoders that
can be connected to the product.

Encoder series Interface Signal period Reference mark Maximum

traverse path

LS 328C TTL 20 ym Coded /1000 20 mm

AK LIDA 27 TTL 20 ym One -

4 um
2 um

AK LIDA 47 TTL 4 um One -

4 um Coded / 10007 20 mm
2 um One -
2 um Coded / 10007 20 mm

LS 388C 1 Vpp 20 um Coded /1000 20 mm

AK LIDA 28 1 Vpp 200 ym One -

AK LIDA 48 1 Vpp 20 ym One -

AK LIF 48 1 Vpp 4 um One -

") "Coded/1000" only in conjunction with the LIDA 4x3C scale

Angle encoders

The following overview provides examples of HEIDENHAIN angle encoders that

can be connected to the product.

Encoder series Interface Line count/ Reference mark Nominal
outputs signals increment
per revolution

RON 225 TTLx2 18 000 One -

RON 285 1 Vpp 18 000 One -

RON 285C 1 Vpp 18 000 Coded / 1000 20°

RON 785 1 Vpp 18 000 One -

RON 785C 1 Vpp 18 000 Coded / 1000 20°

RON 786 1 Vpp 18 000 One -

RON 786C 1 Vpp 18 000 Coded / 1000 20°

ROD 220 TTLx2 18 000 One -

ROD 280 1 Vpp 18 000 One -

ROD 280C 1 Vpp 18 000 Coded / 1000 20°
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Adjusting the encoder

o The adjustment procedure is the same for each axis. The following
section describes only the configuration of the X axis.

> Tap Settings in the main menu

Tap Axes

Tap X

Select the axis in the Axis name drop-down list

Tap Encoder

Specify the connection (X1 - X4) for the respective encoder in
the Encoder input drop-down list

> |f required, select the type of incremental signal in the
Incremental signal drop-down list:

vV v vyYvyy

® 1 Vpp: Sinusoidal voltage signal
® 11 pApp: Sinusoidal current signal
> Select the encoder model in the Encoder model drop-down
list:
B Linear encoder: Linear axis
® Angle encoder: Rotary axis

» Depending on whether you will be using a linear encoder or
an angle encoder, enter the appropriate value in the Signal
period or Line count input field

» Confirm entry with RET
> Select the reference mark in the Reference mark drop-down
list:
B None: There is no reference mark
B One: The encoder has one reference mark
B Coded: The encoder has distance-coded reference marks

> If the linear encoder has coded reference marks, enter the
Maximum traverse path

» Confirm entry with RET

> |If the angle encoder has coded reference marks, enter the
Nominal increment

» Confirm entry with RET

In the Analog filter frequency drop-down list, select
the frequency of the low-pass filter for suppressing high-
frequency interference signals:

® 33 kHz: Suppression of interference frequencies above 33
kHz

® 400 kHz: Suppression of interference frequencies above
400 kHz

» Activate or deactivate the Terminating resistor
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o The terminating resistor is deactivated
automatically for incremental signals of the
current signal type (11 yApp).

> Select the type of error monitoring in the Error monitor
drop-down list:

= Off: Error monitoring not active
= Amplitude: Error monitoring of signal amplitude
B Frequency: Error monitoring of signal frequency

B Frequency & amplitude: Error monitoring of signal
amplitude and signal frequency

> Select the desired counting direction in the Counting
direction drop-down list:

® Positive: The direction of traverse corresponds to the
counting direction of the encoder

® Negative: The direction of traverse does not correspond
to the counting direction of the encoder

Further information: "Axis settings", page 341

Configuring error compensation in the axis

The axes of a measuring machine are subject to mechanical influences, such as
guideway errors, tilting in the end positions, tolerances of the bearing surface or
poor mounting (Abbe error). To compensate these influences, the products provide
the possibility to perform not only linear error compensation (LEC) over the entire
measuring range, but also segmented linear error compensation (SLEC). In this
way, even nonlinear error curves can be compensated down to a comparatively
small residual error. For both methods, the actual error curve of the entire axis
must be exactly measured with a comparator system or calibration standard over
the path whose error is to be compensated.

o The linear error compensation (LEC) or segmented linear error
compensation (SLEC) is performed for each linear axis. The procedure is
the same for each axis.
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Configuring linear error compensation

To perform linear error compensation (LEC), you enter two supporting points to
define the axis as a single segment covering the entire measuring range. The
deviation between the segment length and the actual distance traversed in the
segment determines the compensation value that compensates the mechanical
influences acting on the axis. The compensation value is calculated by subtracting
the actual distance traversed from the segment length.

o For linear error compensation (LEC), use the segmented linear error
compensation (SLEC) function to enter two supporting points that
define the axis as a single segment covering the entire measuring
range. In this way, linear compensation of the axis is performed over
the entire segment.

>

Tap Settings in the main menu

> Tap Axes

Select the axis

» Open in the sequence

VV Vv VvV VvV VvVVvVYy

v

® Error compensation
= Segmented linear error compensation (SLEC)
Deactivate Compensation with the ON/OFF sliding switch

Tap Create table of supporting points

Tap + or - to set the Number of supporting points
Enter the Spacing of the supporting points
Confirm the entry with RET

Enter the Start point

Confirm the entry with RET

Tap Create to create the table of supporting points
The table of supporting points is created

The table lists the supporting point positions (P) and the
compensation values (D) of the individual segments

Enter the compensation value (D) "0.0" for supporting point 0

» Confirm the entry with RET

>
>
>

Enter the determined compensation value (D) for supporting
point 1

Confirm the entry with RET

To switch to Segmented linear error compensation (SLEC),
tap Table of supporting points

Tap Create table of supporting points
Activate Compensation with the ON/OFF sliding switch
The linear error compensation for the axis is applied

Further information: "Segmented linear error compensation
(SLEC)", page 343
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Configuring segmented linear error compensation

To perform segmented linear error compensation, you can enter up to 200
supporting points to divide the axis into segments of any desired length. The
deviations between the actual distance traversed and the segment length in the
individual segments determine the compensation values that compensate the

mechanical influences acting on the axis. The compensation value is calculated by

subtracting the actual distance traversed from the segment length.

>

VV Vv vV VvV VvV vVvVvYVvyy

A A 4

Tap Settings in the main menu

Tap Axes

Select the axis

Open in the sequence

® Error compensation

= Segmented linear error compensation (SLEC)
Deactivate Compensation with the ON/OFF sliding switch

Tap Create table of supporting points

Tap + or - to set the Number of supporting points
Enter the Spacing of the supporting points
Confirm entry with RET

Enter the Start point

Confirm entry with RET

Tap Create to create the table of supporting points
The table of supporting points is created

The table lists the supporting point positions (P) and the
compensation values (D) of the individual segments

Enter the compensation value (D) "0.0" for supporting point O
Confirm entry with RET

Enter the determined compensation value into the
compensation value (D) input field for each supporting point

Confirm each entry with RET

> To switch to Segmented linear error compensation (SLEC),

>
4
>

tap Table of supporting points

Tap Create table of supporting points

Activate Compensation with the ON/OFF sliding switch
The linear error compensation for the axis is applied

Further information: "Segmented linear error compensation
(SLEC)", page 343
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Editing the existing Table of supporting points
Once the supporting point table for linear or segmented linear error compensation
has been created, it can be edited as needed.

> Tap Settings in the main menu

> Tap Axes
> Select the axis
» Open in the sequence
= Error compensation
E Segmented linear error compensation (SLEC)
» Deactivate Compensation with the ON/OFF sliding switch
> Tap Table of supporting points

> The table lists the supporting point positions (P) and the
compensation values (D) of the individual segments

» Adjust the compensation value (D) for the supporting points
» Confirm the entries with RET

» To switch to Segmented linear error compensation (SLEC),
tap Table of supporting points

» Activate Compensation with the ON/OFF sliding switch
> The adjusted linear error compensation for the axis is applied

Further information: "Segmented linear error compensation
(SLEC)", page 343

73.3 Configuring VED sensors

Sec. 7.3.1: Sec. 7.3.2: Sec. 7.3.3:

Basic settings Configuring the axes Configuring VED sensors

If the QUADRA-CHEK 3000 VED software option is active, the VED sensor must
be configured. This section describes the configuration procedure.

Setting the camera

o The product supports the use of a connected camera. Connecting more
than one camera can lead to faulty settings and incorrect measurement
results.

If no camera is detected, the product will switch to the virtual camera.
In this case, the live image will show the 2-D demo part.
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Setting a USB camera

@

>

v

vVVV VvV VvV VYV

vV v v v v yvVvy

v

Tap Settings in the main menu

Tap Sensors

Open in the sequence

B Video edge detection (VED)

= Camera

The list of available cameras is displayed

USB cameras are indicated by (USB) at the end of their name
Tap the USB camera you want to use

Tap Activate first, if necessary, to activate an inactive camera
The camera is activated

The first lines show the camera data

Select the desired pixel format in the Pixel format drop-
down list

Tap - or + to set the Pixel clock (MHz)

Tap - or + to set the Image rate

Tap - or + to set the Detail: Width

Tap - or + to set the Detail: Height

Tap - or + to set the Detail: X position

Tap - or + to set the Detail: Y position

Drag the slider to the desired position to adjust the Master
gain

Drag the slider to the desired position to adjust the Red gain
Drag the slider to the desired position to adjust the Green
gain

Drag the slider to the desired position to adjust the Blue gain

> Tap - or + to set the Exposure time (ps)

>

The new camera settings are applied

Further information: "Camera’, page 318
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Setting an Ethernet camera

@

>

VvV V

vVVyVVYyy

vV Vv

vV VvV vV vV vV vVVVvYy

v

Tap Settings in the main menu

Tap Sensors

Open in the sequence

B Video edge detection (VED)

= Camera

The list of available cameras is displayed

Ethernet cameras are indicated by (GigE) at the end of their
name

Tap the Ethernet camera you want to use

Tap Activate first, if necessary, to activate an inactive camera
The camera is activated

The first lines show the camera data

Select the desired pixel format in the Pixel format drop-
down list

Tap Network settings
The Network settings dialog appears

Depending on the network environment, activate or
deactivate DHCP with the ON/OFF sliding switch

In the dialog, enter the IPv4 address and IPv4 subnet mask
you want to use

Confirm each entry with RET

Save the settings in the dialog with OK

The dialog is closed

Tap - or + to set the Pixel clock (MHz)

Tap - or + to set the Image rate

Tap - or + to set the Detail: Width

Tap - or + to set the Detail: Height

Tap - or + to set the Detail: X position

Tap - or + to set the Detail: Y position

Drag the slider to the desired position to adjust the Master
gain

Drag the slider to the desired position to adjust the Red gain
Drag the slider to the desired position to adjust the Green
gain

Drag the slider to the desired position to adjust the Blue gain

> Tap - or + to set the Exposure time (ps)

>

The new camera settings are applied

Further information: "Camera’, page 318
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Activating the virtual camera

To try out examples described in these instructions, you can activate a virtual
camera. When you use the virtual camera, an image of the 2-D demo part is
displayed in the live image.

> Tap Settings in the main menu
@ » Tap Sensors
» Open in the sequence

B Video edge detection (VED)

= Camera

The list of available cameras is displayed

Tap the virtual camera you want to use

Tap Activate first, if necessary, to activate an inactive camera
The camera is activated

vV v vV

Replacing the live image of the virtual camera

When you use a virtual camera, an image is displayed in the workspace. You can
replace this image with an image of your choice, provided that a geometry in that
image is known and can be used for determining the pixel size.

o Only images in the PNG and JPG file formats and with an image size of
1280 px x 1024 px can be displayed.

> Tap Settings in the main menu
@ » Tap Sensors
» Open in the sequence

® Video edge detection (VED)

= Camera

The list of available cameras is displayed

Tap the virtual camera you want to use

Tap Activate first, if necessary, to activate an inactive camera

vV V.V YV

To select the source for the image displayed in the
workspace, tap Image directory

Select the folder and confirm with OK

> The image stored in the selected folder is displayed in the
workspace

v

Further information: "Camera’, page 318
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Setting the magnification

For camera systems with adjustable optical magnifications, the pixel size must be
determined for each magnification. This ensures the correct size ratio between
the live image and the measured object during a measurement. Before the pixel
sizes can be determined for the magnifications, the magnifications provided by the
measuring machine need to be entered into the product.

Further information: "Determining the pixel sizes", page 129

The number of magnifications depends on the measuring machine connected to
the product.

Adjusting the magnification

» Tap Settings in the main menu
@ » Tap Sensors
» Open in the sequence

B Video edge detection (VED)

B Magnifications

Set a magnification in the camera system, e.g. 1.0
Tap VED Zoom 1, for example

Tap the Description input field

Adapt the existing description

Confirm entry with RET

Tap the Acronym for quick access menu input field
Adapt the existing acronym

Confirm entry with RET

The magnification list shows the magnification together with
the adapted information

VvV v vV vV vV v vVVvY

Further information: "Magnifications", page 320
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Adding a magnification

> Tap Settings in the main menu
@ » Tap Sensors
» Open in the sequence

B Video edge detection (VED)

= Magnifications

Set a magnification in the camera system, e.g. 2.0
Tap Add

Tap the Description input field

Enter a description for the magnification you have set
Confirm entry with RET

Tap the Acronym for quick access menu input field
Enter a meaningful acronym

Confirm entry with RET

The acronym is needed for selecting the magnification in the
quick access menu of the Inspector

Tap Add
> The new magnification appears in the magnification list

V v vV vV vV v vVVvYy

v

Further information: "Magnifications", page 320

Removing magnifications
Magnifications that are no longer needed can be removed from the list.

o Only inactive magnifications can be removed.

Tap Measure in the main menu

Tap the quick access menu in the Inspector
Select a magnification that is not to be deleted
Tap Settings in the main menu

@

v vywvyy

v

Tap Sensors

» Open in the sequence

® Video edge detection (VED)

B Magnifications

The active magnification is indicated by a check mark
Tap the inactive magnification that you want to remove
Tap Remove

To confirm the removal, tap Remove in the dialog

The magnification is removed from the magnification list

vV v vV VvV YV
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Setting the lighting

Linking the lighting to the magnification

The light intensity that reaches the VED sensor, e.g. through the camera optics,
decreases with increasing magnification. To compensate the reduced brightness,
you can link the lighting to the magnification.

> Tap Settings in the main menu
@ » Tap Sensors
» Open in the sequence

B Video edge detection (VED)
= Lighting
» Tap General settings

» To activate or deactivate the link between the lighting and the
magnification, drag the ON/OFF sliding switch to the desired
setting

> When the link is active, the lighting settings are saved for the
respective magnification

> When the link is not active, you need to manually adjust the
lighting if you change the magnification
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Lighting configurations
The range of lighting functions depends on the lighting unit of the connected
measuring machine.

The product supports the following configurations:

® A transmitted light + 4 x AD reflected light

B A trans.light + 4 x A refl.light + D laser pointer
Further information: "Lighting", page 321

Setting the lighting configuration A transmitted light + 4 x AD reflected light

>

@ >

v

vV v.vy

>

Tap Settings in the main menu

Tap Sensors

Open in the sequence

B Video edge detection (VED)

= Lighting

The list of available lighting configurations is displayed
Tap A transmitted light + 4 x AD reflected light

If necessary, tap Activate to activate an inactive lighting

Select the desired analog output in the Analog output for
transmitted light drop-down list

Select the desired analog output in the Analog output for
reflected light drop-down list

Select the desired digital output in the Digital output for
front segment drop-down list

Select the desired digital output in the Digital output for
rear segment drop-down list

Select the desired digital output in the Digital output for left
segment drop-down list

Select the desired digital output in the Digital output for
right segment drop-down list

The lighting can now be adjusted with the lighting palette.

Further information: "Lighting", page 321
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Setting the lighting configuration A trans.light + 4 x A refl.light + D laser
pointer

> Tap Settings in the main menu

» Tap Sensors
@ Open in the sequence
B Video edge detection (VED)
= Lighting
The list of available lighting configurations is displayed
Tap A trans.light + 4 x A refl.light + D laser pointer
If necessary, tap Activate to activate an inactive lighting

Select the desired analog output in the Analog output for
transmitted light drop-down list

v

vV v.vy

> Select the desired analog output in the Analog output for
front segment drop-down list

> Select the desired analog output in the Analog output for
rear segment drop-down list

> Select the desired analog output in the Analog output for
left segment drop-down list

> Select the desired analog output in the Analog output for
right segment drop-down list

> Select the desired digital output in the Digital output for
laser pointer drop-down list

> The lighting can now be adjusted with the lighting palette.

Further information: "Lighting", page 321
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Setting the camera orientation

A slight skew of the camera relative to the measuring plate of the measuring
machine can be compensated to a small extent by using the camera orientation
function.

o If the skew cannot be compensated by the product, a mechanical
alignment needs to be performed.

> Tap Settings in the main menu

> Tap Sensors
@ » Open in the sequence
® Video edge detection (VED)
= Camera orientation
Tap Start
The teach sequence is started

The wizard is displayed in the Measure menu
Follow the instructions of the wizard

VvV VvV VvV VvV Yy

The successful measurement of the camera skew is
displayed

Tap Confirm to confirm the measured camera skew
The measured value is displayed in Camera skew
The value can be adjusted by direct entry

Tap Undo to repeat the teach sequence

vV yVvVy

» Tap Close to close the wizard

Further information: "Camera orientation", page 327
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Adjusting the contrast settings

The currently selected contrast threshold of the product may need to be adjusted
to varying brightness conditions of the surroundings, e.g. changes in daylight. The
contrast threshold defines the contrast value starting from which the product will
recognize a light-to-dark transition as a transition.

A change in brightness could result in light-to-dark transitions—and therefore
edges—being detected earlier or later, thus falsifying the measurements.

@

EE E D

>

Tap Settings in the main menu

Tap Sensors

Open in the sequence

® Video edge detection (VED)

= Contrast settings

Select the Edge algorithm for the edge detection

Tap Start

The teach sequence is started and the Measure menu is
displayed

Follow the instructions of the wizard

Select the lighting palette

Adjust the sliders to achieve the highest possible contrast at
the edge

Tap Confirm in the wizard to confirm the positioning of the
measuring tool and the lighting settings

The teach sequence is complete
Tap Undo to repeat the teach sequence

Tap Close to close the wizard

Further information: "Contrast settings', page 328
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Determining the pixel sizes
When measuring with a VED sensor, the measurement is performed in the live

image on the product. To ensure that the size of the live image matches that of the

measured object, the pixel size must be determined for each magnification.

@

EE B

>

Tap Settings in the main menu

Tap Sensors

Open in the sequence

B Video edge detection (VED)
B Pixel sizes

Tap Magnification

Select the desired magnification

In Calibration standard diameter, enter the diameter of
the desired circle, which is specified in the calibration chart
supplied with the calibration standard

Confirm entry with RET
Tap Start

The teach sequence is started and the wizard is displayed in
the Measure menu

Follow the instructions of the wizard

Tap Confirm to confirm that you have completed the wizard's
instructions

The teach sequence is complete
Tap Undo to repeat the teach sequence

Tap Close to close the wizard

Repeat the procedure to determine the pixel sizes for all
available magnifications

Further information: "Pixel sizes", page 329
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74 OEM area

The OEM area enables commissioning engineers to install custom information in
the product:

B Documentation: OEM documentation, e.g. service information

B Opening screen: Adjustment of the startup screen, e.g. to display the OEM's
company logo

741 Adding the OEM documentation

o Only documents in PDF format can be added. Other documents are not

displayed.
> Tap Settings in the main menu
% > Tap Service
» Open in the sequence
= OEM area

® Documentation
= Add OEM service info

» |f required, connect a USB mass storage device to a USB
port of the product

» To navigate to the desired file, tap the location where the file
is stored

o If you have accidentally tapped the wrong folder,
you can return to the previous folder. Tap the file
name that is displayed above the list.

Navigate to the folder containing the file
Tap the file name
Tap OK

The document is copied to the product and displayed in the
service information area

vV v v Vv

» Confirm the successful transfer with OK
Safely removing a USB mass storage device

>
>
PR » Tap Safely remove
» Disconnect the USB mass storage device

Tap File management in the main menu
Navigate to the list of storage locations
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74.2 Adjusting the startup screen

The product can display a custom startup screen, e.g. the company name or logo.
The corresponding image needs to be stored on the product for this purpose.

Requirements
= File format: PNG or JPG

= Resolution: 96 ppi

B |mage format: 16:10
Images in other formats will be scaled proportionally

B |mage size: Max. 1280 x 800 px

Inserting a startup screen

> Tap Settings in the main menu
% > Tap Service
» Open in the sequence

= OEM area
® Opening screen
m Select the startup screen

» |f required, connect a USB mass storage device to a USB
port of the product

» To navigate to the desired file, tap the location where the file
is stored

o If you have accidentally tapped the wrong folder,
you can return to the previous folder. Tap the file
name that is displayed above the list.

Navigate to the folder containing the file
Tap the file name
Tap OK

The image is copied to the product and displayed the next
time the product is started

» Confirm the successful transfer with OK

vV v v Vv

Safely removing a USB mass storage device

> Tap File management in the main menu
» Navigate to the list of storage locations
] » Tap Safely remove
— » Disconnect the USB mass storage device
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8.1 Overview

0 Make sure that you have read and understood the "Basic Operation"
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

o The following steps must be performed only by qualified personnel.
Further information: "Personnel qualification", page 19

During setup, the setup engineer (Setup) configures the product for use with the
measuring machine in the respective measurement applications. This includes
setting up operators, defining measurement report templates, and creating
measuring programs.

Backing up the configuration

To back up the settings, you can back up the configuration data after
commissioning or setup. These configuration data can be reused for equivalent
products.

Before the backed-up configuration data can be restored to a product, the software
options that were active during the backup must be activated on the respective
product.

Further information: "Backing up and restoring the configuration®, page 346
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8.2 Logging in for setup

In the User login menu, you can log in and out of the product as a user. The
product provides various authorization levels that grant the user full or restricted
access to management and operation functionality.

Login
To set up the product, the Setup user must log in.
Tap User login in the main menu

If required, log out the user who is currently logged in
Select the Setup user

Tap the Password input field and enter 'setup’ as the
password

vV vywvyy

o If a password other than the default password

has been assigned to the Setup user, ask the

machine manufacturer (OEM) for the assigned
password.

If the password is no longer known, contact a
HEIDENHAIN service agency.

» Confirm entry with RET

» Tap Log in

Performing the reference mark search after startup
> After logging in, follow the instructions of the wizard

> On successful completion of the reference mark search, the display color of the
axis position changes from red to white

Setting the language
The default language for the user interface is English. The language can be set
individually for each user.

» Tap Settings in the main menu.

Q

Tap User
The logged-in user is indicated by a check mark
Select the logged-in user

The language selected for the user is indicated by a national

flag in a drop-down list

> Select the flag for the desired language in the Language
drop-down list

> The user interface immediately switches to the selected

language

vV vV V
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Changing the password
The password must be changed to prevent unauthorized configuration.

The password is confidential and must not be disclosed to any other person.

> Tap Settings in the main menu
A Select User

ﬁ The logged-in user is indicated by a check mark

Select the logged-in user

Tap Password

Enter the current password

Confirm the entry with RET

Enter the new password and repeat it

Confirm the entries with RET

Tap OK

Close the message with OK

The new password is available the next time the user logs in

V VvV vV vV vV VvV Yy VvV VY
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8.3 Setup steps

The steps for setting up the product should be performed in the sequence in which

they are described in the following sections.

Sec. 8.3.1: Sec. 8.3.2: Sec. 8.3.3:

Basic settings > Configuring sensors Setting the measuring applica-
tion

Setting the date and time Adjusting the contrast settings Configuring the measuring point

Setting the units of measure Determining the pixel sizes acquisition

Entering and configuring users and Creating a template for measure-

passwords ment reports

Configuring the network Creating a measuring program

Setting up a printer

8.3.1 Basic settings

Sec. 8.3.1: Sec. 8.3.2:

Basic settings Configuring sensors

Sec. 8.3.3:

Setting the measuring application

Setting the date and time

» Tap Settings in the main menu

@ > Tap General
Tap Date and time

To set the date and time in the middle line, drag the columns

up or down
> Tap Set to confirm

> Select the desired format in the Date format list:
5 MM-DD-YYYY: Display as month, day, year
5 DD-MM-YYYY: Display as day, month, year
" YYYY-MM-DD: Display as year, month, day
Further information: "Date and time", page 316
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Setting the units of measure

The product provides various parameters for setting the units of measure, decimal
places and rounding methods.

4

© .

Tap Settings in the main menu

Tap General
Tap Units

To set a unit of measure, tap the corresponding drop-down
list and select the unit

To reduce or increase the number of decimal places
displayed, tap - or +
Further information: "Units", page 316

Entering and configuring users
The product defaults to three users with different rights:

= OEM
B Setup
® Operator

Further information: "User’, page 335
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Entering users and passwords
Requirement: OEM or Setup user is logged in.

You can use any characters for the user ID and the password. These entries are
case-sensitive.

Tap Settings in the main menu

» Tap User

> Tap Add
» Tap the User ID input field

+

0 The User ID is displayed for user selection, e.g.
at the login prompt.

The User ID cannot be changed later.

Enter the user ID

Confirm entry with RET

Tap the Name input field

Enter the name of the new user

Confirm entry with RET

Tap the Password input field

Enter any password

Confirm entry with RET

Re-enter the password in the Repeat password input field
Confirm entry with RET

vV vV vV vV vV v vV VvVYVvyYy

o You can show the contents of the two password
fields in plain text and hide them again:
» Use the ON/OFF sliding switch to show or hide
the contents

Tap OK
A message appears
Close the message with OK

The user account is created with the basic data; the user can
then further adjust the account settings

vV v Vv VY
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Configuring the user

After creating a new Operator-type user account, you can add or edit the following

user data:
5 Name

® First name
= Department
= Password
® |[anguage
= Auto login

If auto login is active for one or more users, the last user who
logged in is automatically logged in to the product on powerup
without entering the user ID and password.

Q

Tap Settings in the main menu

Tap User

» Select the user

v

vV Vv VvyYy

vV vV Vv vVvYyy

Tap the input field whose contents you want to edit: Name,
First name, Department

Edit the contents and confirm your changes with RET
To change the password, tap Password
The Change password dialog appears

When changing the password of the logged-in user, enter the
current password

Confirm entry with RET

Enter the new password and repeat it
Confirm the entries with RET

Tap OK

A message appears

Close the message with OK

To change the language, select the flag for the desired
language in the Language drop-down list

To activate or deactivate Auto login, use the ON/OFF sliding
switch

Further information: "User", page 335

Setup | Setup steps
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Entering and configuring new users
New users and their authorization settings are entered during setup of the product.

Further information: "Entering and configuring users", page 138

Deleting users
You can remove Operator-type users that are no longer needed.

Requirement: OEM or Setup user is logged in.

o OEM-type and Setup-type users cannot be deleted.

» Tap Settings in the main menu

Tap User

Tap the user you want to delete

Tap Remove user account

Enter the password of the authorized user (OEM or Setup)
Tap OK

The user is deleted

Q

VvV v v v.Vv Yy
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Configuring the network
For the network setting details, contact your network administrator.

o The configuration of the network settings is the same for all network
connections.

> Tap Settings in the main menu

Tap Interfaces

Tap Network

Tap the desired interface (X116 or X117)
The MAC address is detected automatically

Depending on the network environment, activate or
deactivate DHCP with the ON/OFF sliding switch

> |f DHCP is active, the network settings are obtained
automatically as soon as the IP address is assigned

> |f the DHCP protocol is not active, enter the IPv4 address,
IPv4 subnet mask and IPv4 standard gateway

» Confirm the entries with RET

» Depending on the network environment, activate or
deactivate IPv6 SLAAC with the ON/OFF sliding switch

> |f IPv6 SLAAC is active, the network settings are obtained
automatically as soon as the IP address is assigned

> If IPv6 SLAAC is not active, enter the IPv6 address, IPv6
subnet prefix length and IPv6 standard gateway

» Confirm the entries with RET

» Enter the Preferred DNS server and, if required, the
Alternative DNS server

» Confirm the entries with RET
> The configuration of the network connection is applied

33

vV vVvyvVvyy

Further information: "Network", page 333
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Configuring the network drive
For the network drive details, such as IP address or host name of the server,
shared folders, etc., contact your network administrator.

33

>

vV vVvyVvyy

v

>
>

Tap Settings in the main menu

Tap Interfaces

Tap Network drive

Enter the network drive details
Confirm the entries with RET

Use the ON/OFF sliding switch to activate or deactivate Show
password

If required, select Network drive options
Tap Mount
The connection to the network drive is established

Further information: "Network drive", page 334

Setting up a printer
Requirement: A printer is connected.

Further information: "Connecting printers", page 48

Adding a USB printer

S

>

vvVvVvyy

Tap Settings in the main menu

Tap General

Tap Printers

If no default printer has been set up yet, a message appears
Tap "Close" in the message
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» Open in the sequence

=  Add printer

= USB printer

Connected USB printers are detected automatically
Tap Located printers

The list of detected printers is displayed

If only one printer is connected, the printer is selected
automatically

Select a printer
Tap Located printers once again
Enter a name for the printer into the Name input field

The name of the printer must not contain slashes ('/"),
number signs ("#") or spaces

Confirm entry with RET

> Enter an optional description for the printer into the
Description input field, e.g. "Color printer"

» Confirm entry with RET

» Enter an optional location into the Location input field, e.g.
"Office"

» Confirm entry with RET

» Enter the connection parameters into the Connection input
field, if they have not been entered automatically

Confirm entry with RET
> Tap Select the driver

vV V vV

v v vy

v

0 The printer can only be activated with the
assigned driver.

> Select the appropriate driver for the printer

> |f the appropriate driver is not listed, it needs to be copied to
the product

o The printer manufacturer usually provides the
appropriate driver.
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» To copy a custom driver to the product, tap Select PPD file
Tap Select file

» To navigate to the desired PPD file, tap the location where
the file is stored

Navigate to the folder containing the PPD file
Select PPD file

Tap OK

The PPD file is copied to the product

v

vV v v Vv

o You can only use drivers that are supported by
Linux. Drivers for other operating systems are
not recognized.

Tap Continue

The driver is activated

Tap Close in the message

Tap Set standard values

Tap Resolution to set the printer resolution
Select the desired resolution

Tap Resolution once again

Tap Paper size to set the paper size

Select the desired paper size

The resolution and the paper size are saved as defaults
The printer is added and can be used

V V V¥V VvV VvV VvV VvV VvVVY

Further information: "Printers”, page 315
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Adding a network printer

> Tap Settings in the main menu
@ » Tap General
> Tap Printers

v

Open in the sequence

=  Add printer

= Network printer

Printers available on the network are detected automatically
Tap Located printers

The list of detected printers is displayed

If only one printer is connected, the printer is selected
automatically

Select a printer
Tap Located printers once again
Enter a name for the printer into the Name input field

The name of the printer must not contain slashes ('/"),
number signs ("#") or spaces

Confirm entry with RET

» Enter an optional description for the printer into the
Description input field, e.g. "Color printer"

» Confirm entry with RET

» Enter an optional location into the Location input field, e.g.
"Office"

» Confirm entry with RET

» Enter the connection parameters into the Connection input
field, if they have not been entered automatically

» Confirm entry with RET
> Tap Select the driver

vV V vV

v v v Yy

v

o The printer can only be activated with the
assigned driver.
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A A 4

v v vy

VV VvV vV vV vV vV VvV VvVvVY

Select the appropriate driver for the printer

If the appropriate driver is not listed, it needs to be copied to

the product

o The printer manufacturer usually provides the
appropriate driver.

To copy a custom driver to the product, tap Select PPD file

Tap Select file

To navigate to the desired PPD file, tap the location where

the file is stored

Navigate to the folder containing the PPD file
Select PPD file

Tap OK

The PPD file is copied to the product

o You can only use drivers that are supported by
Linux. Drivers for other operating systems are
not recognized.

Tap Continue

The driver is activated

Tap Close in the message

Tap Set standard values

Tap Resolution to set the printer resolution
Select the desired resolution

Tap Resolution once again

Tap Paper size to set the paper size

Select the desired paper size

The resolution and the paper size are saved as defaults
The printer is added and can be used

Further information: "Printers’, page 315
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Setting the resolution and paper size

S

>

v

vV VvV VvV VvV VvV VVYy

Tap Settings in the main menu

Tap General

Tap Printers

If multiple default printers have been set up for the product,
select the desired printer in the Default printer drop-down
list

Tap Properties

Tap Resolution to set the printer resolution

The resolutions provided by the driver are displayed

Select the resolution

Tap Resolution once again

Tap Paper size to set the paper size

The paper sizes provided by the driver are displayed

Select the paper size

The resolution and the paper size are saved as defaults

Further information: "Printers’, page 315

Removing a printer
You can remove printers you no longer need. Once removed, they are no longer
available for printing measurement reports or PDF files.

@

>

v

Tap Settings in the main menu

Tap General

Open in the sequence
® Printers

® Remove printer

In the Printers drop-down list, select the printer you no
longer need

The model, location and connection of the printer are
displayed

» Tap Remove

Confirm with OK

The printer is removed from the list and can no longer be
used

Setup | Setup steps
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8.3.2 Configuring sensors

Sec. 8.3.1:

Basic settings

Sec. 8.3.2: Sec. 8.3.3:
> Configuring sensors > Setting the measuring
application

If the QUADRA-CHEK 3000 VED software option is active, the sensors must be
configured. This section describes the configuration procedure.

Adjusting the contrast settings

The currently selected contrast threshold of the product may need to be adjusted
to varying brightness conditions of the surroundings, e.g. changes in daylight. The
contrast threshold defines the contrast value starting from which the product will

recognize a light-to-dark transition as a transition.

A change in brightness could result in light-to-dark transitions—and therefore
edges—being detected earlier or later, thus falsifying the measurements.

@

EE E D

>

Tap Settings in the main menu

Tap Sensors

Open in the sequence

B Video edge detection (VED)

= Contrast settings

Select the Edge algorithm for the edge detection

Tap Start

The teach sequence is started and the Measure menu is
displayed

Follow the instructions of the wizard

Select the lighting palette

Adjust the sliders to achieve the highest possible contrast at
the edge

Tap Confirm in the wizard to confirm the positioning of the
measuring tool and the lighting settings

The teach sequence is complete
Tap Undo to repeat the teach sequence

Tap Close to close the wizard

Further information: "Contrast settings', page 328
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Determining the pixel sizes

When measuring with a VED sensor, the measurement is performed in the live
image on the product. To ensure that the size of the live image matches that of the
measured object, the pixel size must be determined for each magnification.

> Tap Settings in the main menu
@ » Tap Sensors
» Open in the sequence

B Video edge detection (VED)
B Pixel sizes

» Tap Magnification

> Select the desired magnification

» In Calibration standard diameter, enter the diameter of
the desired circle, which is specified in the calibration chart
supplied with the calibration standard

» Confirm entry with RET
> Tap Start

> The teach sequence is started and the wizard is displayed in
the Measure menu

Follow the instructions of the wizard

» Tap Confirm to confirm that you have completed the wizard's
instructions

> The teach sequence is complete
Tap Undo to repeat the teach sequence

» Tap Close to close the wizard

EE B
v

v

Repeat the procedure to determine the pixel sizes for all
available magnifications

Further information: "Pixel sizes", page 329
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8.3.3  Setting the measuring application

Sec. 8.3.1: Sec. 8.3.2: Sec. 8.3.3:
Basic settings > Configuring sensors > Setting the measuring
application

Configuring the measuring point acquisition

To measure the features, you can e.g. adjust the required minimum number of
measuring points or the settings for the measuring point filter.

Adjusting the General settings

> Tap Settings in the main menu

» Tap Features
> Tap General settings
» To set the measuring point acquisition to a fixed or free

number of measuring points, select the desired option in the
Number of measuring points drop-down list:

B Fixed: Measuring point acquisition is concluded auto-
matically as soon as the specified minimum number of
measuring points for the geometry is reached

B Free: The user can capture as many additional measuring
points as desired after reaching the required minimum
number of measuring points. When the minimum
number of points for the geometry has been reached, the
measuring point acquisition can be concluded manually

» To display the distances between the measuring points as
absolute or direction-dependent values, select the desired
option in the Distances drop-down list:

® Signed: The distance between the measuring points is
displayed depending on the measuring direction

®  Absolute: The distance between the measuring points is
displayed independently of the measuring direction

Cp-

Further information: "General settings", page 330
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Measuring point filter
During a measurement, you can filter out measuring points that are outside the
defined criteria.

» Tap Settings in the main menu

» Tap Features
Tap Measuring point filter

» To activate or deactivate the filter during measuring point
acquisition, drag the ON/OFF sliding switch to the desired
setting

» In the Error limit input field, specify the tolerance of the
measuring point filter

» In the Confidence interval (+xo) input field, specify the
number of measuring points allowed outside the error limit

» |n the Minimum % proportion of retained points input field,
specify the minimum percentage of measuring points that
must be used for the measurement

e

Further information: "Measuring point filter", page 330
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Measure Magic

» Tap Settings in the main menu

» Tap Features
> Tap Measure Magic

To define the maximum ratio of form error to main
dimension, enter the desired value into the Maximum form
error ratio input field

> The maximum form error ratio is calculated from the form
error divided by the feature size. It specifies the value below
which a feature is correctly recognized

» To define the minimum angle for the detection of a circular
arc, enter the desired value into the Minimum angle for an
arc input field

» To define the maximum angle for the detection of a circle
segment, enter the desired value into the Maximum angle
for an arc input field

» To define the minimum length for the detection of a line,
enter the desired value into the Minimum line length input
field

» To define the ratio of linear eccentricity to the semimajor
axis of an ellipse, enter the desired value into the Minimum
numeric ellipse eccentricity input field

> The numerical eccentricity describes the deviation of an
ellipse from the circular shape; the greater the value, the
greater the deviation

> A value of 0 represents a circle; a value of 1 results in an
ellipse flattened into a line

Cp-

Further information: "Measure Magic', page 331

Features

» Tap Settings in the main menu

» Tap Features

Tap the desired feature, e.g. Circle

» To reduce or increase the minimum number of measuring
points required, tap - or +

o It is not possible to use fewer than the mathematically required
minimum number of points for the geometries.

Further information: "Geometries', page 332
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Creating a template for measurement reports

In the Measurement report main menu, you can create detailed reports for
your measuring tasks. You can document one or more measured features in a
measurement report. The measurement reports can be printed, exported and
saved.

Using the integrated editor, you can create custom report templates and adapt
them as needed.

Creating a template with the editor

Timestamp [V

Job 2

N

User name  [v|

LOGO,

ENTERPRISE

Part number [V

Fixed text [

51DD03 VY

Variable text
Default settings .

Page header

Report header Omitted
features

= Failed

tolerances

Product
designation .

The different sections of the template can be edited in the editor menu.

The form fields for the template are adjustable.

The list shows the form fields that can be inserted into the selected section of
the template.

WIN =

A description of how to create the templates is provided in the Measurement
Report chapter.

Further information: "Measurement report’, page 283

Setup | Setup steps
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Creating a measuring program

The product can record and save the steps of a measuring process, and run
them sequentially as a batch process. This batch processing is referred to as the
"measuring program’.

In a measuring program, you can thus combine multiple work steps, such as
measuring point acquisition and tolerancing, into a single process. This simplifies
and standardizes the measuring process.

You can create measuring programs for the measurements with the measuring
machine and store them on the product.

1

vZ1i
o Program manual

45.0510
22.8034
0.0000

Initialization

Auto enter

Dispay

Feature list Program step list
Calculate Alignmen

Program

Start VED probe

%
Features
E ‘ Delete selection j\ Delete all ‘ © Enter

3

1 Control with operating elements
2 Program step list
3 Miscellaneous functions

A description of how to create the measuring programs is provided in the
Programming chapter.

Further information: "Programming", page 271
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9.2
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Overview

The Quick Start chapter describes the steps of a general measuring sequence
on the product. The steps range e.g. from aligning the measured object and

measuring the features through to creating the measurement report. For a detailed
description of the individual activities, please refer to the Measurement chapter

and subsequent chapters.

Quick Start | Overview

Depending on the configuration of the product and the enabled software options,
you can capture measuring points without or with a sensor. The product identifies
the captured measuring points as features and displays them.

Requirement: Commissioning and setup have been completed.

Conducting a measurement

This section describes the typical steps for conducting a measurement. The

description provides an overview and, thus, additional steps may be necessary
depending on the measuring machine or the respective measuring application.

Sec. 9.2.1:

Preparing a measure-
ment

Sec. 9.2.2:

Measuring without a
sensor

Sec. 9.2.3:

Measuring with a VED
sensor

Sec. 9.2.4:

Evaluating and docu-
menting the measure-
ment

® Preparing the
measured object
and measuring
machine

® Conducting the
reference mark
search

= Adjusting the
sensors

® Aligning the
measured object

B Measuring the
features

® Aligning the
measured object

B Measuring the
features

® Displaying and
editing the
measurement
results

= Qutputting
measurement
reports

m  Using measuring
programs
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Quick Start | Conducting a measurement

9.2.1

Preparing a measurement

Sec. 9.2.1: Sec. 9.2.2: Sec. 9.2.3: Sec. 9.2.4:

Preparing a mea- |»| Measuring without [ » [ Measuring witha | »| Evaluating and

surement a sensor VED sensor documenting the
measurement

Cleaning the measured object and the measuring machine

Contamination, e.g. from chips, dust and oil residues, leads to incorrect
measurement results. The measured object, the holder for the measured object,
and the sensor must be clean before you start measuring.

» Clean the measured object, the holder for the measured object, and the
sensors with appropriate cleaning products

Stabilizing the temperature of the measured object

The objects to be measured should be stored at the measuring machine for

an appropriate amount of time to allow the objects to adjust to the ambient
temperature. Since the dimensions of the measured objects vary with temperature
changes, the temperature of the measured objects must be stabilized.

This ensures the reproducibility of the measurement. The reference temperature is
usually 20 °C.

> Stabilize the temperature of the measured objects for an appropriate amount
time
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Reducing environmental influences

Environmental influences, such as incident light, ground vibration or air humidity,
can affect the measuring machine, the sensors or the measured objects, and thus
falsify the measurement results. Certain influences, such as incident light, also
have a negative effect on the measurement uncertainty.

» Eliminate or avoid environmental influences as far as possible

Fixing the measured object in place
The measured object must be fixed in place on the measuring plate or in an
appropriate holder, depending on its size.

> Position the measured object in the center of the measuring range
> Use e.g. modeling clay to fix small measured objects in position

> Use fixtures to fix large measured objects in position
>

Make sure that the measured object is fastened neither too loosely nor too
tightly

9.2.2 Measuring without a sensor

Sec. 9.2.1: Sec. 9.2.2: Sec. 9.2.3: Sec. 9.2.4:

Preparing a mea- » | Measuring with- | »| Measuring with a | »| Evaluating and

surement out a sensor VED sensor documenting the
measurement

On products without optical sensors, only geometries and no measuring tools are
available. For alignment and measuring point acquisition, you can use an external
screen with crosshairs, for example. The workspace of the user interface displays
the position of the measuring plate.

o The measurements illustrated here are described in detail in the
Measurement chapter.

Further information: "Measure menu without software option", page 64
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Aligning the measured object

Before you can evaluate the measuring points, you need to align the measured
object. During this process, the coordinate system of the measured object
(workpiece coordinate system) is determined, which is specified in the technical
drawing.

This makes it possible to compare the measured values with the data in the
technical drawing and assess them.

&
HEIDENHAIN L

11T e
\

Measured objects are usually aligned in three steps:
1 Measuring the alignment

2 Measuring a straight line

3 Constructing the zero point
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Quick Start | Conducting a measurement

Measuring the alignment
Define the reference edge for the alignment according to the technical drawing.

» Tap Measure in the main menu
p

Select Manual measuring in the function palette

The workspace with the axis positions is displayed.

Select Alignment in the geometry palette

Position the first measuring point on the reference edge

Tap Enter in the Inspector

A new feature is displayed in the feature list of the Inspector

VvV v vV vV VY

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

» Position the second measuring point on the reference edge
> Tap Enter in the Inspector

o Depending on the configuration of the measuring
point acquisition, you can also capture additional
measuring points for the alignment. In this way
you increase the accuracy of the alignment.

» Tap Finish in the new feature
> The alignment is displayed in the feature list of the Inspector
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Measuring a straight line
For the second reference edge, you can measure a straight line, for example.
Select Line in the geometry palette

Position the first measuring point on the reference edge
Tap Enter in the Inspector

A new feature is displayed in the feature list of the Inspector

v v.v Y

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

» Position the second measuring point on the reference edge
» Tap Enter in the Inspector

0 Depending on the configuration of the measuring
point acquisition, you can also capture additional
measuring points for the line. In this way you
increase the accuracy.

> Tap Finish in the new feature
> The line is displayed in the feature list of the Inspector

mm

manual

Alignment 1
PN

Line 1

PN

)
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Quick Start | Conducting a measurement

Constructing the zero point
The zero point is constructed of the point of intersection between the alignment
and the straight line.

>

A\ >

>

: >

>

. >
v

>

Select Construct in the function palette
A new feature is displayed in the feature list of the Inspector

Select Zero point in the geometry palette

Select the Alignment and Line features in the Inspector or in
the features view

The selected features are displayed in green

Tap Finish in the new feature
The zero point is created

The workpiece coordinate system for the measured object
has been determined

Select Manual measuring in the function palette
Tap Features preview
The coordinate system is shown in the workspace

14.6819
25.6079

Alignment 1
A

Line 1

VAN

t  Zeropoint2
—— A
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Quick Start | Conducting a measurement

Measuring the features

To measure features, you can use the geometries of the geometry palette or
Measure Magic. Measure Magic is able to automatically recognize the geometry
to be measured.

Further information: "Overview of geometry types', page 191

HEIDENHAIN

T
A

This section provides examples describing how to measure three different
features:

1 Circle
2 Slot
3 Blob
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Measuring a circle

Quick Start | Conducting a measurement

A minimum of three measuring points is required to measure a circle.

>

VvV VvV VvVyVy

Tap Measure in the main menu

Select Manual measuring in the function palette

The workspace with the axis positions is displayed

Select Circle in the geometry palette

Position the first measuring point on the circular contour
Tap Enter in the Inspector

A new feature is displayed in the feature list

Position the second measuring point on the circular contour

o Distribute the measuring points as evenly as
possible along the contour of the feature.

Tap Enter in the Inspector
Repeat the last two steps for the third measuring point

Tap Finish in the new feature

The product calculates a new feature from the captured
measuring points and the selected geometry

The measured circle is displayed in the features preview
The measurement is complete

Alignment 1
A

Line 1

A

t  Zeropoint2
=
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Quick Start | Conducting a measurement

Measuring a slot

A minimum of five measuring points is required to measure a slot. Place at least
two measuring points on the first long side, one measuring point on the second
long side, and one measuring point on each arc of the slot. You can capture the
points in any sequence.

Select Slot in the geometry palette

Position the first measuring point on the contour of the slot
Tap Enter in the Inspector

A new feature is displayed in the feature list of the Inspector

vV vV Vvyvyy

Position the second measuring point on the contour of the
slot

0 Distribute the measuring points along the entire
length of the first side, as far as possible.

» Tap Enter in the Inspector

Repeat the last two steps for each of the remaining contour
points

» Tap Finish in the new feature

> The product calculates a new feature from the captured
measuring points and the selected geometry

> The measured slot is displayed in the features preview
> The measurement is complete
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Measuring a blob

A minimum of three measuring points is required to measure a blob. Capture a
sufficient number of measuring points to enable the product to determine the
contour and calculate the center of mass.

Select Blob in the geometry palette

Position the first measuring point on the contour

Tap Enter in the Inspector

A new feature is displayed in the feature list of the Inspector
Position the second measuring point on the contour

vV vV Vvyvyy

0 Distribute the measuring points as evenly as
possible along the contour of the feature.

» Tap Enter in the Inspector

> Repeat the last two steps for each of the remaining contour
points

» Tap Finish in the new feature

> The product calculates a new feature from the captured
measuring points and the selected geometry

> The measured blob is displayed in the features preview
> The measurement is complete
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Quick Start | Conducting a measurement

9.23 Measuring with a VED sensor

Sec.9.2.1: Sec.9.2.2: Sec. 9.2.3: Sec. 9.2.4:

Preparing a mea- » | Measuring without | »| Measuring with a | »| Evaluating and

surement a sensor VED sensor documenting the
measurement

For measuring edges and contours with the QUADRA-CHEK 3000 VED software
option, various measuring tools are available for the acquisition of measuring
points in the live image.

Further information: "Measuring tools", page 84

0 The measurements illustrated here are described in detail in the
Measurement chapter.

0 For the measurements described in this section, a virtual camera
(Virtual Camera (GigE)) will be used with the representation of the
supplied 2-D demo part.

Application-specific adaptations during commissioning or setup can lead
to differing representations.

OEM or Setup users can switch to the virtual camera at any time in
order to try out the examples shown.

Further information: "Measure menu with QUADRA-CHEK 3000 VED software
option", page 65
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Aligning the measured object

Sec. : Sec. :

Aligning the measured object Measuring the features

Before you can evaluate the measuring points, you need to align the measured
object. During this process, the coordinate system of the measured object
(workpiece coordinate system) is determined, which is specified in the technical
drawing.

This makes it possible to compare the measured values with the data in the
technical drawing and assess them.

&
HEIDENHAIN &

11T e
\

Measured objects are usually aligned in three steps:
1 Measuring the alignment

2 Measuring a straight line

3 Constructing the zero point

Measuring the alignment
Define the reference edge for the alignment according to the technical drawing.

» Tap Measure in the main menu
"

» Select Manual measuring in the function palette

» If more than one optical sensor is active, select VED sensor
in the sensor palette

> The geometry palette and the VED measuring tools are
displayed
> The workspace shows the camera's live image

» In the quick access menu, select the magnification that is set
on the measuring machine

> Select Alignment in the geometry palette
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Bl

!

Select Buffer in the tool palette
Position the measuring tool above the reference edge

Expand the measuring tool so that the edge area enclosed in
the search range is as large as possible

Rotate the measuring tool so that the scan direction
corresponds to the desired scan direction

Select the edge detection mode at the bottom of the
workspace

Tap Enter in the Inspector
Multiple measuring points are captured along the edge
A new feature is displayed in the feature list of the Inspector

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

If the edge is interrupted or not fully displayed in the
workspace, reposition the measuring tool and capture more
measuring points

Tap Finish in the new feature
The alignment is displayed in the feature list of the Inspector

mm vZ1

manual | 500 ms

24.0352
8.6359

HEIDENHAIN 1.5964

Alignment 2
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Quick Start | Conducting a measurement

Measuring a straight line
For the second reference edge, you can measure a straight line with the Buffer
measuring tool, for example.

>

v

Select Line in the geometry palette

Select Buffer in the tool palette
Position the measuring tool above the reference edge

Expand the measuring tool so that the edge area enclosed in
the search range is as large as possible

Rotate the measuring tool so that the scan direction
corresponds to the desired scan direction

Select the edge detection mode at the bottom of the
workspace

Tap Enter in the Inspector
Multiple measuring points are captured along the edge
A new feature is displayed in the feature list of the Inspector

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

If the edge is interrupted or not fully displayed in the
workspace, reposition the measuring tool and capture more
measuring points

Tap Finish in the new feature
The line is displayed in the feature list of the Inspector
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Quick Start | Conducting a measurement

Constructing the zero point
The zero point is constructed of the point of intersection between the alignment
and the straight line.

A\
\

>
>

Select Construct in the function palette
A new feature is displayed in the feature list of the Inspector

Select Zero point in the geometry palette

Select the Alignment and Line features in the Inspector or in
the features view

The selected features are displayed in green

Tap Finish in the new feature

The zero point is created

The workpiece coordinate system for the measured object
has been determined

Select Manual measuring in the function palette

Tap Features preview

The coordinate system is shown in the workspace
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Measuring the features

To measure features, you can use the geometries of the geometry palette or
Measure Magic. Measure Magic is able to automatically recognize the geometry
to be measured.

Further information: "Overview of geometry types', page 191

HEIDENHAIN

T
A

This section provides examples describing how to measure three different
features:

1 Circle
2 Slot
3 Blob

Measuring a circle

A minimum of three measuring points is required to measure a circle. To capture
the measuring points, you can use e.g. the Circle measuring tool. Multiple
measuring points are automatically distributed along the entire contour according
to the specified settings.

» Tap Measure in the main menu
"

> Select Manual measuring in the function palette

» |If more than one optical sensor is active, select VED sensor
in the sensor palette

> The geometry palette and the VED measuring tools are
displayed

» Tap Live image preview in the Inspector

> The workspace shows the camera's live image

» In the quick access menu, select the magnification that is set
on the measuring machine

» Select Circle in the geometry palette

» Position the measured object in the live image by moving the
measuring plate
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Quick Start | Conducting a measurement

> Select Circle in the tool palette

» Position the measuring tool above the contour

> Resize the two rings of the measuring tool so that the
contour is fully enclosed within the search range between
the inner and outer rings

B R R e Select the edge detection mode at the bottom of the
workspace

» Tap Enter in the Inspector
> The measuring points are captured along the contour
> A new feature is displayed in the feature list

» Tap Finish in the new feature

> The product calculates a new feature from the captured
measuring points and the selected geometry

> The measured circle is displayed in the features preview

> The measurement is complete
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manual | 500 ms

45.0480
22.8025
1.5084

‘ @)

Alignment 2
PN

Line 3

PN

t  Zero point 1
— A

Circle 1
PN

)

Measuring a slot

A minimum of five measuring points is required to measure a slot. To capture

the measuring points, you can use e.g. the Single edge measuring tool. Place at
least two measuring points on the first long side and one measuring point on the
second long side, and at least one measuring point on each arc of the slot. You can
capture the points in any sequence.

. > Select Slot in the geometry palette
> Select Single edge in the tool palette
sV » Position the search range of the measuring tool on the

contour of the slot
» Resize the search range
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Quick Start | Conducting a measurement

Select the edge detection mode at the bottom of the
workspace

Tap Enter in the Inspector
A new feature is displayed in the feature list

Position the measuring tool on the contour of the slot to
capture the second measuring point

o Distribute the measuring points along the entire
length of the first side, as far as possible.

Tap Enter

Repeat the last two steps for the remaining three contour
points

Tap Finish in the new feature

The product calculates a new feature from the captured
measuring points and the selected geometry

The measured slot is displayed in the features preview
The measurement is complete
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Quick Start | Conducting a measurement

Measuring a blob

A minimum of three measuring points is required to measure a blob. To capture
the measuring points, you can use e.g. the Contour measuring tool. Multiple
measuring points are automatically distributed along the entire contour according
to the specified settings.

E ]
'
. 4 »

R D= e

Select Blob in the geometry palette

Select Contour in the tool palette

Position the measuring tool at any desired location above the
contour

Resize the search range to enclose only one edge

o Make sure that there are no other edges
or contours within the search range of the
measuring tool.

Select the edge detection mode at the bottom of the
workspace

Tap Enter in the Inspector

The measuring points are captured along the edge until the
start point is reached again

A new feature is displayed in the feature list

Tap Finish in the new feature

The product calculates a new feature from the captured
measuring points and the selected geometry

The measured blob is displayed in the features preview
The measurement is complete
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9.24  Evaluating and documenting the measurement

Sec.9.2.1: Sec.9.2.2: Sec. 9.2.3: Sec. 9.2.4:

Preparing a mea- » | Measuring without | »| Measuring with a | »| Evaluating and

surement a sensor VED sensor documenting the
measurement

Displaying and editing the measurement results

You can edit the measured features immediately after capturing the measuring
points.

Further information: "Measurement evaluation’, page 245

Activation
> Tap Measure in the main menu
> The user interface for measuring, constructing and defining
appears

» Drag the feature from the feature list into the workspace
> The Details dialog appears with the Overview tab selected

Short description

mm vzi
Qverview Tolerances manual 500 ms
45.0507
22.8034
Circle 2 0.0000
P C
X | 773666 Zero Y
L=
Y | 309782 Zero
Alignment 1
a
0.0000 Zero
Line 1
N
Diameter EC R | | Zeropoint !
Form deviation 0.0204
A
Number of points 26 of 31
Blob 1
A
Fitting algorithm Gaussian S
New type of geometry Point =

© Enter

Name of the feature

Axis positions of the center point

Feature properties and parameters

Features view of the measuring points and the form

AP WON=
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Quick Start | Conducting a measurement

The Overview shows the following details about the feature:
® Name of the feature

Axis positions of the center point

Feature parameters, depending on the type of geometry

Number of measuring points used for calculating the feature

Fitting algorithm used for calculating the feature (depending on the geometry

and the number of measuring points)
® List of geometry types to which the feature can be converted

Renaming a feature

VvV Vv Vv VvV yVy

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
Tap the input field containing the current name

Enter a name for the feature

Confirm entry with RET

The new name is displayed in the feature list

Tap Close to close the dialog

Adjusting the fitting algorithm
You can adjust the fitting algorithm depending on the measured feature. The
geometry is basically calculated using the Gaussian fitting algorithm.

Further information: "Fitting algorithm", page 248

V.V VYy

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
The fitting algorithm used is displayed

Select the desired fitting algorithm in the Fitting algorithm
drop-down list

The feature is displayed according to the selected fitting
algorithm

Further information: "Display of measuring points and form",

page 247
Tap Close to close the dialog
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Converting a feature
The feature can be converted to a different type of geometry. The list of possible
geometry types is provided as a drop-down list in the features view.

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
The geometry type of the feature is displayed

Select the desired geometry type in the New type of
geometry drop-down list

> The feature is displayed in the new form
Further information: "Display of measuring points and form",
page 247

. » Tap Close to close the dialog

vV yVyYy

Adjusting tolerances
To set tolerances for the measured geometry, enter the tolerance values on the
Tolerances tab.

Further information: "Defining tolerances’, page 252

Activation
. » Tap Measure in the main menu
= > The user interface for measuring, constructing and defining
appears
» Drag the feature from the feature list into the workspace
> The Details dialog appears with the Overview tab selected
» Tap the Tolerances tab
> The tab for tolerancing the selected feature is displayed
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Short description

1

General tolerances

Overview /45

150 2768

Size tolerance

Form tolerances

Location tolerances

Runout tolerances

Q Circle 3
O Circle 3
O roundness
@ Position

Concentricity

=

El
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the tolerance

On the Tolerances tab, you can define the geometrical tolerancing of a measured
or constructed feature. The tolerances are grouped.

Display of general tolerance
List of tolerances, depending on feature
3 Status of the tolerance: active and within the tolerance or active and outside

o Tolerances cannot be applied to reference features, such as zero point,
alignment and reference plane.

Depending on the feature, you can define the following tolerance types:

Runout tolerances

The tolerances can be activated or deactivated.
Further information: "Tolerancing the features", page 258
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General tolerances, e.g. application of the ISO 2768 standard

Size tolerances, e.g. diameter, width, length and angle of reference axis
Form tolerances, e.g. roundness

Location tolerances, e.g. position, concentricity

Directional tolerances, e.g. angularity, parallelism, perpendicularity
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Outputting measurement reports

You can output the measurement as a measurement report. In this way, you can
save and print the measurement results.

Further information: "Measurement report’, page 283

You can create a measurement report in five steps:

> Selecting a template

Selecting features

Entering information on the measuring task
Selecting document settings

Saving, printing or exporting the measurement report

v vy

Requirement
® The measurement and the measurement evaluation are complete

Activation

v

Tap Measurement report in the main menu

A\

The user interface for editing the measurement reports
appears

Select a template, e.g. Standard
The preview of the selected template is displayed
Tap Create to create the measurement report

The Features menu appears with a list of all features that
have been measured, constructed and defined

vV v VvV

v

Tap a feature to add it to the measurement report

> Selected features are displayed in green in the list and in the
features preview

» To add all features to the measurement report, tap Select all
in the Select drop-down list

> All features in the list and in the features preview are
activated and displayed in green
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v

vV v Vv VvYVwvyysy

Alignment 1

Line 1

Zero point 1

Circle 1

Slot 1

Blob 2

Features

Information

Document

Preview

Tap the Information menu

To adjust the date and time in the measurement report, select the Set
automatically or Set manually function in the Timestamp drop-down list

= Set manually: When creating the report, the manually set date and time are
entered

® Set automatically: \When creating the report, the current system date and
time are entered

Select an existing user in the User name drop-down list

If you want another user to be displayed in the measurement report, select
Other user

Enter the name of the user into the input field

Confirm entry with RET

Enter the number of the measurement job into the Job input field

Confirm entry with RET

Enter the part number of the measured object into the Part number input field
Confirm entry with RET
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Entering information about the document

» Tap the Document menu

» To adjust the unit for linear measurement values, select the desired unit in the
Unit for linear values drop-down list

B Millimeters: Display in millimeters
B Inch: Display in inches

» To reduce or increase the number of displayed Decimal places for linear
values, tap - or +

» To adjust the unit for angular values, select the desired unit in the Unit for
angular values drop-down list

® Decimal degrees: Display in degrees
® Radian: Display as radian measure

» To adjust the format for the date and time, select the desired format in the Date
and time format drop-down list

®  hh:mm DD-MM-YYYY: Time and date
® hh:mm YYYY-MM-DD: Time and date
® YYYY-MM-DD hh:mm: Date and time
» Tap the Preview menu
The preview of the measurement report is displayed

ENTERPRISE

Operator

681047-02

2016/04/01 16:17

2-D demo part

Type Posttion Cartesian Orientation Point count

Zero point | 0 faise false
o
]

Features

Information

Document

Preview

Save as
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Saving the measurement report
Measurement reports are saved in the XMR data format. Files saved in XMR data
format can be displayed and newly created at a later point in time.

» Tap Save as

Select the storage location in the dialog, e.g. Internal/Reports
Enter a name for the measurement report

Confirm entry with RET

Tap OK

The measurement report is saved

vV v.v.v Yy

Printing the measurement report
> Tap Print

> The measurement report is output to the specified printer
Further information: "Setting up a printer", page 143

Exporting the measurement report
Measurement reports can be exported as PDF or CSV files. Exported
measurement reports cannot be newly created.

> Select the desired export format in the Export drop-down list

® Export as PDF: The measurement report is saved as a printable PDFE The
values are no longer editable

B Export as CSV: The values in the measurement report are separated by
semicolons. The values can be edited using spreadsheet software

Select the storage location in the dialog, e.g. Internal/Reports
Enter a name for the measurement report

Confirm entry with RET

Tap OK

The measurement report is exported in the selected format and stored in the
storage location

vV v v v Vv

Canceling the measurement report or closing it after saving

. > Tap Close
» Close the message with OK

» The measurement report is closed

0 In the File management main menu, you can open and edit saved
reports.

Further information: "Managing folders and files", page 305
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Creating and using measuring programs

The product can record and save the steps of a measuring process, and run
them sequentially as a batch process. This batch processing is referred to as the
"measuring program’.

In a measuring program, you can thus combine multiple work steps, such as
measuring point acquisition and tolerancing, into a single process. This simplifies
and standardizes the measuring process.

Measuring programs can include the following work steps:
Alignment of the measured object

Measuring point acquisition

Construction and definition

Measurement evaluation

Tolerancing

The work steps of a measuring program are referred to as program steps. The
program steps are displayed in the program step list in the Inspector.

o Regardless of whether the feature list or the program step list is
the current view in the Inspector, the product always records every
measuring process or work step as a program step. The operator can
switch the view between the feature list and the program step list at
any time.

Further information: "Programming", page 271

Saving a measuring program
To be able to run a measuring process repeatedly, you need to save the executed
work steps as a measuring program.

» Tap Measure in the main menu
;

> Select Manual measuring in the function palette

. » Tap Miscellaneous functions in the Inspector
In the Miscellaneous functions dialog, tap Save as

v

Select the storage location in the dialog, e.g.
Internal/Programs

Enter a name for the measuring program
Confirm entry with RET

Tap OK

The measuring program is saved

The name of the measuring program is displayed on the
program control

VV Vv vVvy
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Starting a measuring program

The measuring program that is currently being recorded or executed can

be started directly with the program control. Program steps requiring user
intervention are supported by a wizard. User intervention may be required under
the following conditions, for example:

B The measuring points are outside the live image (only if the QUADRA-CHEK
3000 VED software option and the VED sensor are both active)

= The settings of the camera optics must be adjusted, e.g. magnification of the
camera

B The measured object must be positioned manually using the axes of the
measuring plate

o The user interface is locked while a program is running. Only the
operating elements of the program control and Enter can be used.

u » Tap Run on the program control
The program steps are executed

A\

> Program steps that are currently being executed or require
user intervention are highlighted

> When user intervention is required, the measuring program
stops

» Perform the required user intervention

> The execution of the program steps is resumed until the next

user intervention is required or the end of the program is
reached

> The successful completion of the measuring program is
displayed

‘ 5 ‘ > Tap Close in the message

> The features are displayed in the features preview

Further information: "Starting a measuring program", page 276

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016

187









Measurement | Overview

10.1 Overview

This chapter describes the following functions:
. QOverview of geometry types

Capturing measuring points

Conducting a measurement

Constructing features

Defining features

o Make sure that you have read and understood the "Basic Operation’
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

Requirement: Commissioning and setup have been completed.

Short description

In the Measure menu you measure, construct or define all the features needed
for the acquisition of a measured object. This section discusses the different
possibilities of measuring point acquisition and describes the basic steps for
conducting a measurement. Features are measured by manually capturing
measuring points and using predefined geometries.

You can optionally use optical sensors and various measuring tools to capture
measuring points.
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10.2 Overview of geometry types

The product provides predefined geometries that you can use for measuring,
constructing and defining. Which geometry you choose depends on the measuring
task.

The selected geometry specifies the type of geometry that is determined from the
captured measuring points.

o The number of measuring points to be captured can be adjusted in the
settings of the product.
It is not possible to use fewer than the mathematically required
minimum number of points for the geometries.

Further information: "Geometries", page 332

Geometry Name Properties Number of
measuring
points

" Measure Automatically recognizes the 21
e Magic geometry to be measured
. Point Sets any measuring point 21
. Height point  Sets a height point 21
<
Line Determines a line =2
/
Circle Determines a circle >3
Arc Determines a circle segment 23
The opening angle is defined
by the outermost measuring
points
Ellipse Determines an ellipse 25
e position and length of the
& Th iti dl h of th

reference axis are defined by
the measuring points that are
farthest apart

Slot Determines a slot =5

The position and length of the
reference axis are defined by
the measuring points that are
farthest apart

Rectangle Determines a rectangular 25
feature with straight sides

The position and length of the
reference axis are defined by
the measuring points that are
farthest apart
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Geometry Name Properties Number of
measuring
points

Distance Determines the distance 2
=t between two measuring
points
Angle Determines two straight lines 24
A that intersect at any angle

The angle is determined from

the point of intersection of the
two sides, and the position of

each side

The measuring points need to
be captured for the first side
and then for the second side

Blob Determines the center of >3
mass of the area formed by all

measuring points

Geometries for determining the reference system

Geometry Name Property Number of
measuring
points

Zero point Sets the zero point of the 21

reference system for a
measured object

Alignment Determines the alignment of =22
the X axis of the reference
system for a measured object

Reference Determines the inclination >3
plane of the reference plane for a
measured object

B
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10.3

10.3.1

Capturing measuring points

When you measure an object, the existing geometries are determined based on
features. To determine a feature, you need to capture measuring points for the
feature.

A measuring point is a point in the coordinate system whose position is defined
by the coordinates. Based on the positions of the captured measuring points
(point cloud) in the coordinate system, the product can determine and evaluate the
feature. The product optionally provides various ways to capture measuring points:

= \Without a sensor, e.g. by using crosshairs on the measuring microscope or
profile projector

= With a sensor, e.g. in the form of a camera on the measuring machine

Capturing measuring points without a sensor

If measuring points are captured without using a sensor, the operator on the
connected measuring machine (e.g. measuring microscope, profile projector) must
be able to move to the desired position on the measured object, e.g. by using
crosshairs. On reaching this position, the measuring point acquisition is initiated
either manually by the operator or automatically by the product, depending on the
configuration.

For the measuring point, the product captures the current axis positions that are
displayed in the workspace or position preview. The coordinates of this measuring
point thus result from the current position of the measuring plate. Based on the
captured measuring points, the product determines the feature according to the
selected geometry and displays it in the feature list in the Inspector.

The number of measuring points that need to be captured for a feature depends on
the configuration of the selected geometry.

0 The procedure for capturing measuring points without a sensor is
basically the same for all geometries and is described below using the
"Circle" geometry as an example.
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Capturing measuring points without a sensor

» Tap Measure in the main menu
:

B

Select Manual measuring in the function palette
The workspace with the axis positions is displayed
Select Circle in the geometry palette

On the measuring machine, move to the desired position on
the measured object
> |f automatic measuring point acquisition is active, the
measuring point is captured automatically
Further information: "Setting automatic measuring point
acquisition”, page 81
> |f automatic measuring point acquisition is not active, tap
Enter in the Inspector

> A new feature appears in the feature list of the Inspector. The
symbol of the feature corresponds to the selected geometry
> The number of captured measuring points is shown next to

the symbol
» Position the second measuring point on the circular contour

vV vV y

© Enter

o Distribute the measuring points as evenly as
possible along the contour of the feature.
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Tap Enter in the Inspector
© Enter

> Repeat the last two steps for the third measuring point

A\

" New As soon as a sufficient number of measuring points have

: v

et 3 been captured for the feature, a check mark appears next to
the feature in the feature list

» Tap Finish to conclude the measuring point acquisition

> The acquired feature is displayed in the feature list and the
features preview

mm

manual

Alignment 1
A

Line 1

A

1  Zeropoint2
=
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10.3.2 Capturing measuring points with a sensor

When capturing measuring points with a sensor, various sensor types are available
in the metrology sector. A distinction is made between tactile and optical sensors.
Which of two is used depends on the measuring task.

When selecting the appropriate sensor, the following criteria need to be
considered:

B Properties of the measured object (e.g. surface structure, compliance)

® Size and arrangement of the features to be measured (e.g. accessibility, form)
B Required measuring accuracy

B Economic efficiency and available measuring time

If the QUADRA-CHEK 3000 VED software option is activated on the product, the

product supports the use of a VED sensor (optical sensor). A VED sensor is a USB
camera or network camera connected to the product.

Optical sensors are particularly well suited for use in the following cases:
B Small features to be measured

® | arge number of measuring points

B Short measuring times

= Compliant objects to be measured

When capturing measuring points with a VED sensor, the live image from the
connected camera is displayed in the workspace. The measuring points are
captured in the live image by using VED measuring tools.

For this purpose, the measuring plate is traversed to position the measured object
in such a way that the live image shows the feature to be measured on the object.
The operator positions a VED measuring tool above the measured object in the live
image.
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The product provides the Crosshair VED tool as well as active VED measuring
tools such as Single edge or Circle.

When capturing measuring points with the Crosshair tool, the operator specifies
the measuring point by manually positioning the measuring tool in the live image.

Active VED measuring tools allow an objective acquisition of measuring points
because the product detects a light-to-dark transition within a defined search range
of the measuring tools by evaluating the contrast. The measuring point acquisition
is initiated by the operator or automatically by the product, depending on the
configuration.

mm vz1

manual | 500 ms

24.0352
8.6359
1.5984

)

B EN s

Circle VED measuring tool with captured measuring points

Based on the position of the VED measuring tool in the live image and the axis
positions, the product acquires the coordinates for the measuring point. The
product determines the feature from the captured measuring points according

to the selected geometry. The new feature is shown in the feature list of the
Inspector. The number of measuring points that need to be captured for a feature
depend on the configuration of the selected geometry.

Further information: "Overview of geometry types", page 191

o The procedure for capturing measuring points with a sensor is basically
the same for all geometries and is thus described below by way of an
example geometry.
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Capturing measuring points with the 'Crosshair’' VED measuring tool

> Tap Measure in the main menu

> Select Manual measuring in the function palette

Select Circle in the geometry palette

Position the measured object in the live image by moving the
measuring plate

Select Crosshair in the tool palette

E AN

Position the measuring tool in the live image by tapping or
dragging
> |f automatic measuring point acquisition is active, the
measuring point is captured automatically
Further information: "Setting automatic measuring point
acquisition", page 81
> If automatic measuring point acquisition is not active, tap
Enter in the Inspector

' > A new feature appears in the feature list of the Inspector. The
A1 symbol of the feature corresponds to the selected geometry

> The number of captured measuring points is shown next to
the symbol

» Position the second measuring point on the contour of the
slot

0 Distribute the measuring points as evenly as
possible along the contour of the feature.

» Tap Enter in the Inspector
© Enter

Repeat the last two steps for the third measuring point

A\

e New As soon as a sufficient number of measuring points have

E H v

S & been captured for the feature, a check mark appears next to
the feature in the feature list
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» Tap Finish to conclude the measuring point acquisition

> The acquired feature is displayed in the feature list and the
features preview

mm \7at
manual | 500 ms

24.0352
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Capturing measuring points with an active VED measuring tool
The active VED measuring tools vary in use and area of application. The measuring
point acquisition is the same for all active VED measuring tools.

Further information: "Measuring tools", page 84

» Tap Measure in the main menu
p

> Select Manual measuring in the function palette

» |If more than one optical sensor is active, select VED sensor
in the sensor palette

> The geometry palette and the VED measuring tools are
displayed

» Tap Live image preview in the Inspector

> The workspace shows the camera's live image

» In the quick access menu, select the magnification that is set
on the measuring machine

» Select Circle in the geometry palette

> Select the appropriate measuring tool in the tool palette, e.g.

Circle
» Position the measuring tool above the contour

Resize the two rings of the measuring tool so that the
contour is fully enclosed within the search range between
the inner and outer rings

> |f automatic measuring point acquisition is active, the
measuring points are captured automatically
Further information: "Setting automatic measuring point
acquisition", page 81

e Bl > Select the edge detection mode at the bottom of the
workspace
> A new feature is displayed in the feature list
» |f automatic measuring point acquisition is not active, tap
© Enter .
Enter in the Inspector

> The measuring points are captured along the contour

If the number of measuring points is set to "Free" in the
feature settings, a new feature with a check mark is shown in
the feature list of the Inspector

Further information: "Adjusting the General settings”,

page 151

> The number of captured measuring points is shown next to
the symbol

v
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» Tap Finish to conclude the measuring point acquisition
> The product calculates a new feature from the captured
measuring points and the selected geometry
> The acquired feature is displayed in the feature list and the
features preview
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10.4 Conducting a measurement

To measure features on an object, various steps are required, including the

following:
Sec. 10.4.1: Sec. 10.4.2: Sec. 10.4.3:
Preparing a measurement g Aligning the measured object g Measuring a feature
® Preparing the measured ® Measuring the alignment ® Selecting the geometry
object and measuring ® Measuring a straight line ®  Capturing measuring points

machme. m Constructing the zero point
B Conducting the reference

mark search

B Adjusting the sensors

o The procedure for measuring features is basically the same for all
geometries and independent of the type of measuring point acquisition.
In the measurement examples illustrated below, the QUADRA-CHEK
3000 VED software option is active.

10.4.1 Preparing a measurement

Sec. 10.4.1: Sec. 10.4.2: Sec. 10.4.3:
Preparing a measure- > Aligning the measured > Measuring a feature
ment object

Cleaning the measured object and the measuring machine

Contamination, e.g. from chips, dust and oil residues, leads to incorrect
measurement results. The measured object, the holder for the measured object,
and the sensor must be clean before you start measuring.

» Clean the measured object, the holder for the measured object, and the
sensors with appropriate cleaning products

Stabilizing the temperature of the measured object

The objects to be measured should be stored at the measuring machine for

an appropriate amount of time to allow the objects to adjust to the ambient
temperature. Since the dimensions of the measured objects vary with temperature
changes, the temperature of the measured objects must be stabilized.

This ensures the reproducibility of the measurement. The reference temperature is
usually 20 °C.

> Stabilize the temperature of the measured objects for an appropriate amount
time
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Reducing environmental influences

Environmental influences, such as incident light, ground vibration or air humidity,
can affect the measuring machine, the sensors or the measured objects, and thus
falsify the measurement results. Certain influences, such as incident light, also
have a negative effect on the measurement uncertainty.

» Eliminate or avoid environmental influences as far as possible

Fixing the measured object in place
The measured object must be fixed in place on the measuring plate or in an
appropriate holder, depending on its size.

> Position the measured object in the center of the measuring range
> Use e.g. modeling clay to fix small measured objects in position

> Use fixtures to fix large measured objects in position
>

Make sure that the measured object is fastened neither too loosely nor too
tightly

Conducting the reference mark search

The reference mark search must be performed to ensure that the relationship
between the axis positions and the measuring plate is reproducible.

If the reference mark search is active on the product, the reference marks of the
axes must be traversed after startup. All functions in the main menu will only be
available after the reference mark search has been successfully completed.

Further information: "Activating the reference mark search", page 112

Performing the reference mark search after startup
> After logging in, follow the instructions of the wizard

> On successful completion of the reference mark search, the display color of the
axis position changes from red to white

Starting the reference mark search manually
If the reference mark search was not performed on startup, it can be started
manually later.

Further information: "Starting the reference mark search’, page 112
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Adjusting the VED sensor

Selecting the sensor

> Tap Manual measuring
> If only the VED sensor is enabled, the VED sensor is

activated automatically

» |f more than one sensor is enabled, tap VED sensor in the
sensor palette

> The image section from the VED sensor is displayed in the
workspace

» Position the VED measuring tool above a high-contrast edge
of the measured object

» Focus the optics of the measuring machine until the
displayed edge is as sharp as possible

Setting the lighting

> Tap Lighting palette
» Use the sliders to adjust the lighting in the workspace so that
the contrast at the object edge is as high as possible
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Setting the contrast threshold

The currently selected contrast threshold of the product may need to be adjusted
to varying brightness conditions of the surroundings, e.g. changes in daylight. The
contrast threshold defines the contrast value starting from which the product will

recognize a light-to-dark transition as a transition.

A change in brightness could result in light-to-dark transitions—and therefore
edges—being detected earlier or later, thus falsifying the measurements.

@

EE N D

> Tap Settings in the main menu

» Tap Sensors

Open in the sequence

B Video edge detection (VED)

= Contrast settings

Select the Edge algorithm for the edge detection

Tap Start

The teach sequence is started and the Measure menu is
displayed

Follow the instructions of the wizard

Select the lighting palette

Adjust the sliders to achieve the highest possible contrast at
the edge

Tap Confirm in the wizard to confirm the positioning of the
measuring tool and the lighting settings

The teach sequence is complete
Tap Undo to repeat the teach sequence

Tap Close to close the wizard

Further information: "Contrast settings", page 328

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016

205



Measurement | Conducting a measurement

10.4.2 Aligning the measured object

Sec. 10.4.1: Sec. 10.4.2: Sec. 10.4.3:
Preparing a measurement > Aligning the measured > Measuring a feature
object

Before you can evaluate the measuring points, you need to align the measured
object. During this process, the coordinate system of the measured object
(workpiece coordinate system) is determined, which is specified in the technical
drawing.

This makes it possible to compare the measured values with the data in the
technical drawing and assess them.

&
HEIDENHAIN &

11T e
\

Measured objects are usually aligned in three steps:
1 Measuring the alignment

2 Measuring a straight line

3 Constructing the zero point

Measuring the alignment
Define the reference edge for the alignment according to the technical drawing.

» Tap Measure in the main menu
"

» Select Manual measuring in the function palette

» If more than one optical sensor is active, select VED sensor
in the sensor palette

> The geometry palette and the VED measuring tools are
displayed
> The workspace shows the camera's live image

» In the quick access menu, select the magnification that is set
on the measuring machine

> Select Alignment in the geometry palette
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Bl

!

Select Buffer in the tool palette
Position the measuring tool above the reference edge

Expand the measuring tool so that the edge area enclosed in
the search range is as large as possible

Rotate the measuring tool so that the scan direction
corresponds to the desired scan direction

Select the edge detection mode at the bottom of the
workspace

Tap Enter in the Inspector
Multiple measuring points are captured along the edge
A new feature is displayed in the feature list of the Inspector

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

If the edge is interrupted or not fully displayed in the
workspace, reposition the measuring tool and capture more
measuring points

Tap Finish in the new feature
The alignment is displayed in the feature list of the Inspector
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Measuring a straight line
For the second reference edge, you can measure a straight line with the Buffer
measuring tool, for example.

>

v

Select Line in the geometry palette

Select Buffer in the tool palette
Position the measuring tool above the reference edge

Expand the measuring tool so that the edge area enclosed in
the search range is as large as possible

Rotate the measuring tool so that the scan direction
corresponds to the desired scan direction

Select the edge detection mode at the bottom of the
workspace

Tap Enter in the Inspector
Multiple measuring points are captured along the edge
A new feature is displayed in the feature list of the Inspector

o Distribute the measuring points along the entire
length of the edge, as far as possible. This
minimizes the angular error.

If the edge is interrupted or not fully displayed in the
workspace, reposition the measuring tool and capture more
measuring points

Tap Finish in the new feature
The line is displayed in the feature list of the Inspector
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Constructing the zero point
The zero point is constructed of the point of intersection between the alignment
and the straight line.

A\
\

>
>

Select Construct in the function palette
A new feature is displayed in the feature list of the Inspector

Select Zero point in the geometry palette

Select the Alignment and Line features in the Inspector or in
the features view

The selected features are displayed in green

Tap Finish in the new feature

The zero point is created

The workpiece coordinate system for the measured object
has been determined

Select Manual measuring in the function palette

Tap Features preview

The coordinate system is shown in the workspace
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Coordinate system of the measured object
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10.4.3 Measuring a feature

210

Sec. 10.4.1: Sec. 10.4.2: Sec. 10.4.3:
Preparing a measurement > Aligning the measured > Measuring a feature
object

This section describes the typical steps required for conducting a measurement.
The description provides an overview. Additional steps may be necessary
depending on the measuring machine or the respective measuring application.

A measurement consists of the following steps:
m Selection of the appropriate geometry for the feature to be measured

B Measuring point acquisition using the selected geometry
Further information: "Capturing measuring points", page 193

o The steps described in this section are the same for each measuring
process. The steps are illustrated using the "Circle" geometry as an

example.
> Tap Measure in the main menu
:
> Select Manual measurin
g
o > Select the Circle or Measure Magic geometry in the
geometry palette

» |If required, increase the workspace by hiding the main menu
or the Inspector

» Move the measured object so that it is within the workspace

> Activate or deactivate automatic measuring point acquisition
Further information: "Setting automatic measuring point
acquisition”, page 81

» Select the Circle measuring tool
L Position the measuring tool above the circle to be measured

> Capture measuring points

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Measurement | Conducting a measurement

» Conclude the measuring point acquisition
> The measured feature is displayed in the feature list

> The feature can be evaluated
Further information: "Measurement evaluation”, page 245
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10.5 Constructing features

You can construct new features from measured, constructed or defined features.
This is done by deriving new features from the existing features, e.g. by moving or
copying.

Line 1
A

t  Zeropoint2
= A

1 Feature list in the Inspector
2 Features view in the workspace
3 Geometry palette

10.5.1 Overview of construction types

Existing features used for construction are referred to as parent features. Parent
features can be measured, constructed or defined features.

The overview shows the parent features and construction types that can be used
for constructing a feature.

Point / Zero point

Parent feature Construction type Display
Point Copy
Point Max. Y point

°
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Parent feature

Construction type

Display

Point and Line

Perpendclr. pnt.

Arc

Point Min. Y point

°

[ J
Line Center
Line End point 1 \
Line End point 2
Line Point of origin

(:

Center
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Parent feature

Construction type

Display

Arc and Line

Intersection 1

Arc and Line

Intersection 2

Arc and Line

Perpendclr. pnt.

S =2 A

2x Line Intersection
Distance End point 1

Distance End point 2
Point and Distance Shift
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Parent feature Construction type Display
Angle Vertex
Circle Center

Circle and Line

Intersection 1

Circle and Line

Intersection 2

Circle and Line

Perpendclr. pnt.

2x Circle

Intersection 1

2x Circle

Intersection 2

| PP O]
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Parent feature Construction type Display
2x Circle Center
Ellipse Center

Ellipse and Line

Perpendclr. pnt.

2x Ellipse Center
Slot Center
Rectangle Center

¢
o
O
&
§
g

Multiple features

Average from any number

and combination of the center O
points of:
[ )

Point
Slot /
Rectangle
Circle

Arc
Ellipse
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Line / Alignment

must be specified)

Distance Centerline

Ellipse Semimajor axis

Parent feature Construction type Display
Line Copy
\
2x Point Center
/
2x Line Centerline 1
W
2x Line Centerline 2
A
2x Line Gauge line (the length
v
\
=
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Parent feature Construction type Display
Point and Line Vertical
Point and Line Parallel
Point and Arc Center

o
Point and Arc Tangent 1

o
Point and Arc Tangent 2

J
Point and Circle Center

o
Point and Circle Tangent 1

ol
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Parent feature Construction type Display
Point and Circle Tangent 2
o
Point and Ellipse Center
ol
Point and Slot Center
Z%‘
Point and Rectangle Center
i3
Line and Circle Vertical
&
Line and Circle Parallel
\
O
Line and Arc Vertical
7\
U
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Parent feature Construction type Display
Line and Arc Parallel

\

\b\
Line and Ellipse Vertical

g
Line and Ellipse Parallel

\

RCE
Line and Distance Shift

n
Line and Slot Vertical

=
Line and Slot Parallel
Line and Rectangle Vertical

|
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Parent feature Construction type Display
Line and Rectangle Parallel
Line and Angle Rotation
74
/
2x Circle Center
&@
2x Circle Tangent 1
QB
2x Circle Tangent 2
“
2x Arc Center
@%
2x Arc Tangent 1
“
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Parent feature Construction type Display
2x Arc Tangent 2

J
Circle and Ellipse Center

®b
Circle and Ellipse Tangent 1

%
Circle and Ellipse Tangent 2

I,
Arc and Ellipse Center

®k
Arc and Ellipse Tangent 1

©>
Arc and Ellipse Tangent 2

0.
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Parent feature Construction type Display

Circle and Arc Center

Circle and Arc Tangent 1

Circle and Arc Tangent 2

Circle and Slot Center ~
v\€>

Circle and Rectangle Center -

Arc and Slot Center ~
)«

Arc and Slot Tangent 1 ~
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Parent feature Construction type Display

Arc and Slot Tangent 2 ~
\\

J «

Arc and Rectangle Center -

Arc and Rectangle Tangent 1 -

Arc and Rectangle Tangent 2 H\

2x Ellipse Center @\@

2x Ellipse Intersection 1

2x Ellipse Intersection 2
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Parent feature Construction type Display
Slot Centerline
U

Slot and Ellipse Center H\@
2x Slot Center

AN
Rectangle Centerline
Rectangle and Ellipse Center

Ek@

2x Rectangle Center

i
Slot and Rectangle Center
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Parent feature

Construction type Display

Multiple features

Line or Alignment from
the center points of at O

least two features in any
combination of:

Point O
Slot

|
® Circle
= Arc
= Ellipse
Circle
Parent feature Construction type Display
Circle Copy
Arc Copy (circle superimposed on
arc)
2x Circle Average
2x Line Gauge circle

Circle and Distance

Shift

O
-/
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Parent feature Construction type Display

Multiple features Circle from the center points
of at least three features in any
combination of:

E Point
= Slot
m Circle
= Arc

= Ellipse

Arc

Parent feature Construction type Display

-

Arc Copy

Arc and Distance Shift

¢\

Multiple features Arc from the center points of
at least three features in any
combination of:

® Point

= Slot

® Rectangle
m Circle
Arc

= Ellipse

Ellipse

Parent feature Construction type Display

Ellipse Copy
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Parent feature Construction type Display

Ellipse and Distance Shift

Multiple features Ellipse from the center points
of at least five features in any
combination of:

= Point

= Slot

= Rectangle
m Circle

E Arc

u Ellipse

Slot

Parent feature Construction type Display

}

Slot Copy

Slot and Distance Shift

Multiple features Slot from the center points

of at least five features in any
combination of:

E Point

= Slot

B Rectangle
® Circle

= Arc

® Ellipse
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Rectangle

Parent feature Construction type Display
Rectangle Copy

Rectangle and Distance Shift

1

Multiple features Rectangle from the center
points of at least five features
in any combination of:
= Point
= Slot

= Rectangle

!
)

m Circle
B Arc
u Ellipse
Distance
Parent feature Construction type Display
Distance Copy
Distance Direction change
2x Point Center
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Parent feature Construction type Display
Point and Line Center
\&
Point and Circle Center
ol
Point and Circle Minimum
o
Point and Circle Maximum
o]
Point and Arc Center
5
Point and Arc Minimum
bt
Point and Arc Maximum
)
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Parent feature Construction type Display
Point and Ellipse Center

ol
Point and Slot Center

#’
Point and Rectangle Center

B’/‘
Line Length

\
2x Line Center

\<\
2x Line Minimum

\é
2x Line Maximum

\i\
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Parent feature Construction type Display
Line and Circle Center
\©
Line and Circle Minimum
\ O
Line and Circle Maximum
\©
Line and Arc Center
)
Line and Arc Minimum
)
Line and Arc Maximum
Line and Ellipse Center
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Parent feature Construction type Display
Line and Slot Center

Line and Rectangle Center

2x Distance Sum

2x Distance Average

2x Distance Maximum

2x Distance Minimum

2x Circle Center
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Parent feature Construction type Display
2x Circle Maximum
&@
2x Circle Minimum
Q@
2x Arc Center
9\
2x Arc Maximum )
2
2x Arc Minimum
D
2x Ellipse Center )
%
Circle and Arc Center
el
D)

234
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Parent feature Construction type Display
Circle and Arc Maximum
Circle and Arc Minimum

Q.
Circle and Ellipse Center )

0O
Circle and Slot Center

[}-O
Circle and Rectangle Center

1O
Arc and Ellipse Center

e
Arc and Slot Center

)
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Parent feature

Construction type Display

Arc and Rectangle

Center

ind
Slot and Ellipse Center

oN
2x Slot Center

AN
Rectangle and Ellipse Center

1O
2x Rectangle Center
Slot and Rectangle Center

TR
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Angle

Parent feature Construction type Display
Angle Copy

2x Line Interior angle

2x Line 180° - angle

2x Line 180° + angle

2x Line 360° - angle
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10.5.2 Constructing a feature

238

>

Tap Measure in the main menu
Select Construct in the function palette

Select the desired geometry in the geometry palette,
e.g. Distance

Select the required parent features in the feature list
The selected features are displayed in green

A new feature with the selected geometry is displayed

Tap Finish in the new feature

0 If a feature cannot be concluded, the
construction must be checked to ensure that the
parent features used are permitted.

The constructed feature is displayed in the workspace and
the feature list
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Alignment 1
PN

Line 1
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PN

Slot 1
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Editing a constructed feature

The constructed features can be edited immediately after construction. Depending
on the geometry and the parent features, you can change the construction type of
a constructed feature.

>

v

VvV yYyy

Drag the constructed feature from the feature list into the
workspace

The Details dialog appears with the Overview tab selected

To rename the feature, tap the input field containing the
current name

Enter a name for the feature
Confirm entry with RET
The new name is displayed in the feature list

To change the construction type of the feature, select
the type you want to use for the construction in the
Construction type drop-down list

o The available construction types depend on the
geometry and the parent features.

Further information: "Overview of construction
types', page 212

The new construction type is applied

To change the geometry type, select the desired geometry
type in the New type of geometry drop-down list

The feature is displayed in the new form
Tap Close to close the dialog
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10.6 Defining features

In some situations, it is necessary to define features. This may be the case, for
example, if a reference used in the technical drawing cannot be established on the
measured object by means of measurement or construction. Here you can define
the reference on the basis of the coordinate system of the measured object.

1

mm vzi

manual

Alignment 1

a

Line 1

A
t  Zeropoint2
= A

Girde 3

a

—Slot 1
o

Blob 1
A
ance

es of t

E 10.0000

Display of the geometry

Feature list in the Inspector

Input fields for the geometry parameters
Geometry palette

AP WON=

10.6.1 Overview of definable geometries

The overview shows the definable geometries and the required geometry
parameters.

Display Geometry parameters

Point

The feature is defined by the following values:
m X: Position on the X axis

= Y: Position on the Y axis

240 HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Measurement | Defining features

Display Geometry parameters

Height point
The height point can only be defined if the Z axis is active.
The feature is defined by the following values:
+ m X: Position on the X axis
B Y: Position on the Y axis
0 ® Z: Position on the Z axis

Line

The feature is defined by the following values:

® X1: Position of the first point on the X axis

= Y1: Position of the first point on the Y axis

. X2: Position of the second point on the X axis
® Y2: Position of the second point on the Y axis

Circle

The feature is defined by the following values:

X: Position of the center point on the X axis

Y: Position of the center point on the Y axis

D: Diameter of the circle

R: Radius of the circle

To switch between diameter and radius, tap D or R

V B B §m

Arc

The feature is defined by the following values:

m  X: Position of the vertex on the X axis

= Y: Position of the vertex on the Y axis

Bs: Starting angle between the X axis and the first side

Be: End angle between the X axis and the second side
enclosing the opening angle

® D: Diameter of the arc
R: Radius of the arc
To switch between diameter and radius, tap D or R

o
u

v
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Display Geometry parameters

Ellipse

The feature is defined by the following values:
®  X: Position of the center point on the X axis
® Y: Position of the center point on the Y axis
= \W: Length of the minor axis

® L: Length of the reference axis

= 0: Angle between X axis and reference axis

Slot

The feature is defined by the following values:
®  X: Position of the center point on the X axis
® Y: Position of the center point on the Y axis
= \W: Width of the slot

® |: Length of the slot (reference axis)

8: Angle between X axis and reference axis

Rectangle
The feature is defined by the following values:
®  X: Position of the center point on the X axis
® Y: Position of the center point on the Y axis
W: Width of the rectangle
L: Length of the rectangle (reference axis)
8: Angle between X axis and reference axis

Distance

The feature is defined by the following values:

® X1: Position of the first point on the X axis
Y1: Position of the first point on the Y axis
X2: Position of the second point on the X axis

Y2: Position of the second point on the Y axis
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Display Geometry parameters

Zero point

The feature is defined by the following values:
® X: Position on the X axis

® Y: Position on the Y axis

Alignment

The feature is defined by the following values:
®  X: Position on the X axis
= Y: Position on the Y axis

B 0: Direction with angle between X axis and alignment

X1 (=)

Y1
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10.6.2 Defining a feature

244

> Tap Measure in the main menu
> Select Define in the function palette

> Select the desired geometry in the geometry palette

Further information: "Overview of definable geometries’,

page 240

> A new feature is added to the feature list and displayed in the
workspace

Enter a name for the feature

Confirm entry with RET

Enter the geometry parameters of the feature
Confirm the entries with RET

Tap Finish in the new feature

The defined feature is displayed in the feature list

vV Vv v v vy
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manual 5

Alignment 1
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Line 1
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t  Zeropoint2
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Circle 3
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7369 —

Enter the coordinates of the crcle center

and the diameter or radius.
E 6.0000
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Measurement evaluation | Overview

1.1 Overview

This section describes the following functions:
B Evaluating a measurement
® Defining tolerances

o Make sure that you have read and understood the "Basic Operation’
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

The measurement evaluation and tolerancing described in this chapter are
performed using the features that were measured or constructed in the Quick Start
chapter. The supplied 2-D demo part is used as an example for illustrating how to
apply the tolerances.

Further information: "Quick Start", page 157

11.2  Evaluating a measurement

During a measurement, the product determines features from the captured
measuring points. Depending on the number of measuring points captured, a
fitting algorithm is used to calculate the appropriate substitute feature and display it
as a feature in the feature list. The Gaussian fitting algorithm is used by default.

The following functions are available:
= Changing the fitting algorithm
® Converting the geometry type

Activation
> Tap Measure in the main menu
> The user interface for measuring, constructing and defining
appears

» Drag the feature from the feature list into the workspace
> The Details dialog appears with the Overview tab selected
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Short description

A WON=

mm vzi
Qverview Tolerances manual 500 ms
45.0507
22.8034
Circle 2 0.0000
P C
X | 773666 Zero Y
oW1
Y | 309782 Zero
Alignment 1
a
0.0000 Zero
Line 1
A
Diameter e AR | | Zcro point 1
Form deviation 0.0204
A
Number of points 26 of 31
Blob 1
A
Fitting algorithm Gaussian v
New type of geometry Point =

© Enter

Name of the feature

Axis positions of the center point

Feature properties and parameters

Features view of the measuring points and the form

The Overview shows the following details about the feature:

Name of the feature

Axis positions of the center point

Feature parameters, depending on the type of geometry
Number of measuring points used for calculating the feature

Fitting algorithm used for calculating the feature (depending on the geometry
and the number of measuring points)

List of geometry types to which the feature can be converted

Display of measuring points and form

® The measuring points with the greatest deviations
within the fitting algorithm are displayed in red

® The measuring points that are not used for the fitting
algorithm according to the measuring point filter
settings are displayed in gray

B The measuring points used for the fitting algorithm are
displayed in white

® The distances between the measuring points and the
calculated form are displayed as lines
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11.2.1 Fitting algorithm

Short description

If the number of points captured during the measurement of a feature exceeds the
mathematical minimum number of points, there are more points than necessary
for determining the geometry. The geometry is thus overdetermined. Therefore,
fitting algorithms are used to calculate the appropriate substitute feature.

The following fitting algorithms are available:

B aussian

B Minimum zone

B Max. inscribed

= Min. circumscribed

The fitting algorithms are described below, using a circle as an example:

Gaussian

Fitting algorithm that calculates a substitute feature that is
optimally centered between all measuring points.

The statistical mean of all captured measuring points is
used for the calculation. All measuring points are weighted
equally.

Gaussian is the default setting.

Minimum zone

“'h Fitting algorithm that calculates a geometry from two refer-
%/}:’é’% ence circles. One circle lies on the two outermost measur-

///
7 . : . . .
\\%g’ ing points. The other circle lies on the two innermost
Y%

measuring points. The two circles have the same center.

The substitute feature is located halfway between the two
circles.

The algorithm is suitable for measuring form error.

Max. inscribed

Fitting algorithm that calculates a substitute feature that is
located within all measuring points and, at the same time,
is as large as possible.

The algorithm is suitable e.g. for measuring holes when
checking mating sizes.

Min. circumscribed

Fitting algorithm that calculates a substitute feature that
is located outside the measuring points and, at the same
time, is as small as possible.

The algorithm is suitable e.g. for measuring pins or shafts
when checking mating sizes.

U

it

0 The center of the minimum circumscribed circle does not coincide with
the center of the maximum inscribed circle.
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Overview
The following overview shows the possible fitting algorithms for the features.

Geometry Fitting algorithm

Gaussian Minimum  Max. Min.
inscribed circum-
scribed

Point

Line

X

Circle
Arc
Ellipse
Slot

Rectangle

X | X | X
>

Distance

Angle
Blob

Zero point

Alignment

X XX |IX|X|X|X|X|X|X|X|X]|X

Reference plane
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11.2.2 Evaluating a feature

250

Renaming a feature

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
Tap the input field containing the current name

Enter a name for the feature

Confirm entry with RET

The new name is displayed in the feature list

Tap Close to close the dialog

vVV Vv VvV VvV yVYy

Adjusting the fitting algorithm

You can adjust the fitting algorithm depending on the measured feature. The
geometry is basically calculated using the Gaussian fitting algorithm.

Further information: "Fitting algorithm", page 248

> Drag the feature from the feature list into the workspace

> The Details dialog appears with the Overview tab selected

> The fitting algorithm used is displayed

> Select the desired fitting algorithm in the Fitting algorithm
drop-down list

> The feature is displayed according to the selected fitting
algorithm
Further information: "Display of measuring points and form",
page 247

> Tap Close to close the dialog
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Converting a feature
The feature can be converted to a different type of geometry. The list of possible
geometry types is provided as a drop-down list in the features view.

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected
The geometry type of the feature is displayed

Select the desired geometry type in the New type of
geometry drop-down list

The feature is displayed in the new form

Further information: "Display of measuring points and form",
page 247

. » Tap Close to close the dialog

vVVvVvyVvVvy

v
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252

Defining tolerances

This section describes the following functions:

® Qverview of tolerances

® Configuring general tolerances
= Tolerancing the features

Activation

v

vV v.v VY

Short description

Measurement evaluation | Defining tolerances

Tap Measure in the main menu
The user interface for measuring, constructing and defining

appears

Drag the feature from the feature list into the workspace
The Details dialog appears with the Overview tab selected

Tap the Tolerances tab

The tab for tolerancing the selected feature is displayed

Runout tolerances

Concentricity

mm vz1
Overview Totrances manual
45.0513
General tolerances 150 2768 » 22.8034
a 15984
Size tolerance @ Circle 3 X Y 4 | [ o)
Cirde 3 (D] 4 i
O 'S
A
Form tolerances O Roundness 4 1 Zero point 2
A
Location tolerances {B Position » Q Xd" 3

—Slot 1
=5k

Blob 1
A

¢ Distance 1
A

N =

Display of general tolerance
List of tolerances, depending on feature

3 Status of the tolerance: active and within the tolerance or active and outside

the tolerance

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Measurement evaluation | Defining tolerances

On the Tolerances tab, you can define the geometrical tolerancing of a measured
or constructed feature. The tolerances are grouped.

0 Tolerances cannot be applied to reference features, such as zero point,
alignment and reference plane.

Depending on the feature, you can define the following tolerance types:

®  General tolerances, e.g. application of the ISO 2768 standard

® Size tolerances, e.g. diameter, width, length and angle of reference axis
= Form tolerances, e.g. roundness

B | ocation tolerances, e.g. position, concentricity

= Directional tolerances, e.g. angularity, parallelism, perpendicularity

= Runout tolerances

The tolerances can be activated or deactivated.

Further information: "Tolerancing the features", page 258

Display of toleranced features

vz1
manual 5

45.0513
22.8034

Alignment 1

A

Line 1 2
A

t  Zeropoint2
s A

Circle 2
PN

—Slot 1
=

Blob 1
A

¢ Distance 1
A

Cirde 5
©e

o

1 Feature (red) with one or more tolerance values exceeded
2 Feature list with toleranced features, indicated by the symbol

The features preview in the workspace displays a feature in red if one or more of
its tolerance limits were exceeded.

The results of the tolerance test are indicated by symbols in the feature list and on
the Tolerances tab.

Symbol Meaning

The activated tolerances of the feature are met.

Q One or more activated tolerances of the feature are exceeded.
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11.3.1 Overview of tolerances
The following overview shows the tolerances that can be defined for a feature.

Feature General Size Form Location Direction Runout

Point, height point ISO 2768 - - -

SRS

Line ISO 2768 / // -
Circle ISO 2768 : : | - /
Arc ISO 2768 : | - /
Ellipse ISO 2768 - | - i
Slot ISO 2768 - - -
== &
Rectangle ISO 2768 - | - -
Distance ISO 2768 - - - -

Angle ISO 2768

=
A
Blob ISO 2768 @ - @ - -
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Overview of position tolerance types

Symbol

Tolerance type

Circular tolerance zone

A circular tolerance zone is set around the nominal dimension of the feature's
position. The position of the center point defines the position of the feature.

The center point of the feature must be within the tolerance zone.

Rectangular tolerance zone

A rectangular tolerance zone is set around the nominal dimension of the feature's
position. The upper and lower tolerance limits define the tolerance zone.

The center point of the feature must be within the tolerance zone.

Sloe)

Maximum material requirement (MMR)

The maximum material requirement allows tolerance compensation between the
position tolerance and the size tolerance. The maximum material requirement is
applied to features of the circle and arc types. It defines a tolerance for the feature
with respect to a geometrically ideal counterpart to check the joinability of the
workpiece.

dloe)

Least material requirement (LMR)

The least material requirement defines the requirements for the minimum material
thicknesses of a feature. It defines a tolerance for the feature with respect to a
geometrically ideal counterpart that must be fully enclosed by the feature.
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Measurement evaluation | Defining tolerances

Configuring general tolerances

Tolerances can be assigned to the features in different ways. You can either
manually define the tolerance limits for each value, e.g. size or position, or you can
use general tolerances.

The general tolerances are defined globally. The general tolerances can be used in
all features that can be toleranced. The general tolerances available on the product
include, for example, ISO 2768 and decimal place tolerances.

Features to which a general tolerance is applied are automatically updated with
respect to the tolerance limits whenever the setting of the general tolerance
changes. Manually set tolerance limits are not updated automatically.

» Drag the feature from the feature list into the workspace
The Overview tab is displayed

> Tap the Tolerances tab

> The tab for tolerancing the selected feature is displayed

» Tap General tolerances

mm vzZ1
Overview Tolerances AR
45.0513
22.8034
4 General tolerances

il e ®
o \

No general tolerances

] Standard Length, angle, rounding arc and Straightness, symmetry, runout, y Alignment 1
General tolerance chamfers flatness and perpendicularity A

[ 1 [ 1 [ 'f Line 1
150 2768 - f - H - / A

t  Zeropoint2
= A

Decimal place tolerances XX 0.02 Circle 3
PN
SI:)t 1
XXX 0.01 PN
O Blob 1
PN
XXX 0.005 1
= Distance 1
00K 0.0005 . |
Circle 5
e
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Selecting general tolerances
The tolerance tables defined in the ISO 2768 standard are stored on the product
for all tolerance classes.

>

r >

Tap the checkbox next to General tolerance to activate the
general tolerances

The active checkbox is highlighted in green

Select the desired standard in the Standard drop-down list

Select the desired tolerance class in the Length, angle,
rounding arc and chamfers drop-down list

Select the desired tolerance class in the Straightness,
symmetry, runout, flatness and perpendicularity drop-
down list

Tap General tolerances

The selected general tolerance is displayed on the
Tolerances tab

Defining the decimal place tolerance
You can define a separate tolerance for each decimal place.

>

—

vV v vV Vv VvV Yy

To perform decimal place tolerancing, tap the checkbox next
to Decimal place tolerances

The active checkbox is highlighted in green

Tap an input field

Enter a value for the tolerance limit

Confirm entry with RET

Repeat the last three steps for the remaining decimal places
Tap General tolerances

The Decimal place tolerances are displayed on the
Tolerances tab

Deactivating general tolerances

>

r >

v

Tap the checkbox next to No general tolerances to
deactivate the general tolerances

The active checkbox is highlighted in green

Tap General tolerances

No general tolerance is displayed on the Tolerances tab
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Measurement evaluation | Defining tolerances

Tolerancing the features

The setting of tolerances is described using an example based on the features that
were measured and constructed in the Quick Start chapter.

Setting size tolerances

You can define the size tolerances for the following geometry parameters of a
feature:

Axis positions (X, Y) of the center point

Angle (B) between the X axis of the coordinate system and the reference axis
Width (W) and length (L) of slot and rectangle

Length (L) of line and distance

Largest dimension (A) and smallest dimension (C) of a blob

Radius (R) of circle and arc

Diameter (D) of circle and arc

0 The procedure for setting the size tolerances is the same for all

features. The following description shows how to set the size tolerance
for the axis position X of a circle.

» Drag the feature from the feature list into the workspace
> The Overview tab is displayed
> Tap the Tolerances tab
> The tab for tolerancing the selected feature is displayed
5 » Tap the size tolerance X
: > An overview of the selected size tolerance appears
o T > Activate tolerancing of the measured value with the ON/OFF

sliding switch

> The drop-down list with the selected General tolerance ISO
2768 or Decimal place tolerances is activated
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Setting General tolerance ISO 2768

mm vzi
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> The nominal and actual dimensions are displayed

» Tap the Nominal dimension input field to enter the nominal
dimension

Enter the desired value
» Confirm entry with RET

The upper and lower tolerance or the upper and lower limit
are displayed

o The tolerance limits are entered automatically
based on the nominal dimension and the
specified general tolerance.

» To switch between the Upper tolerance and Upper limit
input fields, tap Upper tolerance or Upper limit

The nominal value is shown in red if it is out of tolerance
The nominal value is shown in green if it is within tolerance
Tap the size tolerance

The Tolerances tab is displayed

The result of the tolerance test is displayed on the tab and in
the feature list

V V VvV V YV
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Setting General tolerance Decimal place tolerances

mm \741
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> The nominal and actual dimensions are displayed

» Tap the Nominal dimension input field to enter the nominal
dimension

Enter the desired value

» Confirm entry with RET
Use the slider below Nominal dimension to set the tolerance
limit (number of decimal places)

> The upper and lower tolerance limit values or the upper limit
and lower limit are displayed

o The tolerance limits are entered automatically
based on the nominal dimension and the
specified general tolerance.

» To switch between the Upper tolerance and Upper limit
input fields, tap Upper tolerance or Upper limit

> The nominal value is shown in red if it is out of tolerance
> The nominal value is shown in green if it is within tolerance

@ > Tap the size tolerance
> The Tolerances tab is displayed

> The result of the tolerance test is displayed on the tab and in
the feature list
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Setting the tolerance limits manually

The tolerance limits can be adjusted manually to differ from the general tolerance
specified for the respective feature. The modified tolerance values apply only to
the currently open feature.

>

VV VvV VvV VvV VVvVYVvyy

To switch between the Upper tolerance and Upper limit
input fields, tap Upper tolerance or Upper limit

Tap the Upper tolerance or Upper limit input field
Enter the desired value

Confirm entry with RET

The adjusted tolerance value is applied

Tap the Lower tolerance or Lower limit input field
Enter the desired value

Confirm entry with RET

The adjusted tolerance value is applied

The value is shown in green if the deviation of the actual
dimension is within the tolerance zone

The value is shown in red if the deviation of the actual
dimension is outside the tolerance zone

The display in the drop-down list switches to Manual after the
adjustment

Tap the symbol for size tolerance
The Tolerances tab is displayed

The result of the tolerance test is displayed on the tab and in
the feature list
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Setting form tolerances

You can define the form tolerances for the following geometry parameters of a
feature:

= Roundness for circles and arcs
®  Straightness for lines

o The procedure for setting the form tolerances is the same for all
features. The following description shows how to perform roundness
tolerancing for a circle.

Drag the feature from the feature list into the workspace
The Overview tab is displayed

Tap the Tolerances tab

The tab for tolerancing the selected feature is displayed
Tap Roundness

An overview of the selected form tolerance appears

Activate tolerancing of the measured value with the ON/OFF
sliding switch

> The drop-down list with the selected General tolerance ISO
2768 or Decimal place tolerances is activated

vV VVV VVYy
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Setting General tolerance ISO 2768

Overview

4 O Roundness

ON

150 2768-mH

Tolerances

-
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The fitting algorithm is activated

The tolerance zone of the selected general tolerance is
displayed

o The tolerance zone is entered automatically
based on the specified general tolerance.

The deviation from the ideal form is displayed
Select the desired fitting algorithm

The value of the tolerance zone is shown in green if the
deviation is within the tolerance zone

The value of the tolerance zone is shown in red if the
deviation is outside the tolerance zone

Tap Roundness
The Tolerances tab is displayed

The result of the tolerance test is displayed on the tab and in
the feature list
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Measurement evaluation | Defining tolerances

Setting the tolerance zone manually

The tolerance zone can be adjusted manually to differ from the general tolerance
specified for the respective feature. The modified tolerance value applies only to
the currently open feature.

Tap the Tolerance zone input field
Enter the desired value

Confirm entry with RET

The adjusted tolerance value is applied

The value of the tolerance zone is shown in green if the
deviation is within the tolerance zone

> The value of the tolerance zone is shown in red if the
deviation is outside the tolerance zone

> The display in the drop-down list switches to Manual after the
adjustment

O > Tap Roundness
> The Tolerances tab is displayed

> The result of the tolerance test is displayed on the tab and in
the feature list

VV VvvVvy
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Setting location tolerances

You can define the location tolerances for the following geometry parameters of a
feature:

= Position for point, height point, line, circle, arc, ellipse, slot, rectangle and blob
®  Concentricity for circle and arc

o The procedure for setting the position tolerances is the same for
all features. The following description shows how to set a location
tolerance for a circle with circular tolerance zone.

Drag the feature from the feature list into the workspace
The Overview tab is displayed

Tap the Tolerances tab

The tab for tolerancing the selected feature is displayed
Tap Position

An overview of the selected position tolerance appears

The selection of position tolerance types is displayed
Further information: "Overview of position tolerance types’,
page 255

> Activate tolerancing of the measured value with the ON/OFF
l sliding switch

VV VYV VvV VYy

ON

> The drop-down list with the selected General tolerance ISO
2768 or Decimal place tolerances is activated
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Setting General tolerance ISO 2768

mm \741

Ubersicht Toleranzen manual | 500 ms

4 @ Position
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| 150 2768-mH = | Abweichung 0.0000 Toleranzzone

Kreis
A
X SolmaB Schwerpun...
A

Istmab 920.5572 Nut G
PN

Abweichung 0.0000
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W Solmaf 4

» Select the fitting algorithm for tolerancing in the Fitting
algorithm drop-down list

Tap Circular tolerance zone
The tolerance zone is displayed
The nominal and actual dimensions are displayed

To enter the nominal dimension for X, tap the Nominal
dimension input field

Enter the desired value
Confirm entry with RET

> To enter the nominal dimension for Y, tap the Nominal
dimension input field

Enter the desired value
» Confirm entry with RET

The tolerance zone is updated according to the specified
nominal values

V.V VvV Yy

\ A 4

o The tolerance zone is entered automatically
based on the nominal dimension and the
specified general tolerance.

> The value of the tolerance zone is shown in red if the
deviation is outside the tolerance zone

> The value of the tolerance zone is shown in green if the
deviation is within the tolerance zone

@ » Tap Position
> The Tolerances tab is displayed

> The result of the tolerance test is displayed on the tab and in
the feature list
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Setting the tolerance zone manually

The tolerance zone can be adjusted manually to differ from the general tolerance
specified for the respective feature. The modified tolerance value applies only to
the currently open feature.

> Tap the Tolerance zone input field to manually adjust the
tolerance zone

» Enter the desired value
» Confirm entry with RET

> The value of the tolerance zone is shown in green if the
deviation is within the tolerance zone

> The value of the tolerance zone is shown in red if the
deviation is outside the tolerance zone

> The display in the drop-down list switches to Manual after the
adjustment

@_ » Tap Position
The Tolerances tab is displayed

> The result of the tolerance test is displayed on the tab and in
the feature list

A4
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Setting the runout and directional tolerances
A reference feature is required for setting the runout and directional tolerances.

o Runout tolerances and directional tolerances (parallelism and
perpendicularity) are set in the same way. The following section
describes how to perform perpendicularity tolerancing for a straight line.
The alignment is used as the reference object for tolerancing.

Drag the feature from the feature list into the workspace
The Overview tab is displayed

Tap the Tolerances tab

The tab for tolerancing the selected feature is displayed
Tap Perpendicularity

An overview of the perpendicularity tolerance appears

m Activate tolerancing of the measured value with the ON/OFF
- sliding switch

> The drop-down list with the selected General tolerance ISO
2768 or Decimal place tolerances is activated

vVV VvV VvV VYy
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Setting General tolerance ISO 2768

mm \741

Overview Tolerances manual
45.0510
X, 22.8034
4 J_ Perpendicularity 1.5984

Reference
feature

150 2768-mH v Alignment 1
¥ A

Line 1
Deviation AN

f  Zeropoint1
— A

o v | Tokrancezone 0.2000

Cirde 1
AQ
Circle 2
V-
Circle 3
V=N

—Slot 1
E=
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> Select the Alignment feature in the Reference feature drop-
down list

> The deviation is displayed
> The tolerance zone is displayed

0 The tolerance zone is entered automatically
based on the specified general tolerance.

> The value of the tolerance zone is shown in red if the
deviation is outside the tolerance zone

> The value of the tolerance zone is shown in green if the
deviation is within the tolerance zone

J_ » Tap Perpendicularity
> The Tolerances tab is displayed

> The result of the tolerance test is displayed on the tab and in
the feature list

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016

269



270

Measurement evaluation | Defining tolerances

Setting the tolerance zone manually

The tolerance zone can be adjusted manually to differ from the general tolerance
specified for the respective feature. The modified tolerance value applies only to
the currently open feature.

> Tap the Tolerance zone input field to manually adjust the
tolerance zone

» Enter the desired value
» Confirm entry with RET

> The value of the tolerance zone is shown in green if the
deviation is within the tolerance zone

> The value of the tolerance zone is shown in red if the
deviation is outside the tolerance zone

> The display in the drop-down list switches to Manual after the
adjustment

J_ > Tap Perpendicularity
The Tolerances tab is displayed

> The result of the tolerance test is displayed on the tab and in
the feature list

A4
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12.1  Overview

This chapter describes how to create and edit measuring programs and how to use
them for recurring measuring tasks. The following functions are described:

®  Using the program control
Recording a measuring program
Saving a measuring program
Starting a measuring program

Editing a measuring program

o Make sure that you have read and understood the "Basic Operation’
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

Short description

The product can record and save the steps of a measuring process, and run
them sequentially as a batch process. This batch processing is referred to as the
"measuring program"”.

In a measuring program, you can thus combine multiple work steps, such as
measuring point acquisition and tolerancing, into a single process. This simplifies
and standardizes the measuring process.

Measuring programs can include the following work steps:
Alignment of the measured object

Measuring point acquisition

Construction and definition

Measurement evaluation

Tolerancing

The work steps of a measuring program are referred to as program steps. The
program steps are displayed in the program step list in the Inspector.

o Regardless of whether the feature list or the program step list is
the current view in the Inspector, the product always records every
measuring process or work step as a program step. The operator can
switch the view between the feature list and the program step list at
any time.
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Activation

Tap Measure in the main menu

The user interface for measuring, constructing and defining
appears

Tap Miscellaneous functions in the Inspector

Tap Program step list in the dialog

The program step list is displayed in the Inspector
The program control is displayed in the workspace
In the Miscellaneous functions dialog, tap Close

H D

vVVyVvyVYyy

manual

45.0510
22.8034
0.0000

| ©
(@)
Initialization

Auto enter

Display Start VED probe

Feature list Program step list
ICalculate Alignmen

Start VED probe

=)
/

3

1 Control with operating elements
2 Program step list
3 Miscellaneous functions
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Using the program control

You can control the execution of an active measuring program directly in the
workspace.

Calling the program control
If the program control is not displayed in the workspace, you can call the program
control in the following way:

Tap Miscellaneous functions in the Inspector
Tap Control in the dialog
The program control is displayed in the workspace

To move the program control in the workspace, drag the
program control to the desired location

vV v Vvy

Operating elements of the program control

Operating Short description
element

Before the start of the measuring program, the program
control shows the following information:
m  1: Status of the measuring program
A dashed circle is displayed while a program step is
being edited
®  2: Name of the measuring program, e.g. Program
Unsaved measuring programs are displayed in italics
® 3: Close
The program control is closed
E 4: Remove breakpoints
Breakpoints that were set while editing a measuring
program are cleared
® 5:Single steps
The measuring program is run step by step
E 6: Run
The measuring program is run

12

After the start of the measuring program, the program
control shows the following information:

m  7: Status of the measuring program
Program steps are being executed

= 8: Remove breakpoints
Breakpoints that were set while editing a measuring
program are cleared

= 9: Terminate
The measuring program is terminated

= 10: Pause
The measuring program is paused

Closing the program control
If no measuring program is currently being executed or edited, you can close the
program control.

. » Tap Close to close the program control
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12.3 Recording a measuring program

All work steps of a measuring process are recorded. The work steps are displayed
as program steps in the program step list. You can use any work step for a
measuring program.

To start recording a new measuring program, proceed as described below.

o Unsaved work steps are deleted before a new measuring program is
recorded.

v

Tap Miscellaneous functions in the Inspector
In the Miscellaneous functions dialog, tap New

> To delete existing program steps, confirm the message with
OK

> All features and program steps are deleted

> An empty feature list or a new program step list appears,
depending on the selection

» Perform the measuring process on the measured object, e.g.
alignment of measured object, acquisition and evaluation of
features

> All program steps are displayed in the program step list

v

12.4 Saving a measuring program

To be able to run a measuring process repeatedly, you need to save the executed
work steps as a measuring program.

. » Tap Miscellaneous functions in the Inspector
In the Miscellaneous functions dialog, tap Save as

Select the storage location in the dialog, e.g.
Internal/Programs

Enter a name for the measuring program
Confirm entry with RET

Tap OK

The measuring program is saved

The name of the measuring program is displayed on the
program control

v

VV Vv vVvyy
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Starting a measuring program

The measuring program that is currently being recorded or executed can

be started directly with the program control. Program steps requiring user
intervention are supported by a wizard. User intervention may be required under
the following conditions, for example:

B The measuring points are outside the live image (only if the QUADRA-CHEK
3000 VED software option and the VED sensor are both active)

B The settings of the camera optics must be adjusted, e.g. magnification of the
camera

= The measured object must be positioned manually using the axes of the
measuring plate

Starting a measuring program

o The user interface is locked while a program is running. Only the
operating elements of the program control and Enter can be used.

v

u Tap Run on the program control
> The program steps are executed

> Program steps that are currently being executed or require
user intervention are highlighted

> When user intervention is required, the measuring program
stops

» Perform the required user intervention

> The execution of the program steps is resumed until the next
user intervention is required or the end of the program is
reached

> The successful completion of the measuring program is
displayed

» Tap Close in the message

> The features are displayed in the features preview
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Starting a measuring program from the file manager

v

Tap File management in the main menu

> The user interface for managing the stored files and
documents appears

» Navigate to the location where the program is stored, e.g.
Internal/Programs

» Tap the name of the program

> An overview of the program properties is displayed

» Tap Open

> The user interface for measuring, constructing and defining
appears

> The program step list containing the program steps of the
measuring program is displayed

> The selected measuring program is displayed on the program
control

o The user interface is locked while a program is running. Only the
operating elements of the program control and Enter can be used.

u » Tap Run on the program control
The program steps are executed

v

> Program steps that are currently being executed or require
user intervention are highlighted

> When user intervention is required, the measuring program
stops

» Perform the required user intervention

> The execution of the program steps is resumed until the next
user intervention is required or the end of the program is
reached

> The successful completion of the measuring program is
displayed

> Tap Close in the message

> The features are displayed in the features preview
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Editing a measuring program

In the program step list, you can edit the program steps of a measuring program
that is currently being recorded or that has been saved.

Opening a measuring program

> Tap File management in the main menu

> The user interface for managing the stored files and
documents appears

» Navigate to the location where the program is stored, e.g.
Internal/Programs

» Tap the name of the program

> An overview of the program properties is displayed

» Tap Open

> The user interface for measuring, constructing and defining
appears

> The program step list containing the program steps of the
measuring program is displayed

> The selected measuring program is displayed on the program
control

Adding program steps

You can add work steps to an existing measuring program. To include the new
work steps in the measuring program, you need to save the measuring program
again.

» In the program step list, highlight the program step after
which the new work step must be inserted
» Execute the new work step

> The work step is added to the program step list as a new
program step

o If changes are made to a measuring program, the measuring program
needs to be saved again.

Further information: "Saving a measuring program"’, page 275
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12.6.2 Adjusting program steps

You can adjust the settings of every recorded program step.

The program steps of a measuring program belong to the following categories:
® Settings of the Inspector, e.g. unit of measure

B Measuring tools

= Lighting

® Features

The adjustments made to a program step become effective immediately after
tapping Finish or Close.

To apply the changes to the measuring program, you need to save the measuring
program again after you have made the adjustments.

Adjusting the settings

Drag the program step to the left into the workspace
The settings are displayed

Adjust the settings

Tap Finish in the program step

The settings are applied

VvV v vV Y

o If changes are made to a measuring program, the measuring program
needs to be saved again.

Further information: "Saving a measuring program"’, page 275

Adjusting the measuring tool

» Drag the program step of the measuring tool to the left into
the workspace

The measuring tool is displayed

Adjust the measuring tool, e.g. size and alignment

Tap Settings at the bottom of the workspace

Adjust the settings of the measuring tool

Further information: " Setting the VED measuring tool", page 85
» Tap Close to close the settings of the measuring tool

vV v.Vv.yV

&

> The settings for the measuring tool are applied

If changes are made to a measuring program, the measuring program
needs to be saved again.

Further information: "Saving a measuring program’, page 275

. » Tap Finish in the program step
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Adjusting the lighting
» Drag the program step for setting the lighting to the left into
the workspace
> The lighting settings are displayed
» Adjust the lighting
Further information: "Adjusting the lighting", page 94
» Tap Finish in the program step
i > The lighting settings are applied

0 If changes are made to a measuring program, the measuring program
needs to be saved again.

Further information: "Saving a measuring program"’, page 275

Adjusting a feature

» Drag the program step of the feature to the left into the
workspace

> The Overview and Tolerances tabs are displayed

» On the Overview tab, adjust the settings of the feature
Further information: "Evaluating a feature", page 250

» On the Tolerances tab, adjust the tolerancing of the feature
Further information: "Defining tolerances", page 252

o General tolerances are applied to all tolerances
of the features unless they are overwritten
manually or ISO 286 is applied.

. » Tap Close to close the dialog
> The settings and tolerances are saved for the feature

0 If changes are made to a measuring program, the measuring program
needs to be saved again.

Further information: "Saving a measuring program"’, page 275
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Deleting a program step

» Drag the program step to the right out of the program step
list
> The program step is deleted from the program step list

o If changes are made to a measuring program, the measuring program
needs to be saved again.

Further information: "Saving a measuring program"’, page 275

Closing a program step without applying adjustments

> Tap Close in the program step to close it without applying any
adjustments you made

> The changes made are discarded

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016

281




Programming | Editing a measuring program

12.6.3 Setting and clearing breakpoints

When creating or editing a measuring program, you can stop the program run at
specified points. After being started, the measuring program stops at a breakpoint
and needs to be resumed or terminated. A breakpoint can be set at any program
step of the measuring program.

Breakpoints cannot be saved in the measuring program.
Setting a breakpoint

» Tap the program step

The program step is highlighted

The breakpoint is displayed at the program step

Tap Breakpoint

A dot appears next to the name of the program step
The breakpoint is set

Removing a breakpoint

V V VvV YV

Tap the program step containing the breakpoint

The program step is highlighted

The breakpoint is displayed at the program step

Tap Breakpoint

The dot next to the name of the program step is removed
The breakpoint is cleared

Removing all breakpoints

VV VYV VYy

m > Tap Remove breakpoints on the program control
> All breakpoints are removed
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13.1  Overview

This chapter describes the following functions and activities:
B Managing templates for measurement reports

B Creating a measurement report

® Creating and editing templates for measurement reports

o Make sure that you have read and understood the "Basic Operation'
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

Short description

In the Measurement report main menu, you can create detailed reports for
your measuring tasks. You can document one or more measured features in a
measurement report. The measurement reports can be printed, exported and
saved.

Using the integrated editor, you can create custom report templates and adapt
them as needed.

Further information: "Creating and editing a template", page 291

Activation

> Tap Measurement report in the main menu

AllTol
Standard
PN EuroTol RGED
Standard { -
4 @ MyCustomTemplatel
MyCustomTemplate2
+
Create
Created
rq 04/18/2016 10:19:01
Last changed
{é} 04/15/2016 08:23:14
Last opened
04/18/2016 10:19:01
0)

List of default templates

Preview of the selected template

Display of information on the selected template
List of custom templates

A WN=
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13.2

Managing templates for measurement reports

You can copy existing default templates, or edit, rename or delete custom
templates.

Displaying operating elements

» Tap Measurement report in the main menu

» In the list, drag the name of the template to the right

> The operating elements for managing the templates are
displayed

Copying a template

= » Tap Copy to
p Copy

> The editor opens

Further information: "Creating and editing a template",
page 291

» To duplicate the template, tap Save as

The Save as dialog appears

Select a storage location, e.g. Internal/Reports
Enter a name for the template

Confirm the entry with RET

Tap OK to confirm copying

The copy of the template is saved

VvV v v VvV VvV YV

Editing a template

> Tap Edit file

> The editor opens
Further information: "Creating and editing a template’,
page 291

Renaming a template
Tap Rename file

Change the file name in the dialog
Confirm the entry with RET

Tap OK

vV vYvyy

Deleting a template

> Tap Delete selection

> Tap Delete
> The template for the measurement report is deleted
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Creating a measurement report

You can create a measurement report in five steps:
> Selecting a template

vvyyvVvyy

Requirement

Selecting features

Entering information on the measuring task
Selecting document settings

Saving, printing or exporting the measurement report

B The measurement and the measurement evaluation are complete

Selecting the template and features

N >
>

v v VvV VY

Tap Measurement report in the main menu

The user interface for editing the measurement reports
appears

Select a template, e.g. Standard
The preview of the selected template is displayed
Tap Create to create the measurement report

The Features menu appears with a list of all features that
have been measured, constructed and defined

o The feature list can be filtered by criteria.

Further information: "Filtering features",
page 290

Tap a feature to add it to the measurement report

Selected features are displayed in green in the list and in the
features preview

To add all features to the measurement report, tap Select all
in the Select drop-down list

All features in the list and in the features preview are
activated and displayed in green

Alignment 1

Line 1

Zero point 1

Circle 1
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Entering information on the measuring task

o The information entered depends on the configuration of the template.

» Tap the Information menu

» To adjust the date and time in the measurement report, select the Set
automatically or Set manually function in the Timestamp drop-down list

B Set manually: When creating the report, the manually set date and time are
entered

® Set automatically: \When creating the report, the current system date and
time are entered

> Select an existing user in the User name drop-down list

» |f you want another user to be displayed in the measurement report, select
Other user

» Enter the name of the user into the input field

» Confirm entry with RET

> Enter the number of the measurement job into the Job input field

» Confirm entry with RET

» Enter the part number of the measured object into the Part number input field

» Confirm entry with RET
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Selecting document settings

>
>

Tap the Document menu

To adjust the unit for linear measurement values, select the desired unit in the
Unit for linear values drop-down list

B Millimeters: Display in millimeters
B Inch: Display in inches

To reduce or increase the number of displayed Decimal places for linear
values, tap - or +

To adjust the unit for angular values, select the desired unit in the Unit for
angular values drop-down list

® Decimal degrees: Display in degrees
® Radian: Display as radian measure

To adjust the format for the date and time, select the desired format in the Date
and time format drop-down list

®  hh:mm DD-MM-YYYY: Time and date

® hh:mm YYYY-MM-DD: Time and date

® YYYY-MM-DD hh:mm: Date and time

Tap the Preview menu

The preview of the measurement report is displayed

ENTERPRISE

Operator

681047-02

2016/04/01 16:17

2-D demo part

Type Posttion Cartesian Orientation Point count

Zero point | 0 faise false
o
]

Features

Information

Document

Preview

Save as
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Saving the measurement report
Measurement reports are saved in the XMR data format. Files saved in XMR data
format can be displayed and newly created at a later point in time.

» Tap Save as

Select the storage location in the dialog, e.g. Internal/Reports
Enter a name for the measurement report

Confirm entry with RET

Tap OK

The measurement report is saved

vV v.v.v Yy

Printing the measurement report
> Tap Print

> The measurement report is output to the specified printer
Further information: "Setting up a printer", page 143

Exporting the measurement report
Measurement reports can be exported as PDF or CSV files. Exported
measurement reports cannot be newly created.

> Select the desired export format in the Export drop-down list

® Export as PDF: The measurement report is saved as a printable PDFE The
values are no longer editable

B Export as CSV: The values in the measurement report are separated by
semicolons. The values can be edited using spreadsheet software

Select the storage location in the dialog, e.g. Internal/Reports
Enter a name for the measurement report

Confirm entry with RET

Tap OK

The measurement report is exported in the selected format and stored in the
storage location

vV v v v Vv

Canceling the measurement report or closing it after saving

. > Tap Close
» Close the message with OK

» The measurement report is closed

0 In the File management main menu, you can open and edit saved
reports.

Further information: "Managing folders and files", page 305
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Filtering features

You can filter the feature list in the Features menu by type, size, tolerance and
selection. Only features meeting the filter criteria are displayed, e.g. only circles
with a specific minimum diameter.

You can use any combination of filters.

> Select the desired filter criterion

» Specify the operator

> Select the function

> To deactivate a filter criterion, tap Close next to the filter

Filter Operator Function
Type Is Only features of the selected geometry type
are displayed.
Is not Only features that are not of the selected
geometry type are displayed.
Size Equal Only features of the specified size are
displayed.

Greater than  Only features that are larger than the specified
size are displayed.

Less than Only features that are smaller than the speci-
fied size are displayed.
Tolerance Is Only features that meet the selected character-
istic are displayed:
® Passed
® Failed
B [nactive
Is not Only features that do not meet the selected
characteristic are displayed.
Selection Is Only the selected features are displayed.
Is not Only the unselected features are displayed.
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13.4 Creating and editing a template
With the editor, you can create or edit custom templates for the measurement
reports. You can create a new template in six steps:
» Opening a new template with the editor

Editing the default settings for the measurement report

Configuring the page header

Configuring the report header

Defining the data for the measurement report

vV vVvyyvVwvyy

Saving the template

13.4.1 Opening a new template with the editor

A new template can be added or created from existing templates.

> Tap Measurement report in the main menu
p P

4 » Tap Add to create a new template
> The Default settings for the template are displayed

Template AllTol.xmt
Unit for linear values Millimeters
Decimal places for linear values

Unit for angular values Decimal degrees ¥

|
IS
+ < <

Date and time format hh:mm DD-MM... ¥

Default settings Grid size

|
i
o
T

Page header X
Display page header

Report header
Display report header
Data

Display feature view

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016 291



Measurement report | Creating and editing a template

13.4.2 Editing the default settings for the measurement report

> Select the default template you want to use as the basis in
the Template drop-down list

> Select the desired unit in the Unit for linear values drop-
down list

» To reduce or increase the number of displayed Decimal
places for linear values, tap — or +

> Select the desired unit in the Unit for angular values drop-
down list

> Select the desired format in the Date and time format drop-
down list

» To reduce or increase the Grid size, tap - or +

0 A grid from 5 to 50 can be specified for the
auxiliary lines. The auxiliary lines are displayed
only in the editor. The smaller the spacing is
between the auxiliary lines, the more precisely
the fields and columns of the form can be
positioned.

> To show the page header in the template, activate Display
page header with the ON/OFF sliding switch

> To show the report header in the template, activate Display
report header with the ON/OFF sliding switch
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13.4.3 Configuring the page header

» Tap Page header

o The menu is only available if the Display page
header setting is active in the Default settings
menu.

Timestamp  [¥]

LOGO,

ENTERPRISE

Default settings

Page header

Report header

-

The different sections of the template can be edited in the editor menu.
The form fields for the template are adjustable.

N

3 The list shows the form fields that can be inserted into the selected section of

the template.

4 "Grid" operating element for displaying and hiding the auxiliary lines in the
editor.

% » Tap Grid to display or hide the grid of auxiliary lines

o The grid of auxiliary lines is always active. All
fields of the form are automatically aligned with
it.
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Adding or removing form fields

The form fields listed below can be inserted into the page header of the
measurement report. During the creation of the measurement report, the form
fields are filled according to the entries made.

» To add or remove a form field, tap the form field in the list
> Active form fields are indicated by a check mark

> The form field is inserted into the template or removed from
the template

Form field Meaning and application

Timestamp The date and time are inserted.

Job The job is inserted.

User name The user name is inserted.

Part number The part number is inserted.

Fixed text Fixed text is inserted into the template.

> Tap the Fixed text form field in the template
> Aninput field opens

> Enter the desired text
>

To close the input field, tap anywhere outside
the input field

Variable text Variable text is inserted. You can type the variable
text into the template. When creating the
measurement report, you can overwrite the text as
needed.

Logo A logo is inserted.
» Tap the Logo form field in the template
> A dialog appears
> Select the desired logo in the storage location
» Tap OK to close the dialog
> The logo is inserted into the template
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Resizing a form field
You can resize a form field with the square handles at the corners of the form field.

» Tap Grid to use auxiliary lines for easy alignment

> Drag the square handle of the corresponding form field to the
desired size

> |If form fields overlap, the affected area is highlighted in red
> The change to the form field is applied

Positioning a form field
You can position the form fields any way you want in the template.

» Tap Grid to use auxiliary lines for easy alignment

> Drag the form field to the desired position in the template
> |If form fields overlap, the affected area is highlighted in red
> The change to the form field is applied
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13.4.4 Configuring the report header

» Tap Report header

o The menu is only available if the Display report
header parameter is active in the Default
settings menu.

Timestamp [¥/]

LOGO,

ENTERPRISE

number

SoiTos2t Variable text [l

Default settings

Page header

Omitted

Report header
features

Failed
tolerances

The different sections of the template can be edited in the editor menu.

The form fields for the template are adjustable.

The list shows the form fields that can be inserted into the selected section of
the template.

4 'Grid" operating element for displaying and hiding the auxiliary lines in the
editor.

WIN =
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Adding or removing form fields

The form fields listed below can be inserted into the report header of the
measurement report. During the creation of the measurement report, the form
fields are filled according to the entries made.

» To add or remove a form field, tap the form field in the list
> Active form fields are indicated by a check mark

> The form field is inserted into the template or removed from
the template

Form field Meaning and application
Timestamp The date and time are inserted.
Job The job is inserted.

User name The user name is inserted.

Part number

The part number is inserted.

Fixed text

Fixed text is inserted into the template.

> Tap the Fixed text form field in the template
> An input field opens

» Enter text
>

To close the input field, tap anywhere outside
the input field

Variable text

Variable text is inserted. You can type the variable
text into the template. When creating the
measurement report, you can overwrite the text as
needed.

Logo

A'logo is inserted.

» Tap the Logo form field in the template

> A dialog appears

> Select the desired logo in the storage location
» Tap OK to close the dialog

> The logo is inserted into the template

Omitted features

The number of measured features that are not
displayed in the measurement report is inserted.

Failed tolerances

The number of features that are out of tolerance is
inserted.

Product designation

The product designation of the product is inserted.

Serial number

The serial number of the product is inserted.

Firmware version

The firmware version currently installed on the
product is inserted.
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Resizing a form field
You can resize a form field with the square handles at the corners of the form field.

» Tap Grid to use auxiliary lines for easy alignment

> Drag the square handle of the corresponding form field to the
desired size

> |If form fields overlap, the affected area is highlighted in red
> The change to the form field is applied

Positioning a form field
You can position the form fields any way you want in the template.

» Tap Grid to use auxiliary lines for easy alignment

> Drag the form field to the desired position in the template
> |If form fields overlap, the affected area is highlighted in red
> The change to the form field is applied
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13.4.5 Defining the data for the measurement report

» Tap Data

Name B
L @ G @ Number  [&] 3
ENTERPRISE /
Type
Cartesian ‘7‘
position d
Polar
position |
e /REPID ID.REP_POSITION X ]
Default settings
Page header Y [~
Report header z v
: [ /‘_'r
|

The different sections of the template can be edited in the editor menu.
The data table in the template can be adjusted.

The list shows the form fields that can be inserted into the data table.
"Grid" operating element for displaying and hiding the auxiliary lines in the
editor.

A WON=

» Tap Grid to display or hide the grid of auxiliary lines

ﬁ

o The grid of auxiliary lines is always active. All

It.

fields of the form are automatically aligned with
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Selecting the data for the measurement report

The form fields listed below can be inserted into the data table of the
measurement report. During the creation of the measurement report, the data are
filled in according to the entries made and depending on the measured features.

» To add or remove a form field, tap the form field in the list
> Active form fields are indicated by a check mark
> The form field is inserted as a column into the data table or

removed from the data table.

Form field Meaning and application

Name The name of the feature is inserted.
Number The number of the feature is inserted.
Type The feature type is inserted.

Cartesian position

The position in Cartesian coordinates is inserted.

Polar position

The position in polar coordinates is inserted.

X The X coordinate (Cartesian) is inserted.

Y The Y coordinate (Cartesian) is inserted.

z The Z coordinate (Cartesian) is inserted.

r The radial coordinate (polar) is inserted.

(0] The angular coordinate (polar) is inserted.

Size The main dimension of the feature (e.g. the length
of a straight line) is inserted.

Length The length of the feature is inserted.

Width The width of the feature is inserted.

Radius The radius of the feature is inserted.

Diameter The diameter of the feature is inserted.

Angle The angle of the feature is inserted.

Fitting algorithm The fitting algorithm applied to the feature is insert-
ed.

Number of points The number of points measured for the feature is
inserted.

Form deviation

The maximum deviation from the calculated ideal
form is inserted.

o Applies only to features that have
been measured using more than the
mathematically required number of
points.

Creation type

The feature type used for creating the feature is
inserted.

Tolerance - general state

The overall status of all tolerances applied to the
feature is inserted.

For example, Passed if all individual tolerances are
met.
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Form field

Meaning and application

Tolerance type

The tolerance types applied to the feature are
inserted.

Tolerance state

The states of the tolerances applied to the feature
are inserted.

Nominal dimension

The nominal dimension of a tolerance applied to
the feature is inserted.

Actual value

The actual dimension of a tolerance applied to the
feature is inserted.

Deviation

The difference between nominal dimension and
actual dimension is inserted.

Lower tolerance

The lower tolerance limit of a tolerance applied to
the feature is inserted.

Upper tolerance

The upper tolerance of a tolerance applied to the
feature is inserted.

Lower limit

The lower limit of a tolerance applied to the feature
is inserted.

Upper limit

The upper limit of a tolerance applied to the feature
is inserted.

Trend [-/+++]

The trend of the deviation is inserted.

The tolerance zone is divided into seven segments.
The result is assigned to the corresponding
segment. The corresponding segment is shown as
a trend:

® Segment -3: ---

® Segment-2: --

® Segment-1: -
Segment O: .
Segment +1: +
Segment +2: ++
Segment +3:; +++

Reference, bonus

The reference feature of a tolerance applied to the
feature is inserted.

If a material requirement is being used, the exist-
ing tolerance bonus is inserted.
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Adjusting the data table

You can resize the data table with the square handles at the corners of the data
table. The sequence of form fields in the list determines how the columns are
arranged in the table. To adjust the width of the columns in the data table, use the
diamond-shaped handles.

» Tap Grid to use auxiliary lines for easy alignment

» Use the square handles to resize and position the data table
as needed

» To rearrange the columns, long press the form field in the list
and drag it to the desired position in the list

» Adjust the column width with the diamond-shaped handles
> Columns that are outside the print area are marked red
> The changes to the data table are applied

13.4.6 Saving the template

The templates are saved in the XMT data format.
. To save the template, tap Save as

@ The Save as dialog appears
Select a storage location, e.g. Internal/Reports
Enter a name for the template
Confirm entry with RET
Tap OK

The template is saved and can be used for measurement
reports

VvV vV vV vV vV VY

13.4.7 Exiting or canceling the creation of a template

0 When creating or editing a template, you need to save the template
before closing it. Otherwise, the editing process will be canceled and
the changes will be discarded.

Further information: "Saving the template", page 302

» Tap Close to exit or cancel the creation of the template or
measurement report

» Tap OK to close the message
> The editor is closed
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File management | Overview

Overview

This chapter describes the functions provided in the "File management" menu.

o Make sure that you have read and understood the "Basic Operation'
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

Short description
The files of the product are managed in the File management menu.

Overview of file types:

Type Use
*.xmr Measurement reports
* . xmt Measurement report templates
*.xmp Measuring programs
*.mcc Configuration files
*.dro Firmware files
*.jpg, *.png, *.bmp Image files
*.ixt, *.log, *.xml, *.csv Text files
* pdf PDF files
Activation
> Tap File management in the main menu
1

= o = (3 Documents

S

b 01 Prgane

3 Reports
3 system

(Q] 3 user

&

d

1 List of available storage locations
2 List of folders in the selected storage location
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14.2 Managing folders and files
Creating a new folder

» Touch the icon of the folder in which you want to create a
new folder, and drag it to the right

> The operating elements are displayed

> Tap Create a new folder
>

Tap the input field in the dialog and enter a name for the
folder

» Confirm the entry with RET
> Tap OK
> A new folder is created

Moving a folder
» Touch the icon of the folder you want to move, and drag it to
the right
> The operating elements are displayed

E Tap Move to
> In the dialog, select the folder to which you want to move the
folder

» Tap OK
> The folder is moved

Copying a folder

» Touch the icon of the folder you want to copy, and drag it to
the right

> The operating elements are displayed

» Tap Copy to
» In the dialog, select the folder to which you want to copy the
folder
» Tap OK

> The folder is copied

Renaming a folder

> Touch the icon of the folder you want to rename, and drag it
to the right

> The operating elements are displayed

» Tap Rename folder
>

Tap the input field in the dialog and enter a new name for the
folder

» Confirm the entry with RET
» Tap OK
> The folder is renamed
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Moving a file

» Touch the icon of the file you want to move, and drag it to the
right
> The operating elements are displayed

E > Tap Move to
> In the dialog, select the folder to which you want to move the
file
> Tap OK
> The file is moved
Copying a file
» Touch the icon of the file you want to copy, and drag it to the
right
> The operating elements are displayed
» Tap Copy to
» In the dialog, select the folder to which you want to copy the
file
» Tap OK

> The file is copied

Renaming a file

» Touch the icon of the file you want to rename, and drag it to
the right

> The operating elements are displayed

» Tap Rename file
» Tap the input field in the dialog and enter a new name for the
file
» Confirm the entry with RET
» Tap OK
> The file is renamed

Deleting a folder or file
The folders and files you delete will be deleted irreversibly. If you delete a folder, all
subfolders and files contained in that folder will also be deleted.

» Touch the icon of the folder or file you want to delete and
drag it to the right

The operating elements are displayed
Tap Delete selection

Tap Delete

The folder or file is deleted

VvV VvV VvV V
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14.3 Displaying and opening files

You can view the following file types in the file manager and, if applicable, open

them for editing:

Type Use View Open
*.xmr Measurement reports v v
* . xmt Measurement report v v
templates
*.xmp Measuring programs v v
*.mcc Configuration files v -
*.dro Firmware files v -
*Jpg, *.png, *.bmp Image files v _
*.ixt, *.log, *.xml, *.csv Text files v -
* . pdf PDF files v -

Viewing files

v Vv v Vvy

& Internal/Documents

OEMServiceHints.pdf

D

[M  Qc3KserviceHints.pdf
[0 Resetsettings_de.pdf
0O

ResetSettings_en.pdf

Tap File management in the main menu
Select the Internal storage location
Tap the folder containing the file
Tap the file

A preview image (only with PDF and image files) as well as
information about the file are displayed

QC3KServiceHints.pdf

Vytvoreno
02/25/2016 09:05:03

Posledni zména
03/05/2015 13:11:24

Posledni otevfeni
02/25/2016 09:05:03

Velikost souboru
125.46 K8

Pocet stran
5

Néhled

Print

> Tap View
> The file contents are displayed
» Tap Close to close the view

In this view, you can print files of the *.pdf type on the connected

printer by tapping Print.
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Opening measuring programs
Measuring programs saved as *.xmp file type can be viewed or opened for editing.

vV v v v v VY

File management | Displaying and opening files

Tap File management in the main menu
Select the Internal storage location
Tap the Programs folder
Tap the desired file
To display the measuring program, tap View

To edit the measuring program, tap Open

The measuring program is opened in the Inspector

Further information: "Editing a measuring program®, page 278

Opening a measurement report
Measurement reports saved as *.xmr file type can be viewed or opened for

editing.

vV vyVvyy

Tap File management in the main menu
Select the Internal storage location

Tap the Reports folder
Tap the desired file

custom_templates

templates

Job_123.xmr

Internal/Reports

Job_123.xmr

Nahled Vytvorit hlaseni

Vytvoreno
02/25/2016 09:10:51

Posledni zména
02/25/2016 09:10:51

Posledni otevieni
02/25/2016 09:10:51

Velikost souboru
185 KB

To display the measurement report, tap View
To edit the measurement report, tap Recreate report
The measurement report is opened in the preview of the

editor

Further information: "Opening a new template with the editor", page 291
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14.4 Exporting files

The data can be exported to an external USB mass storage device or to the
network drive. The data can be either copied or moved:

® |f they are copied, duplicates of the data remain in the product

= Moved data are deleted in the product

> Tap File management in the main menu

)
> In the Internal storage location, navigate to the file you want
to export
» Drag the icon of the file to the right
> The operating elements are displayed
= > To copy the file, tap Copy file
py p Copy

E » To move the file, tap Move file

» In the dialog, select the storage location to which you want to

export the file
» Tap OK

> The file is exported to the USB mass storage device or the
network drive

Safely removing a USB mass storage device

> Tap File management in the main menu
» Navigate to the list of storage locations

o > Tap Safely remove

_— » Disconnect the USB mass storage device
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Settings | Overview

15.1 Overview

Short description
This chapter describes the setting options and the associated adjustment
parameters for the product.

The basic setting options and adjustment parameters for commissioning and setup
are outlined in the respective chapters:

Further information: "Commissioning", page 103
Further information: "Setup’, page 133

0 Depending on the type of user that is logged in to the product,
settings and adjustment parameters can be edited and changed (edit
permission).
If a user logged in to the product has no edit permission for a setting or
an adjustment parameter, the setting or adjustment parameter is grayed
out. The setting or adjustment parameter cannot be accessed or edited.

Further information: "User permissions’, page 335

Function Description

General General settings and information

Sensors Configuration of sensors and sensor-dependent functions

Features Configuration of measuring point acquisition and features

Interfaces Configuration of interfaces and network drives

User Configuration of users

Axes Configuration of connected encoders and error compensa-
tion

Service Configuration of software options, service functions and
information

Activation

> Tap Settings in the main menu

15.2 Factory default settings

If settings that were changed during commissioning or setup need to be reset
to the factory defaults, you can look up the default setting for each adjustment
parameter in the Settings chapter.

If all settings need to be reset to the factory defaults, you can restore the product
to the factory default settings.

Further information: "Resetting to the factory defaults", page 350
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15.3

15.3.1

15.3.2

General

Device information

The overview displays basic information about the software.

Parameter

Product designation

Displays the information

Product designation of the product

Part number

Part number of the product

Serial number

Serial number of the product

Firmware version

Version number of the firmware

Firmware built on

Firmware creation date

Last firmware update on

Date of most recent firmware update

Free memory space

Free memory space in the internal storage location Internal

Free working memory (RAM)

Free RAM on the system

Number of unit starts

Number of times the product was started up with the current
firmware

Operating time

Screen and touch screen

Parameter

Brightness

Operating time of the product with the current firmware

Explanation

The brightness of the screen can be adjusted continuously
® Setting range: 1% ... 100 %
B Default setting: 70 %

Touchscreen sensitivity

The sensitivity of the touchscreen can be adjusted in three
levels.

B Low(contamination): Allows operating the touchscreen if it is
dirty

= Normal(standard): Allows operating the touchscreen under
normal conditions

® High(gloves): Allows operating the touchscreen while
wearing gloves

m Default setting: Normal(standard)

Energy-save-mode timeout

The time until energy-save mode is activated is adjustable.

m Setting range: 0 min ... 120 min
If the value is set to 0, the energy-save mode is deactivated

m Default setting: 30 minutes
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15.3.3 Display

Parameter

Size of the axis displays

15.3.4 Sounds

Settings | General

Explanation

The size in which the axis positions are displayed in the
workspace can be adjusted in three levels.

= Small

" Medium

= Large

m Default setting: Small

The available sounds are grouped into categories. The sounds differ within a

category.

Parameter

Speaker

Explanation

Use of the built-in speaker on the rear panel of the product
m Settings: ON or OFF
® Default setting: ON

Speaker volume

Volume of the product's speaker
m Setting range: 0% ... 100 %
B Default setting: 50 %

Measuring point acquired

Sound to be played after a measuring point was acquired
When you select a setting, the associated sound is played

m Settings: Standard, Guitar, Robot, Outer space, No sound
m Default setting: Standard

Message and Error

Sound to be played when a message is displayed

When you select a setting, the associated sound is played

B Settings: Standard, Guitar, Robot, Outer space, No sound
® Default setting: Standard

Measurement successful

Sound to be played when the measurement was successful
When you select a setting, the associated sound is played

m Settings: Standard, Guitar, Robot, Outer space, No sound
m Default setting: Standard

Touch tone

314

Sound to be played when using a touch element

When you select a setting, the associated sound is played

B Settings: Standard, Guitar, Robot, Outer space, No sound
® Default setting: Standard
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15.3.5
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Printers

Default printer

Parameter

Explanation

Default printer

List of printers set up on the product

Properties
Parameter Explanation
Resolution Print resolution in dpi
B The setting range and default setting depend on the printer
type
Paper size Specification of paper size and dimensions

Add printer

B The setting range and default setting depend on the printer
type

The following parameters are available for USB printer and Network printer.

Parameter

Explanation

Located printers

Printers detected automatically on the (USB or network) port of
the product

Name Arbitrary printer name for easy identification
0 The text must not contain slashes ('/"), number signs
("#') or spaces.
Description General printer description (optional, arbitrary)
Location General location description (optional, arbitrary)
Connection Type of printer connection

Select the driver

Remove printer

Selection of the appropriate driver for the printer

Parameter Explanation

Printers List of printers configured on the product

Type Shows the type of the configured printer
Location Shows the location of the configured printer
Connection Shows the connection of the configured printer

Remove the selected printer

Deletes the configured printer from the product
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15.3.7

316

Date and time

Parameter

Date and time

Settings | General

Explanation

Current date and time of the product
m Settings: Year, Month, Day, Hour, Minute
® Default setting: Current system time

Date format

Units

Parameter

Unit for linear values

Format in which the date is displayed
Settings:
" MM-DD-YYYY: Month, day, year
® DD-MM-YYYY: Day, month, year
B YYYY-MM-DD: Year, month, day
B Default setting: YYYY-MM-DD (e.g. "2016-01-31")

Explanation

Unit of measure for linear values
m Settings: Millimeters or Inch
m Default setting: Millimeters

Rounding method for linear
values

Rounding method for linear values
Settings:

B Commercial: Decimal places from 1 to 4 are rounded down,
decimal places from 5 to 9 are rounded up

® Round off: Decimal places from 1 to 9 are rounded down
® Round up: Decimal places from 1 to 9 are rounded up

B Truncate: Decimal places are truncated without rounding up
or down

® Default setting: Commercial

Decimal places for linear values

Number of decimal places for linear values
Setting range:

® Millimeters:0...5

® Inch:0...7

Default value:

® Millimeters: 4

E Inch: 6

Unit for angular values

Unit for angular values

Settings:

® Radian: Angle in radian (rad)

= Decimal degrees: Angle in degrees (°) with decimal places

= Deg-Min-Sec: Angle in degrees (°), minutes ['] and seconds [']
m Default setting: Decimal degrees
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15.3.8

15.3.9

15.3.10
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Parameter

Rounding method for angular
values

Explanation

Rounding method for decimal angular values

Settings:

® Commercial: Decimal places from 1 to 4 are rounded down,
decimal places from 5 to 9 are rounded up

B Round off: Decimal places from 1 to 9 are rounded down
® Round up: Decimal places from 1 to 9 are rounded up

B Truncate: Decimal places are truncated without rounding up
or down

. Default setting: Commercial

Decimal places for angular
values

Number of decimal places for angular values
Setting range:

® Radian:0...7

® Decimal degrees: 0... 5

= Deg-Min-Sec: 0 ... 2

Default value:

® Radian: 5

= Decimal degrees: 3

= Deg-Min-Sec: 0

Decimal separator

Copyrights

Parameter

Open source software
Service info

Parameter

HEIDENHAIN - Customer service

Separator for the display of values
m Settings: Point or Comma
B Default setting: Point

Meaning and function

Display of the licenses of the software used

Meaning and function

Display of a document containing HEIDENHAIN service
addresses

OEM service info

Documentation

Parameter

Operating Instructions

Display of a document containing service information from the
machine manufacturer

Default: Document containing HEIDENHAIN service addresses

Meaning and function

Display of the operating instructions stored on the product

Default: No document available, the desired language can be
added
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15.4 Sensors

Depending on the software options for sensors that have been activated on the
product, various parameters are available for configuring the sensors.

Software option Sensor
QUADRA-CHEK 3000 VED Video edge detection (VED):
software option The product supports the use of a VED sensor (optical sensor).

A VED sensor is a USB camera or network camera connected to
the product.

Further information: "Video edge detection (VED)", page 318

15.5 Video edge detection (VED)

15.5.1 Camera
The Camera menu lists the virtual cameras ((GigE) and (USB)) as well as the
camera ((GigE) or (USB)) that is connected to the product.

The displayed information relates to the respective camera; the values specified by
the respective manufacturer apply to the settings.

o The available parameters and settings depend on the camera model
connected and may differ from the list given below.

Parameter Explanation

Camera Shows the name of the camera

Serial number Shows the serial number of the camera

Sensor resolution Shows the resolution of the camera sensor

Images per second Shows the number of camera images per second

Images (successful/faulty) Shows the number of successful and faulty images taken since
the last time the product was powered up

Pixel format Displayable color range of the camera image
Settings:

= 8 Bit: 256 colors

®m 16 Bit: 65 536 colors

= 24 Bit: 16.78 million colors

m 32 Bit: 16.78 million colors with accelerated rendering

Image directory Location in which the demo image is stored on the product (can
only be set for virtual cameras)

® Default setting: Internal/System/Cameralnternal/System/
Camera
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Parameter

Network settings

Explanation

Network address and subnet mask of the network connection
(can only be set for connected (GigE) camera)

DHCP

m Settings: ON or OFF
m Default setting: OFF

0 The camera must be in the same subnet as the
product.

Mirroring image

Depending on the mechanical mounting of the camera, the
image can be mirrored in the camera (can only be set for
connected cameras)

Settings:

B No: Image is not mirrored

® Horizontally: Image is mirrored horizontally
® Vertically: Image is mirrored vertically
|

Horizontally and vertically: Image is mirrored horizontally
and vertically

B Default setting: No

Pixel clock (MHz)

Rate at which the image data are read from the camera sensor
® Setting range: Depending on connected camera

Image rate

Number of single images acquired per second
m Setting range: Depending on connected camera

o For image evaluation, the field of view of the camera can be reduced to the relevant image
section. This enables you to increase e.g. the Image rate, if required.

The zero point for determining the size and position of the image section is located in the
upper left corner of the camera's field of view. The width and height as well as the X and Y
positions are set with respect to the zero point.

Detail: Width

Width of the image section relevant to image evaluation
m Setting range: Depending on connected camera

Detail: Height

Height of the image section relevant to image evaluation
m Setting range: Depending on connected camera

Detail: X position

X position of the image section relevant to image evaluation
m Setting range: Depending on connected camera

Detail: Y position

Y position of the image section relevant to image evaluation
m Setting range: Depending on connected camera
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Parameter Explanation
Master gain o The camera sensor outputs a voltage in proportion to
the amount of incident light. If you want to increase

image brightness and contrast, you can use analog
gain to increase this voltage before digitizing. The
Master gain leads to an increase in the overall
brightness of the resulting image and improves the
contrast.

Master gain for increasing brightness and contrast
m Setting range: 1% ... 100 %

Red gain 0 Comparable with Master gain, Red gain can be used
for setting the gain for this color value.

Red gain for increasing brightness and contrast
® Setting range: 1% ... 100 %

Green gain 0 Comparable with Master gain, Green gain can be
used for setting the gain for this color value.

Green gain for increasing brightness and contrast
m Setting range: 1% ... 100 %

Blue gain o Comparable with Master gain, Blue gain can be used
for setting the gain for this color value.

Blue gain for increasing brightness and contrast
m Setting range: 1% ... 100 %

Exposure time (ps) Length of time during which the light for image acquisition can
reach the sensor

m Setting range: Depending on connected camera

15.5.2 Magnifications

For each optical magnification available on the measuring machine, a Magnification
must be set up on the product.

Parameter Explanation

Magnifications Definition of the respective magnifications

Default magnification: ® Entry for Description and Acronym for quick access menu:
VED Zoom 1 At least one character

B Default setting: VED Zoom 1 and VZ1
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15.5.3
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Lighting

Parameter

Explanation

General settings

Global settings for lighting

A transmitted light + 4 x AD
reflected light

Configuration of lighting using transmitted light and reflected
light

A trans.light + 4 x A refl.light +
D laser pointer

Configuration of lighting using transmitted light, reflected light
and laser pointer

AD trans.light + 4 x AD refl.light
+ AD coaxial light + exposure
time

General settings

Configuration of lighting using transmitted light, reflected light,
coaxial light and camera exposure time

Parameter

Explanation

Linking with magnifications

Setting of reflected light and transmitted light depending on the
magnification

Settings:

B ON: When selecting a magnification, the last selected
setting for this magnification is set for the lighting

® OFF: When selecting a magnification, no changes are
made to the lighting

® Default setting: OFF
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A transmitted light + 4 x AD reflected light

Parameter Explanation
Analog output for transmitted Assignment of the analog outputs for reflected light and
light transmitted light

Analog output for reflected light ~Settings of the analog outputs:
Not connected

Aout 0 X103.11
Aout 1 X103.30
Aout 2 X103.12
Aout 3 X103.31
Aout 4 X103.13
Aout 5 X103.32
Default value: Not connected

Digital output for front segment  Assignment of the digital outputs for reflected-light

Digital output for rear segment segments

Settings of the digital outputs:

Digital output for left segment = Not connected

Digital output for right segment Dout 0 X103.7

Dout 1 X103.26

Dout 2 X103.8

Dout 3 X103.27

Dout 4 X103.9

Dout 5 X103.28

Default value: Not connected
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A trans.light + 4 x A refl.light + D laser pointer

Parameter Explanation
Analog output for transmitted Assignment of the analog outputs for reflected-light segments
light and transmitted light

Analog output for front segment  Settings of the analog outputs:

Analog output for rear segment = Not connected
= Aout 0 X103.11

Analog output for left segment ® Aout 1 X103.30

Analog output for right segment Aot 2 X103.12
E Aout 3 X103.31
= Aout 4 X103.13
|

Aout 5 X103.32
Default value: Not connected

Digital output for laser pointer Assignment of the digital output for the laser pointer
Settings of the digital output:

Not connected

Dout 0 X103.7

Dout 1 X103.26

Dout 2 X103.8

Dout 3 X103.27

Dout 4 X103.9

Dout 5 X103.28

Default value: Not connected
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AD trans.light + 4 x AD refl.light + AD coaxial light + exposure time

Parameter

Transmitted light

Explanation

Configuration of the transmitted light

Reflected light

Configuration of the reflected light

Coaxial light

Configuration of the coaxial light

Camera exposure time

Transmitted light

Parameter

Function

Configuration of the camera's exposure time

Explanation

Use of the transmitted light
® Settings: ON or OFF
® Default setting: ON

Digital output

Assignment of the digital output for the lighting
Settings of the digital outputs:

Not connected

Dout 0 X103.7

Dout 1 X103.26

Dout 2 X103.8

Dout 3 X103.27

Dout 4 X103.9

Dout 5 X103.28

Default value: Not connected

Analog output

Assignment of the analog output for the lighting
Settings:

Not connected

Aout 0 X103.11

Aout 1 X103.30

Aout 2 X103.12

Aout 3 X103.31

Aout 4 X103.13

Aout 5 X103.32

Default value: Not connected

Minimum selectable voltage

Minimum voltage that is output at the analog output
m Setting range: 0 mV ... 9900 mV
m Default value: 0

Maximum selectable voltage

Maximum voltage that is output at the analog output
®m Setting range: 100 mV ... 10000 mV
m Default value: 10000

Slider threshold for "light off"

Threshold value for the slider in pixels from the initial position
(0 %), starting from which the light is activated or deactivated via
the digital output

m Setting range: 0 ... 100
® Default value: 5
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Reflected light

Parameter

Function

Explanation

Use of the reflected light
m Settings: ON or OFF
® Default setting: ON

Digital output for front segment

Digital output for rear segment

Digital output for left segment

Digital output for right segment

Assignment of the digital outputs for the reflected-light
segments

Settings of the digital outputs:
Not connected

Dout 0 X103.7

Dout 1 X103.26

Dout 2 X103.8

Dout 3 X103.27

Dout 4 X103.9

Dout 5 X103.28

Default value: Not connected

Analog output for front segment

Analog output for rear segment

Analog output for left segment

Analog output for right segment

Assignment of the analog outputs for the reflected-light
segments

Settings:

Not connected

Aout 0 X103.11

Aout 1 X103.30

Aout 2 X103.12

Aout 3 X103.31

Aout 4 X103.13

Aout 5 X103.32

Default value: Not connected

Minimum selectable voltage

Minimum voltage that is output at the analog output
m Setting range: 0 mV ... 9900 mV
m Default value: 0

Maximum selectable voltage

Maximum voltage that is output at the analog output
m  Setting range: 100 mV ... 10000 mV
m Default value: 10000

Slider threshold for "light off"
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Threshold value for the slider in pixels from the initial position
(0 %), starting from which the light is activated or deactivated via
the digital output

m Setting range: 0 ... 100
® Default value: 5
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Settings | Video edge detection (VED)

Parameter

Explanation

Function

Use of the coaxial light
m Settings: ON or OFF
= Default setting: ON

Digital output

Assignment of the digital output for the lighting
Settings of the digital outputs:

Not connected

Dout 0 X103.7

Dout 1 X103.26

Dout 2 X103.8

Dout 3 X103.27

Dout 4 X103.9

Dout 5 X103.28

Default value: Not connected

Analog output

Assignment of the analog output for the lighting
Settings:

Not connected

Aout 0 X103.11

Aout 1 X103.30

Aout 2 X103.12

Aout 3 X103.31

Aout 4 X103.13

Aout 5 X103.32

Default value: Not connected

Minimum selectable voltage

Minimum voltage that is output at the analog output
m Setting range: 0 mV ... 9900 mV
= Default value: 0

Maximum selectable voltage

Maximum voltage that is output at the analog output
® Setting range: 100 mV ... 10000 mV
m Default value: 10000

Slider threshold for "light off"
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Threshold value for the slider in pixels from the initial position
(0 %), starting from which the light is activated or deactivated via
the digital output

® Setting range: 0 ... 100
B Default value: 5
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Camera exposure time

Parameter Explanation

Function Use of the camera exposure time
m Settings: ON or OFF
= Default setting: ON

o Minimum exposure time and Maximum exposure time define the setting range of the
slider for the exposure time in the lighting.

Minimum exposure time Minimum length of time during which the light for image acquisi-
tion can reach the sensor

m  Setting range: Depending on connected camera

Maximum exposure time Maximum length of time during which the light for image acqui-
sition can reach the sensor

m Setting range: Depending on connected camera

15.5.4 Camera orientation

Parameter Explanation
Camera skew Compensation of the camera skew caused by the mechanical
mounting

°

® Setting range: -5° ... +5
® Default value: 0°

Teach sequence Teach sequence for determining the Camera orientation
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15.5.5 Contrast settings

Parameter Explanation
Edge algorithm Contrast definition for edge detection
Settings:

® First edge: The first detected contrast transition that is equal
to or greater than the contrast threshold value is defined as
the edge

B Strongest edge: The strongest contrast transition that is
equal to or greater than the contrast threshold value is
defined as the edge

B Automatic: The edge is detected automatically
® Default value: Automatic

Maximum contrast Display of the maximum contrast determined in the live image
Minimum contrast Display of the minimum contrast determined in the live image
Contrast threshold value for Threshold value for the contrast starting from which a transition
edge detection is recognized as an edge

m Setting range: 0 ... 255
. Default value: 0

Teach sequence Teach sequence for determining the contrast threshold value for
edge detection
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15.5.6 Pixel sizes

Parameter Explanation
Magnification List of available magnifications (see "Magnifications", page 320)
Calibration standard diameter Circle diameter specified in the calibration chart for the calibra-

tion standard

Setting range

= Millimeters: 0.00001 mm ... 50 mm
= Inch: 0.0000004" ... 2"

Default value:

= Millimeters: 1.0000

® Inch: 0.039370

Pixel size Pixel size of the camera sensor
Setting range
= Millimeters: 0.00001 mm ... 5 mm
® Inch: 0.0000004" ... 0.2"
Default value:
= Millimeters: 1.0000
® Inch: 0.039370

Teach sequence Teach sequence for determining the Pixel size for the selected
Magnification
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15.6 Features
15.6.1 General settings

Parameter

Number of measuring points

Settings | Features

Explanation

Specifies whether the number of measuring points is fixed or
freely selectable for each feature

Settings:

B Free: Number of measuring points is freely selectable

B Fixed: Number of measuring points is fixed

m Default setting: Free

Distances

15.6.2 Measuring point filter

Parameter

Measuring point filter

Display of the measuring point distance

Settings:

= Signed: Distances are displayed with a positive or negative
algebraic sign, depending on the relative direction

®  Absolute: Distances are displayed without an algebraic sign,
independently of the relative direction

B Default setting: Signed

Explanation

Automatic compensation of the measuring point acquisition for
detecting measuring points outside the normal distribution

® Settings: ON or OFF

m Default setting: ON

Error limit

Definition of the maximum permissible deviations of the measur-
ing point filter

m Setting range: 2 0 (Millimeters or Inch)
® Default setting: 0.003 mm or 0.0001181"

Confidence interval (+xo)

Definition of the measuring point filter range
m Settingrange: 0 ... 10
® Default value: 2

Minimum % proportion of
retained points

330

Percentage of the measuring points that are used for the calcula-
tion of the feature

® Setting range: 0% ... 100 %
® Default value: 75 %
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15.6.3 Measure Magic

Parameter Explanation

Maximum form error ratio Maximum permissible ratio of form error to main dimension for
recognizing a feature

E Setting range: =0
® Default value: 0.050

Minimum angle for an arc Minimum angle for recognizing a circular arc
m Setting range: 0° ... 360°
® Default setting: 15.000

Maximum angle for an arc Maximum angle for recognizing a circular arc
® Setting range: 0° ... 360°
® Default setting: 195.000

Minimum line length Minimum length for recognizing a line

® Setting range: 20

® Default value: 0.001
Minimum numeric ellipse Ratio of the two reference axes for recognizing an ellipse
eccentricity = Setting range: 20

= Default value: 0.500
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Settings | Features

Geometries

The overview shows the minimum number of points for measuring the individual

features.

Parameter Explanation

Point m Setting range: 1 ... 100
®m Default setting: 1

Line ® Setting range: 2 ... 100
B Default setting: 2

Circle ® Setting range: 3 ... 100
® Default setting: 3

Arc m Setting range: 3 ... 100
® Default setting: 3

Ellipse ® Setting range: 5 ... 100
m Default setting: 5

Slot ® Setting range: 5 ... 100
® Default setting: 5

Rectangle m Setting range: 5 ... 100
® Default setting: 5

Blob ® Setting range: 3 ... 100
B Default setting: 3

Reference plane ® Setting range: 3 ... 100
® Default setting: 3

Alignment ® Setting range: 2 ... 100
B Default setting: 2

Distance ® Setting range: 2 ... 100
B Default setting: 2

Angle ® Setting range: 4 ... 100

Default setting: 4
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15.7 Interfaces

15.71 Network

Parameter Explanation
X116 Configuration of the interface X116
X117 Configuration of the interface X117

X116 or X117

0 Contact your network administrator for the correct network settings for
configuring the product.

Parameter Explanation
MAC address Unigue hardware address of the network adapter
DHCP Dynamically assigned network address of the product

® Settings: ON or OFF
m Default value: ON

IPv4 address Network address consisting of four octets

The network address is automatically assigned if DHCP is active,
or it can be entered manually

m Setting range: 0.0.0.0 ... 255.255.255.255

IPv4 subnet mask Identifier within the network, consisting of four octets

The subnet mask is automatically assigned if DHCP is active, or
it can be entered manually.

® Setting range: 0.0.0.0 ... 255.255.255.255
® Default value: 0.0.0.0

IPv4 standard gateway Network address of the router connecting a network

0 The network address is automatically assigned if
DHCP is active, or it can be entered manually

m Setting range: 0.0.0.0 ... 255.255.255.255
IPv6 SLAAC Network address with extended namespace

Only required if supported in the network

® Settings: ON or OFF

® Default value: OFF

IPv6 address Automatically assigned if IPv6 SLAAC is active

IPv6 subnet prefix length Subnet prefix in IPv6 networks

IPv6 standard gateway Network address of the router connecting a network
Preferred DNS server Primary server for mapping the IP address
Alternative DNS server Optional server for mapping the IP address
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15.7.2 Network drive

o Contact your network administrator for the correct network settings for
configuring the product.

Parameter Explanation

Name Folder name displayed in the file management
Default value: Share (cannot be changed)

Server IP address or host name Name or network address of the server

Shared folder Name of the shared folder

User name Name of the authorized user
Password Password of the authorized user
Show password Display of the password in plain text

® Settings: ON or OFF
u Default value: OFF

Network drive options Authentication settings:

Selection of the encryption for the password in the network
None

Kerberos V5 authentication

Kerberos V5 authentication and packet signing
NTLM password hashing

NTLM password hashing with signing

NTLMv2 password hashing

NTLMv2 password hashing with signing

Default value: None

Mount options settings:

® Default value: nounix,noserverino
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15.8 User

15.8.1 User permissions

The product's operating system provides the following levels of permissions:

OEM

The OEM (Original Equipment Manufacturer) user has the highest level of
permissions. This user is allowed to configure the product's hardware (e.g.
connection of encoders and sensors). He can also create Setup-type and
Operator-type users and configure the Setup and Operator users. The OEM user
cannot be duplicated or deleted. This user cannot be logged in automatically.

Setup

The Setup user configures the product for use at the place of operation. This user
can create Operator-type users. The Setup user cannot be duplicated or deleted.
This user cannot be logged in automatically.

Operator

The Operator user is permitted to use the basic functions of the product.

An Operator-type user cannot create additional users and is allowed to change his
name or the language, for example. A user of the Operator group can be logged in
automatically as soon as the product is switched on.

15.8.2 User settings

Parameter Explanation

OEM Configuration of the default user OEM
Setup Configuration of the default user Setup
Operator Configuration of the default user Operator

Creation of a new user of the type Operator

J‘»

Further information: "Entering and configuring users", page 138

It is not possible to create additional OEM-type and Setup-type users.
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15.8.3 User type OEM

Parameter Explanation Edit permission

Name Name of the user -
m Default value: OEM

First name First name of the user -
m Default value: —

Department Department of the user -
® Default value: —

Group Group of the user -
® Default value: oem

Password Password of the user OEM

Language Language of the user OEM

Auto login On restart of the product: Automatic login -

of the last logged-in user
® Default value: OFF

Remove user account Removal of the user account -

15.8.4 User type Setup

Parameter Explanation Edit permission

Name Name of the user -
B Default value: Setup

First name First name of the user -
® Default value: —

Department Department of the user -

B Default value: —
Group Group of the user -

® Default value: setup
Password Password of the user Setup, OEM
Language Language of the user Setup, OEM
Auto login On restart of the product: Automatic login -

of the last logged-in user
® Default value: OFF

Remove user account Removal of the user account -
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15.8.5 User type Operator

Parameter Explanation Edit permission
Name Name of the user Operator, Setup, OEM
® Default value: Operator
First name First name of the user Operator, Setup, OEM
Department Department of the user Operator, Setup, OEM
® Default value: —
Group Group of the user -
® Default value: operator
Password Password of the user Operator, Setup, OEM
Language Language of the user Operator, Setup, OEM
Auto login On restart of the product: Automatic login Operator, Setup, OEM

of the last logged-in user
m Settings: ON or OFF
m Default value: OFF

Remove user account Removal of the user account Setup, OEM
15.9 Axes

Parameter Explanation

General settings Configuration of global functions for all axes

X Configuration of the axes that are available on the product

Y Default: Xand Y

0 The number of axes may vary depending on the activation of the
QUADRA-CHEK 3000 AEI1 software option.

15.9.1 General settings

Parameter Explanation
Reference mark search Configuration of reference mark search after unit start
Information Display of the assignment of the encoder inputs, the analog and

digital outputs as well as the analog and digital inputs to the axes

Error compensation Configuration of error compensation using NLEC and SEC
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Reference mark search

Settings | Axes

Parameter

Explanation

Reference mark search after
unit start

Setting for the reference mark search after unit start

Settings:

® ON: The reference mark search must be performed after
startup

. OFF: No reference mark search is required after startup of the
product

m Default value: ON

Reference mark search status

Indicates whether the reference mark search was successful
Display:

® Successful

= Unsuccessful

Stop of reference mark search

Indicates whether the reference mark search was canceled
Display:

= Yes

" No

Reference mark search

Start starts the reference mark search and opens the workspace

All users can cancel reference
mark search

Specifies whether the reference mark search can be canceled by
all user types

Settings

B ON: The reference mark search can be canceled by any user
type

. OFF: The reference mark search can only be canceled by the
OEM or Setup user type

u Default value: OFF
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Information
Parameter Explanation
Assignment of the encoder Shows the assignment of the encoder inputs to the axes

inputs to the axes

Assignment of the analog Shows the assignment of the analog outputs to the axes
outputs to the axes

Assignment of the analog inputs  Shows the assignment of the analog inputs to the axes
to the axes

Assignment of the digital outputs Shows the assignment of the digital outputs to the axes
to the axes

Assignment of the digital inputs Shows the assignment of the digital inputs to the axes
to the axes

Error compensation

Parameter Explanation

Nonlinear error compensation Mechanical influences on the axes of the machine are compen-
(NLEC) sated

Squareness error compensation Mechanical influences on the squareness of the axes relative to
(SEC) each other are compensated
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Nonlinear error compensation (NLEC)

Parameter

Explanation

Compensation

Mechanical influences on the axes of the machine are compen-
sated

Settings:

B ON: Compensation is active

® OFF: Compensation is not active
B Default value: OFF

Number of supporting points

Number of measuring points for error compensation on both
axes (X and Y) of the encoder

B Setting range: 1... 99 (XandY)
B Default value: 2 (X and Y)

Spacing of the supporting points

Spacing of the compensation points on the axes (X and Y)
B Setting range: 0.00001 mm ... 100.0 mm (X and Y)
B Default value: 0.00001 mm (X and Y)

Read deviations of calibration
standard

The file containing the deviations of the calibration standard is
read

Table of supporting points

The overview of the table of supporting points is opened for
manual editing

Teach sequence

The teach sequence for determining the compensation values is
started

Squareness error compensation (SEC)

Parameter Explanation
XY plane Mechanical influences on the squareness of the axes relative to
XZ Plane each other are compensated
B Setting range: 85° ... 95°
YZ plane

® Default value: 90
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15.9.2 Axis settings

Parameter

Axis name

Explanation

Definition of the axis name displayed in the position preview
Settings:

=X

myY

mZ

= Q

Encoder

Configuration of the connected encoder

Error compensation

Encoder

Parameter

Encoder input

Configuration of the segmented linear error compensation SLEC

Explanation

Assignment of the encoder input to the axis of the product
Settings:

= X1 (1 Vpp) or X21 (TTL)

= X2 (1 Vpp) or X22 (TTL)

= X3 (1 Vpp) or X22 (TTL)

= X4 (1 Vpp) or X24 (TTL)

Incremental signal

0 The Incremental signal parameter can only be
changed on the product variant with 1 Vpp encoder
signal. The parameter cannot be edited on the
product variant with TTL encoder signal.

Signal of the connected encoder
Settings:

= 1 Vpp: Sinusoidal voltage signal

® 11 pApp: Sinusoidal current signal

® Default value: 1 Vpp or TTL (depending on the product
variant)

Encoder model

Connected encoder model

Settings:

® Linear encoder: Linear axis

®  Angle encoder: Rotary axis

m Default value: Depending on the connected encoder

Signal period Length of a signal period on linear encoders
B Setting range: 0.001 pm ... 1000000.000 pm
m Default value: 20.000

Line count Number of lines on angle encoders

m Setting range: 1 ... 1000000
m Default value: 1000
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Parameter Explanation
Reference mark Definition of the type of reference mark
Settings:

® None: There is no reference mark

® One: The encoder has one reference mark

B Coded: The encoder has distance-coded reference marks
B Default value: One

Analog filter frequency Frequency value of the analog low-pass filter (not with TTL)
Settings:
® 33 kHz: Suppression of interference frequencies above
33 kHz
B 400 kHz: Suppression of interference frequencies above
400 kHz

= Default value: 33 kHz

Terminating resistor Dummy load to avoid reflections
m Settings: ON or OFF
B Default value: ON

Error monitor Monitoring of signal errors

Settings:

®  Off: Error monitoring not active

= Amplitude: Error monitoring of signal amplitude
® Frequency: Error monitoring of signal frequency
|

Frequency & amplitude: Error monitoring of signal amplitude
and signal frequency

® Default value: Frequency & amplitude

Counting direction Signal detection during axis movement
Settings:

® Positive: The direction of traverse corresponds to the
counting direction of the encoder

® Negative: The direction of traverse does not correspond to
the counting direction of the encoder

= Default value: Positive

342 HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016



Settings | Axes

Segmented linear error compensation (SLEC)

Parameter Explanation

Compensation Mechanical influences on the axes of the machine are compen-
sated
Settings:

® ON: Compensation is active
® OFF: Compensation is not active
B Default value: OFF

Table of supporting points The overview of the table of supporting points is opened for
manual editing

Create table of supporting points The menu for creating a new Table of supporting points is

opened
Create table of supporting points
Parameter Explanation
Number of supporting points Number of supporting points on the mechanical axis of the

measuring machine

o For linear error compensation (LEC), use the
segmented linear error compensation (SLEC) function
to enter two supporting points that define the axis
as a single segment covering the entire measuring
range. In this way, linear compensation of the axis is
performed over the entire segment.

® Setting range: 2 ... 200
m Default value: 2

Spacing of the supporting points  Spacing of the supporting points on the mechanical axis of the
measuring machine

Start point The start point defines the point starting from which the
compensation is applied to the axis

Create Creates a new table of supporting points based on the entries
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15.10.1
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Settings | Service

Service

Firmware information

The following information on the individual software modules is displayed for
service and maintenance.

Parameter Explanation

Core version Version number of the microkernel

Microblaze bootloader version Version number of the Microblaze bootloader
Microblaze firmware version Version number of the Microblaze firmware
Extension PCB bootloader Version number of the bootloader (expansion board)
version

Extension PCB firmware version  Version number of the firmware (expansion board)

Boot ID ID number of the boot process

HW Revision Revision number of the hardware

Touchscreen Controller version Version number of the touchscreen controller

Qt build system Version number of the Qt compilation software

Qt runtime libraries Version number of the Qt runtime libraries

Login status Information on the logged-in user

Systemlinterface Version number of the system interface module

Backendinterface Version number of the backend interface module

Guilnterface Version number of the user interface module

TextDataBank Version number of the text database module

Optical edge detection Version number of the optical edge detection module

Cameralnterface Version number of the camera interface module

Imageprocessing Version number of the image processing module

Metrology Version number of the metrology module

Networkinterface Version number of the network interface module

OSInterface Version number of the operating system interface module

Printerinterface Version number of the printer interface module

Programming Version number of the programming module

ReferenceSystem Version number of the reference system module

VideoProbes Version number of the video tools module

system.xml Version number of the system parameters

io.xml Version number of the parameters for inputs and outputs

info.xml Version number of the information parameters

option.xml Version number of the parameters of the software options

audio.xml Version number of the audio parameters

camera.xml Version number of the camera parameters

cameraRuntime.xml Version number of the runtime environment parameters of the
camera
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Parameter

Explanation

lightcontrolRuntime.xml

Version number of the runtime environment parameters of the
lighting

metrology.xml Metrology parameters

network.xml Version number of the network parameters

networkRuntime.xml Version number of the runtime environment parameters of the
network

os.xml Version number of the operating system parameters

printer.xml Version number of the printer parameters

probeRuntime.xml Version number of the runtime parameters of the sensors

runtime.xml Version number of the runtime parameters

serialPort.xml

Version number of the parameters of the serial interface

users.xml

Version number of the user parameters

ved.xml version

Version number of the VED parameters
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15.10.2 Backing up and restoring the configuration

346

Backing up the configuration

The configuration of the product can be backed up as a file to make it available
after a reset to the factory default settings or for installation on multiple products.

> Tap Settings in the main menu
& .
» Open in the sequence

= Service
® Backup and restore configuration
® Backup configuration

Performing a complete backup
During a complete backup of the configuration, all settings of the product are
backed up.

» Tap Complete backup

> If required, connect a USB mass storage device to a USB
port of the product

> Select the folder to which you want to copy the configuration
data

> Specify a name for the configuration data,
e.g. "<yyyy-mm-dd>_config"

Confirm entry with RET

Tap OK

Confirm the successful backup of the configuration
The configuration file was backed up

v Vv vVvy

Safely removing a USB mass storage device

» Tap File management in the main menu
> Navigate to the list of storage locations

A > Tap Safely remove

— > Disconnect the USB mass storage device

Settings | Service
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Restoring the configuration

Backed-up configurations can be restored to the product. The current configuration

of the product is replaced in the process.

o Software options that were active when the configuration was backed
up must be activated before restoring the configuration.

A restore can be necessary in the following cases:

B During commissioning, the configuration data are set on a product and
transferred to all identical products
Further information: "Commissioning steps"’, page 107

®  After a reset to the factory default settings, the configuration data are copied
back to the product
Further information: "Resetting to the factory defaults", page 350

» Tap Settings in the main menu

» Openin the sequence
B Service
® Backup and restore configuration
= Restore configuration

Performing a complete restore

> Tap Complete restoration

If required, connect a USB mass storage device to a USB
port of the product

Navigate to the folder containing the configuration data
Select the configuration data

Tap OK

Confirm successful transfer with OK

The system is shut down

To restart the product with the transferred configuration data,
switch the product off and then back on

v

VvV Vv Vvyvyy

Safely removing a USB mass storage device

> Tap File management in the main menu
» Navigate to the list of storage locations
>
] Tap Safely remove
I >

Disconnect the USB mass storage device
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15.10.3 Firmware update

The firmware is the operating system of the product. You can import new versions
of the firmware via the product's USB port or the network connection.

When updating the firmware of the product, the current configuration
must be backed up for safety and security reasons.

0 The existing settings are not changed during a firmware update.

Requirement
B The new firmware is available as a *.dro file

= To update the firmware via the USB port, the current firmware must be stored
on a USB mass storage device

= To update the firmware via the network interface, the current firmware must be
available in a folder on the network

Starting a firmware update

. » Tap Settings in the main menu
< .
» Tap Service
» Open in the sequence
® Firmware update
= Continue
> The service application is launched
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Updating the firmware
The firmware can be updated from a USB mass storage device or via a network
drive.

» Tap Firmware update
; "

> Tap Select

> |f required, connect a USB mass storage device to a USB
port of the product

» Navigate to the folder containing the new firmware

o If you have accidentally tapped the wrong folder,
you can return to the previous folder.
» Tap the file name that is displayed above the
list

Select the firmware

Tap OK to confirm the selection

The firmware version information is displayed
Tap OK to close the dialog

vV yYyy

o The firmware update cannot be canceled once
the data transfer has started.

Tap Start to start the update

The screen shows the progress of the update

Tap OK to confirm successful update

Tap Finish to terminate the service application

The service application is terminated

The main application is launched

If automatic user login is active, the user interface is
displayed in the Measure menu

> If automatic user login is not active, the User login menu is
displayed

VV V Vv VvV Yy

Safely removing a USB mass storage device

A

Tap File management in the main menu
Navigate to the list of storage locations
Tap Safely remove

Disconnect the USB mass storage device

vV v vy
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15.10.4 Resetting to the factory defaults

You can reset the settings of the product to the factory defaults, if required.
Software options are deactivated and subsequently need to be reactivated with
the available license key.

350

> Tap Settings in the main menu
> Tap Service

VVV Vv VvV VvVYyy

Open in the sequence

= Reset to factory settings

B Reset all settings

Enter password

Confirm entry with RET

To show the password in plain text, activate Show password
Tap OK to confirm the reset

Tap OK to confirm shutdown of the product

The product is shut down

All settings are reset

To restart the product, switch it off and then back on

Settings | Service
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15.10.5 OEM area

The OEM area enables commissioning engineers to install custom information in

the product:

® Documentation: OEM documentation, e.g. service information

® Opening screen: Adjustment of the startup screen, e.g. to display the OEM's

company logo

Adding the OEM documentation

0 Only documents in PDF format can be added. Other documents are not
displayed.

4

v v vy

>

Tap Settings in the main menu

> Tap Service
» Open in the sequence

5 OEM area
5 Documentation
5 Add OEM service info

If required, connect a USB mass storage device to a USB
port of the product

To navigate to the desired file, tap the location where the file
is stored

0 If you have accidentally tapped the wrong folder,
you can return to the previous folder. Tap the file
name that is displayed above the list.

Navigate to the folder containing the file
Tap the file name
Tap OK

The document is copied to the product and displayed in the
service information area

Confirm the successful transfer with OK

Safely removing a USB mass storage device

A

vV v vy

Tap File management in the main menu
Navigate to the list of storage locations
Tap Safely remove

Disconnect the USB mass storage device
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Adjusting the startup screen

The product can display a custom startup screen, e.g. the company name or logo.
The corresponding image needs to be stored on the product for this purpose.

Requirements
® File format: PNG or JPG
= Resolution: 96 ppi

B |mage format: 16:10
Images in other formats will be scaled proportionally

B |mage size: Max. 1280 x 800 px

Inserting a startup screen

> Tap Settings in the main menu
% > Tap Service
» Open in the sequence
= OEM area

® Opening screen
m Select the startup screen

> If required, connect a USB mass storage device to a USB
port of the product

» To navigate to the desired file, tap the location where the file
is stored

o If you have accidentally tapped the wrong folder,
you can return to the previous folder. Tap the file
name that is displayed above the list.

Navigate to the folder containing the file
Tap the file name
Tap OK

The image is copied to the product and displayed the next
time the product is started

» Confirm the successful transfer with OK

v v vy

Safely removing a USB mass storage device

> Tap File management in the main menu
> Navigate to the list of storage locations

o > Tap Safely remove

_— » Disconnect the USB mass storage device
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15.10.6 Documentation

The product provides the possibility to upload the corresponding Operating
Instructions in the desired language. The Operating Instructions can be copied
from the supplied USB mass storage device to the product.

The latest version can be downloaded from the download area at
www.heidenhain.de.

Requirement

The current Operating Instructions are available as a PDF file.

4

v

V v vVV VY

Tap Settings in the main menu
Tap Service

Open in the sequence

= Documentation

B Add Operating Instructions

If required, connect a USB mass storage device to a USB
port of the product

Navigate to the folder containing the new Operating
Instructions

o If you have accidentally tapped the wrong folder,
you can return to the previous folder.

» Tap the file name that is displayed above the
list

Select file

Tap OK

The Operating Instructions are copied to the product

Any existing Operating Instructions will be overwritten
Confirm successful transfer with OK

The Operating Instructions can be opened on the product

Safely removing a USB mass storage device

o

>
.
>
>

Tap File management in the main menu
Navigate to the list of storage locations
Tap Safely remove

Disconnect the USB mass storage device

HEIDENHAIN | QUADRA-CHEK 3000 | Operating Instructions | 6/2016

353



Settings | Service

15.10.7 Software options

o In the factory default setting, no software options are enabled on the
product. To enable software options, the corresponding license keys
must be installed.

Parameter Explanation

Overview Overview of all software options that are active on
the product

Request options Creation of a license key request that can be
submitted to a HEIDENHAIN service agency

Further information: "Requesting a license key",
page 108

Request trial options Creation of a license key request that can be
submitted to a HEIDENHAIN service agency

Further information: "Requesting a license key",
page 108

Activate options Activation of the software options via license key or
license file

Further information: "Activating a license key",
page 111

Reset trial options Reset of the trial options by entering a license key
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16.1 Overview

This chapter describes the general maintenance work on the product:
® Cleaning

B Maintenance schedule

= Resuming operation

@ This chapter contains a description of maintenance work for the product
only.
Further Information: Manufacturer's documentation for the respective
peripheral devices

16.2 Cleaning

NOTICE

Cleaning with sharp-edged objects or aggressive cleaning agents
Improper cleaning will cause damage to the product.

» Never use abrasive or aggressive cleaners, and never use strong detergents
or solvents

» Do not use sharp-edged objects to remove persistent contamination

> Use only a cloth dampened with water and a mild detergent for cleaning the
exterior surfaces

> Use a lint-free cloth and a commercially available glass cleaner to clean the
screen
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16.3 Maintenance schedule

The product is largely maintenance-free.

NOTICE

Operating defective products
Operating defective products may result in serious consequential damage.

» Do not operate or repair the product if damaged

> Replace defective products immediately or contact a HEIDENHAIN service
agency

o The following steps are only to be performed by electrical specialists.
Further information: "Personnel qualification", page 19

Maintenance step Interval Corrective action

» Check all labels and Annually » Contact HEIDENHAIN service
symbols provided on the agency
product for readability

> Inspect electrical Annually > Replace defective cables.
connections for damage Contact HEIDENHAIN service
and check their function agency if required

» Check power cables for Annually » Replace power cables
faulty insulation and weak according to the specification
points

16.4 Resuming operation

When operation is resumed, e.g. when the product is reinstalled after repair or
when it is remounted, the same measures and personnel requirements apply as
for mounting and installing the product.

Further information: "Assembly of the device", page 30
Further information: "Installation”, page 37

When connecting the peripheral devices (e.g. encoders), the operating company
must ensure safe resumption of operation and assign authorized and appropriately
qualified personnel to the task.

Further information: "Obligations of the operating company", page 19
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17.2

173
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What to do if

Overview

This chapter describes the causes of faults or malfunctions of the product and
corrective actions.

o Make sure that you have read and understood the "Basic Operation'
chapter before performing the activities described below.

Further information: "Basic operation”, page 51

System or power failure

Operating system data can be corrupted in the following cases:
. System or power failure
= Switching off the product without shutting down the operating system

If the firmware is damaged, the product starts the Recovery System. The firmware
and the configuration are deleted.

Restoring the firmware
» Create the "heidenhain" folder in a USB mass storage device

In the "heidenhain" folder, create the "update" folder
Copy the current firmware to the "update" folder

The firmware will be restored to the product by using the USB mass storage
device

Switch off the product

Connect the USB mass storage device to the product
Switch on the product

The product starts the Recovery System

The USB mass storage device is detected automatically
The firmware is installed automatically

Restart the product on completion of the installation
The product starts up with the factory defaults

v vV

VVVVVVvyVVYyy

Restoring the configuration

Installing the firmware resets the product to the factory defaults. If a backup of the
configuration was made e.g. during setup, the backup file can be used for restoring
the configuration. Before the backed-up configuration data can be restored to the
product, the software options that were active when the backup was made must
be activated in the product.

» Enable the software options

Further information: "Enabling software options", page 108

> Restore the configuration

Further information: "Backing up and restoring the configuration®, page 346

Malfunctions

If faults or malfunctions that are not listed in the "Troubleshooting" table below
occur during operation, a HEIDENHAIN service agency must be contacted.

... | Overview
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17.4

Troubleshooting

o The following troubleshooting steps must be performed only by the
personnel indicated in the table below.

Further information: "Personnel qualification”, page 19

Error Error source Correction of fault Personnel
Status LED remains There is no supply » Check the power cable Electrical
dark after switch-on. voltage specialist
The product does Contact a HEIDENHAIN Qualified
not function service agency personnel
properly
A blue screen appears Software error If this fault occurs for the first ~ Qualified
when the product starts  during startup time, switch the product off personnel
up. and then on again
If the fault recurs, contact a
HEIDENHAIN service agency
After startup, the Incorrect Switch the product off and Qualified
product does not hardware then on again personnel
recognize any initialization
entries made on the
touchscreen.
The position display Incorrect » Correct the connection Qualified
does not count the axis ~ connection of the Contact the encoder personnel
position even though encoder manufacturer's service agency
the encoder is moving.
The axis values are red The encoder Perform the reference mark Operator
and the functions are has not been search
disabled. referenced (see "Conducting the
reference mark search’,
page 203)
The position display Incorrect settings Check the encoder settings Qualified
miscounts the axis of the encoder (see "Setting axis parameters’, personnel
position. page 113)
The lighting does not Defective Check the cable Electrical
work. connection specialist
Incorrect settings Check the settings for the Qualified
of the inputs and inputs and outputs personnel
outputs (see "Setting the lighting",
page 124)
The camera image is Wrong camera Check the camera model Qualified
not displayed. model connected personnel
Incorrect settings Check the camera settings Qualified
of the camera (see "Setting the camera’, personnel
page 118)
Defective Check the cable and the Qualified
connection correct connection to X32 / personnel

X117
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What to do if ... | Troubleshooting

Error Error source Correction of fault Personnel
The camera image Incorrect pixel > Set the pixel format in the Qualified
flickers. format selected camera settings personnel
for the camera (see "Camera", page 318)
Connection to the Defective » Check the cable and the Qualified
network is not possible.  connection correct connection to X116 personnel
Incorrect settings > Check the network settings Qualified
of the network (see "Configuring the personnel
network’, page 142)
The connected USB Defective » Check the correct position of Qualified
mass storage device is  connection the USB mass storage device  personnel
not detected. in the port
» Use another USB port (X31 to
X34)
The type or » Use another USB mass Qualified
formatting of storage device personnel
the USB mass
storage device is
not supported
The device starts up in Software error > If this fault occurs for the first ~ Qualified
recovery mode (text- during startup time, switch the product off personnel
only mode). and then on again
> |f the fault recurs, contact a
HEIDENHAIN service agency
User login is not Password does > As a user with a higher Qualified
possible. not exist authorization level, reset the personnel

password

(see "Entering and configuring
users", page 138)

To reset the OEM password,
contact a HEIDENHAIN
service agency
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Removal and disposal | Overview

Overview

This chapter provides information about the removal and disposal of the product.
This information includes requirements to be complied with in respect of
environmental-protection laws.

Removal

o Removal of the product must be performed only by qualified personnel.
Further information: "Personnel qualification", page 19

Depending on the connected peripherals, the removal may need to be performed
by an electrical specialist.

In addition, the same safety precautions that apply to the mounting and installation
of the respective components must be taken.

Removing the product
To remove the product, follow the installation and mounting steps in the reverse
order.

Further information: "Installation’, page 37
Further information: "Mounting", page 29

Disposal

NOTICE

Incorrect disposal of the product!

Incorrect disposal of the product can cause environmental
damage.

» Do not dispose of electrical waste and electronic components
in domestic waste

» Forward the product to recycling in accordance with the
applicable local disposal regulations

> If you have any questions about the disposal of the product, please contact a
HEIDENHAIN service agency
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Product data

Specifications | Product data

Device

Housing

Aluminum milled housing

Housing dimensions

314 mm x 265 mm x 38 mm

Fastener system,
mating dimensions

VESA MIS-D, 100
100 mm x 100 mm

Display

Visual display unit

® LCD widescreen (16:10)
Color screen 30.7 cm (12.1")

= 1280 x 800 pixels

Display step

Selectable, min. 0.00001T mm

User interface

User interface (GUI) with touchscreen

Electrical data

Power supply

AC 100V ... 240 V (£10 %)
50 Hz ... 60 Hz (5 %)
Input power max. 79 W

Overvoltage category

Number of encoder inputs

2x (2 additional inputs can be enabled optionally via
software option)

Encoder interfaces

B 1 Vpp: Max. current 300 mA,
max. input frequency 400 kHz

B TTL: Max. current 300 mA,
max. input frequency 5 MHz

Interpolation at 1 V,

4096-fold

Camera connection

Hi-Speed USB 2.0 (Type A), max. current 500 mA,
1 Gigabit Ethernet (RJ45)

Connection for
optical edge detector

Two FSMA sockets (thread designation
1/4-36 UNS-2A)

Digital inputs

TTLOVto+bV

Digital outputs

TTL OV to +5 V. maximum load 1 kQ

Relay outputs

B Max. switching voltage AC 30V /DC 30V
= Max. switching current 0.5 A

B Max. switching capacity 15 W

® Max. continuous current 0.5 A

Analog inputs

Voltage range OV ... +5V

Analog outputs

Voltage range DC-10V ... +10V
Maximum load =1 kQ

5V voltage outputs

Voltage tolerance £5 %, maximum current 100 mA

Data interface

®m Hi-Speed USB 2.0 (Type A), max. current
500 mA per USB port

= 100 Mbit/1 Gbit Ethernet (RJ45)
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Ambient conditions

Operating temperature

0°Cto +45°C

Storage temperature

-20°Cto +70°C

Relative air humidity

10 % to 80 % r.H., non-condensing

Altitude

<2000 m

General information

Directives

Until April 19, 2016:

EMC Directive 2004/108/EC
Low Voltage Directive 2006/95/EC

As of April 20, 2016:

EMC Directive 2014/30/EU
Low Voltage Directive 2014/35/EU

Pollution degree 2
Protection EN 60529 B Front panel and side panels: IP 65
B Rear panel: IP 40
Weight ® 3.5kg
= \With Duo-Pos stand 3.8 kg
= With Multi-Pos stand: 4.5 kg
= With Multi-Pos holder: 4.1 kg
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19.2 Product dimensions and mating dimensions

All dimensions in the drawings are in millimeters.
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Product dimensions with Duo-Pos stand
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Product dimensions with Multi-Pos stand
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